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Using the Check Model Tool

The IBM® Rational® Statemate®Check Model tool is an error-handling tool that enables you to
check for errors and warnings in Rational Statemate models. While designing model charts and
diagrams, the Rational Statemate graphical editors handle simple, syntactical errors. Use Check
Model to both detect and resolve more complex errors in relational elements of models.

Check Model performs the following types of checks:

¢ Correctness - Checks for inconsistencies in the model. Correctness checks return errors.

+ Completeness - Checks for redundancy and incompleteness in the model. Completeness
checks return warnings.

+ Design - Checks for design problems in the model. This type of check is available in
Rational Statemate extended mode. Design checks return warnings.

+ Rational Statemate MicroC Compatibility - Reports on Rational Statemate features
used that are not supported in MicroC code generation.

Correctness checks detect illegal situations regarded as errors, whereas most completeness checks
warn of possible oversights in your System Under Design specifications. Some completeness
warnings might have minimal or no impact on a model’s overall design or the behavior of a
system.

This section describes how to check Rational Statemate models using the Check Model tool. The
topics are as follows:

¢ Performing a Check on a Single Chart
¢ Creating Check Model Profiles

¢ Customizing Check Model Profiles

¢ Analyzing Results and Fixing Errors
¢ Enabling and Disabling Checks

¢ Check Model Test Settings File
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Performing a Check on a Single Chart

At any stage during your work on an individual chart, you can easily run Check Model. Best
practices advise running Check Model frequently during the design process to ensure that errors
are caught before models become too complex and errors compound.

To check an individual chart, do the following:
1. Open the chart within its graphic editor.
2. Select Tools > Check Model.

Check Model runs a check on the chart and all its elements and reports the number of errors in
correctness or warnings in completeness in the Messages field. In addition, a list of check names
and numbers for erroneous elements open in a text editor.

Creating Check Model Profiles

Check Model enables you to create a configuration of charts and diagrams to check and recheck by
using profiles. Each Check Model profile displays the scope of all the charts and diagrams to be
checked.

To create a Check Model profile, do the following:

1. Open the Check Model tool, then select File > New Profile. The New Check Model
Profile dialog box opens.

2. Enter a Name for the profile, then click OK.

3. Click Add Selected Chart with Descendants to Profile &|. The Charts Tree dialog box
opens. See the following figure.

4. Select the names of the charts you want to check in the chart tree. To include additional
charts within a profile’s scope, even if those charts are not hierarchically related, select
the chart names from the chart tree.

5. Click OK. The Charts Tree dialog box closes.

6. Select File > Save.
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T im—

New/Dpen Check Model Profile
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Charts Tree |

@4 REAR_DEFOG_GDE

[ fBl REAR_DEFOG_$§
REAR_DEFOG_FEATURES
(-] B CALC_REAR DEFOG _STATE
@ CALC_REAR _DEFOG STATE BHVR
[-] .fBl REAR_DEFOG_RELAY MGMT
48 REAR_DEFOG_RELAY MGMT BHVR
i3t REAR_DEFOG_UCD

7f-| REAR_DEFOG_LO_SPEED_NO_LOAD

-/ REAR DEFOG _7HI SPEED 7LOAD1
7o/ REAR_DEFOG_7HI SPEED 7LOAD!
7o/ REAR_DEFOG_LO_SFEED_NO_LOAD

0K | Apply I Cancel

Customizing Check Model Profiles

To delete charts from a profile’s scope, select the chart name and click Remove Selected Objects

from Profile ﬂ The profile editor removes the selected chart and all its children charts from the
profile.

Exclude from Check Model Scope

Exclude from Scope allows trimming of the activity chart’s hierarchy at a defined activity chart.
The result is a scope that includes only a part of the model hierarchy.

The activity chart that was excluded from the scope is marked with a special icon and does not
show any of its descendants.

To exclude and activity chart from the scope, select Edit > Exclude from Scope.

To include the activity chart back into the scope, select Edit > Include in Scope.
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Customizing Check Model Profiles

Performing a Check on a Profile

Rational Statemate enables you to check multiple charts and diagrams, and the relation of their
elements, using the Check Model profile.

To perform a check on a configuration of charts in a model, do the following:

1. Create a new profile or open a saved profile of the charts you want to check.

¥Zcheck Model: REAR_DEFOG_CHK (Mo I (] 3

File Edit Wiew Execute Options Window Help

IR

Scope Definitioh

Bl REAR_DEFOG_SS

REAR_DEFOG_FEATURES

Bl CALC_REAR _DEFOG_STATE

o8 CALC REAR DEFOG STATE BHVR
(-] {8l REAR DEFOG_RELAY MGMT

-8 REAR_DEFOG_RELAY MGMT BHVR

Mezzages

| I—

2. Click Execute Current Check Model Profile 4'

The Check Model Results window opens (see the following figure) and reports

correctness errors and completeness warnings for specific elements, listed by check
number and name.

To sort the results, select View > Sort.
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Check Model Results: REAR_DEFOG_TEST 2 |EI|5|

File Wiew Execute Help

El Completeness
El Charts/GDSs relations tests
[E Tested: charts relations
[ ¢Cc77oly Multiple root charts in WorkArea:
ACTIVITY_CHART_TEST
REAR_DEFOG_5SS
DATABANK_TEST -
SIMULATION
El Activity-chart tests
E Tested Activity-chart:; ACTIVITY_CHART_TEST
E ¢Cdol7y  Unlabeled compound flow-lines;
Data-Flow#l, .,
Data-Flowsz, .,
E (Cd4020) Arrows nokt a component of any compound dat:
Data-Flow#l, .,
E iCdo21? Flow-lines with incomplete source definitic
[ zource in=zide activity ACTIVITY_CHART_TEST ...
[ zource in=zide activity ACTIVITY_CHART_TEST ...
[ iCd4029) Basic activities without any outputs:
LACTIVITY#®E
[ iCdndB) Unrezolved elements:
activity ACTIVITY&3
E Tested Actiwvity-chart:; DRATABAMK_TEST ;l

4 | M

Messages

Check Model Guide



Analyzing Results and Fixing Errors

Analyzing Results and Fixing Errors

The Check Model Results window reports correctness errors and completeness warnings for
model elements by check number and name. After running a check, Check Model lists the
erroneous element and its location in the model for each error.

You can examine and edit the properties of these erroneous elements through the Check Model
Results window by right-clicking on the element name and clicking Properties or opening the
graphic editor or property in which it appears.

[ (Cd029) Basic activities without any output:
LACTIVITw#2
El (C40d8)  Unreszolved elements:

activity ACTIVITYH3
E Tested fictivity-chart; DATABANK_TEST
4l |

=101 x|
File Wiew Execute Help
Bl Completeness 2
EH Charts/G0Ss relations tests
E Tested: charts relations
E 7701y Multiple root charts in WorkfArea:
ACTIVITY _CHART_TEST
RERRE_DEFOG_55S
DATABAMK_TEST |
SIMULATION
Efctivity-chart tests
ETested Activity-chart: ACTIVITY_CHART_TEST
Bl (Cd4017) Unlabeled compound fg ;
[ Data-Flow#l, .. EE%LElﬂEEl———
Data-Flowsz, .. Suppresz Selected
E {Cd020)  Arrows not a componemound dat:
Data-flow#l, ,, M
[ iCd021) Flow-lines with incomplete source definitic

[ =zource inside activity ACTIVITY_CHART_TEST ...
[ source inside asctivity ACTIVITY_CHART_TEST ...

b

Hezzages

[

<L

For descriptions of each Check Model check by chart and chart relation, see the following
sections:

*

Charts and GDS Relation Checks
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¢ Statechart Checks

¢ Activity Chart Checks

¢ Module Chart Checks

¢ Global Definition Set Checks

¢ Sequence Diagram Checks
¢ Statechart and Activity Chart Relation Checks

¢ Activity and Module Chart Relation Checks

Automatic Population of Info-Flow

This feature enables a quick resolution for the following check-model errors, using the
check-model suggested actions mechanism:

¢ (C4071) Elements affected by an activity but are neither used internally nor output
¢ (C4073) Elements that are used by an activity but are neither input nor affected internally

When the tool is able to suggest an information-flow path resolving these errors, a new default
action is offered on the error node, called Populate Information Flow(s).

To open the Populate Information Flow dialog box, right-click on the error node in the
Check-Model tree view and select Populate Information Flow(s) > Set Information Flow Path.
This dialog box enables you to define alternate information-flow paths to resolve the check-model
error. When the dialog box opens, it displays the first possible path that resolves the error. You can
modify this suggested information-flow path or select an alternate route.
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Populate Information Flow(s) i |
Message ||ﬁctiuit9 Mame ||P0pulate ||InFo—F10w Path |
¥ {affected by AZ) Al Yes AINFDZ
CONDL {affected by AL} Az Yes FINFOL

]
4 | »l

r Info-Flow Path Browser

Info-Flow Path:

0K | Apply | Clear ALl | Cancel |

To apply the default, suggested path, select Populate Information Flow(s) > Set Default Path.

Suppressing Check Model Checks

To further isolate which errors the tool reports, you can suppress selected errors from the report as
follows:

1. Execute a check on a model profile.
2. Right-click the check name or erroneous error, then select Suppress Selected.

Check Model runs an analysis on suppressed checks, but does not report them. Suppressed errors
remain not visible in the report until you unsuppress them.

To view suppressed errors, select View > Messages Suppression View from the Check Model
Results window (see the following figure).

To unsuppress a check or error, right-click and select Unsuppress Selected.

To add justification as to the rationale behind user’s decision to suppress particular error/warning,
right click and select Edit Justification.

The justification text is displayed in the “Message Suppression View” just under the error/warning
report and is saved in the Check Model Profile, under the specific error/warning section of the
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message suppression view. Users may access that data by reading/parsing the Check Model
Profile.

¢ Messages Suppression View: UTILITY

File VYiew Execute Help

El Completeness
Bl fctivity-chart tests
El Tested Activity-chart: HMAIMTEMANCE_DATA_PAMEL
Gl icdo0ly  Empty information-flows:
Blinformation—Fflow I O_MGRE_2_MHM, . ,

information—flow I0_MGR_Z_MH
=xxxx Jostitication ==xxx
Some explanation and reazoning
of why the reported mezszage iz accepted and s=upressed,
May use multi-line and zimple text,

information—flow I0_MGR_Z2_FPMDOS
information—-flow MM_2_TO0_MGR
information—flow PMDS_Z2_TO0_MGRE

] (C4048)  Unresolved elements:
information—flow UCS_AU=_FAILURE_TRELES
information—flow UCS_A=_LRI_DETAILS

El information—flow UCS_BRE_FAILURE_TARELES, ..
information—-flow UCS_BEK_FAILURE_TABLES
zxxxx Justification =xxxx
Some further explanation and reasoning
aof why the reported meszsage iz accepted and supresszed.
May usze multi-line and =imple text,

information—flow UCS_BRE_LRI_DETHILS
information—Fflow UCS_ECS_FRILURE_TABLES
information—flow UCS_ECS_LRI_DETHILS

—

information—-flow UCS_ESC_FRILURE_TABLES =]
4 I »l
-
Meszages
|
i
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Enabling and Disabling Checks

Enabling and Disabling Checks

To refine the focus of a scan for errors in a model, the Check Model tool provides the option of
configuring which checks run in a given analysis. You can enable or disable any Check Model

check, either for specified profiles or globally, for checks of all model elements within a project,
by a user, or on a system.
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Changing Settings for a Specific Profile

To set check options for a specific profile:

1. Open the profile in Check Model, then select Options > Test Settings. The Test Settings
dialog box opens for the profile, as shown in the following figure.

Test Settings: REAR_DEFOG_TEST

2. Select the type of check to run and the type of charts to check.

3. Disable and enable specific checks by clicking Detailed Settings, then selecting Yes or
No in the Value column.

12
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| check Model Preferences (T
Preferences of: Current -Jl

Groupy

Statecharts

=

&l

:gQJIParameter

|| Walus

=

(CA003}
(L1005}
(CL007 )
(L1009}
(L1010}
(C1011)
(L1013}
(C1015)
(L1017}
(C1019)
(Cao21y
(L1023}

Aliases defined as non wariable or non
Arrays with an out of range index
Arrayz with indices in reverse order
Conztants with inconziztent definition
Data elementz defined az arrayz of bit
Elementz using uninitialized context w
Elementz containing infinite while loo
Elementz containing for loopz with err
Humeric expresszionz uzing bit-arrayz 1
Expreszions containing operation betuwe
Loopz in index definition

Defined data elementz that are uzed in

fres

[
Yes Mo

Yes

Load Values...l
Choose... |

0K |

Apply |

Cancel |

Help |

4. Click OK to save your changes and close the dialog box.

5. Select Save Detailed Settings In Profile to save the preferences for this specific profile

without changing the preference settings in the User Check Model preferences.

6. Click OK to dismiss the Test Settings dialog box.

Rational Statemate
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Changing Global Settings

To set check preferences globally for all charts and diagrams:
1. From the Check Model profile, select Options > Preferences Management.

Alternatively, from the Rational Statemate browser, select Options > Preferences
Management > Check Model to open the Check Model Preferences dialog box.

2. Select the environment for the configuration of your check preferences in the Preferences
of drop-down menu. The possible options are as follows:

+ System - Retrieves the configuration for all checks set on a system

* Project - Retrieves the configuration for all checks set within the currently
selected project

¢ User - Sets the configuration for all checks set by a user

¢ Default - Resets the default configuration for all checks

¢ Current - Displays the current preferences of the active window session
Note: System and Project settings are permission-sensitive.

3. Select the chart configuration you want to display from the Group drop-down menu
4. Enable or disable checks in the Value column.

5. Click Apply, then OK.

Note

System and Project preferences can be enforced (values cannot be changed by the user).
This information is displayed in the Enforced column.
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General Check Model Preferences

Check Model also provides a means so that the user can control some preferences that are not
specific to any checks.

To access these preferences, select from the Main window Project > Preference Management >

Check Model.
Check Model Preferences x|
Preferences oft  lUser — |
Graoup? Gereral Check Model Preferences = |
Enforced " Parameter " Value ||
Scope View Tree view Load Values...l
Require Box Attributes for Instance Boxes Mo
Report Errorsddarnings for Unresolved Elements ‘fes Choose, , . |
Prepare Auto-Fopulation Paths Mo
Apply tests 4075 and 4077 to offpage instances Mo
Apply tests 4070 and 4077 to Activitiesz with Selected-Implementation "Mone”  Yes
Erhanced Show In Model In Results Tree fes
Statemate MicroC Compatibility Tests (for Statemate? ‘fes
Design Tests ‘fes
0k | Apply I Cancel | Help |

+ Scope View controls the method that test results are displayed to the screen.
+ Require Box Attributes for Instance Boxes:

— Set to No when you want to eliminate the Check Model tests 6005, 4005,
2003, 17003 (“Elements with incorrect or incomplete attribute definitions™)
for instance boxes.

— Set to Yes for the Check Model tool to check for box attributes also in
instance boxes.

¢ Report Errors/Warnings for Unresolved Elements:

— Set to Yes when you want the Check Model tool to report various Warnings
and Errors regarding the element, according to the selected Check Model
checks.

— Set to No when you want the Check Model tool to report only those elements
that are unresolved. No other Warnings or Errors are generated for the
unresolved elements.

+ Prepare Auto-Population Paths controls the calculation of the C4073/C4071
default-action (calculation of possible information flow paths) with a preference. In order
to enable the feature of automatic population, set to Yes. The default value is No.
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Apply tests 4075 and 4077 to offpage instances controls whether or not to expand the
following tests also for nonbasic activities (off-page):

— (C4075) Elements output from activity that are not affected (generated or
modified) internally.

— (C4077) Elements input to activity that are not used internally.

Apply tests 4075 and 4077 to Activities with Selected Implementation ‘None’ controls the
execution of Check Model tests 4075 and 4077 for activities with
Selected-Implementation ‘“None’. When set to No, tests 4075 and 4077 will not check
activities with selected implementation ‘None’. The default is Yes.

Enhanced Show In Model In Results Tree controls the availability of the Show in
Model option from the Check Model results tree for an enhanced list of tests.

Rational Statemate MicroC Compatibility Tests (for Rational Statemate) controls the
execution of Rational Statemate MicroC compatibility tests in Rational Statemate Classic.
The default is No.

Design Tests controls the execution of the “Design” tests of the Check Model tool. A new
Check Model profile reads this preference and uses its value as the default value for the
Design check box on the Test Settings dialog box (to open, select Options > Test
Settings). The default is Yes.

16
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Check Model Test Settings File

Check Model Test Settings File

You can create and use Check-Model test-sets. Test-sets are files that define enabled/disabled
Check-Model tests that are saved in the Rational Statemate Preferences directory and are available
for all users using that directory.

To manage test setting files:

1. Choose Tools > Check Model to open the Check Model dialog box and the New/Open
Check Model Profile dialog box.

2. On the New/Open Check Model Profile dialog box, select a profile or create a new one.

3. On the Check Model dialog box, choose Options > Test Setting Configurations to open
the Test Settings Configuration dialog box, as shown in the following figure:

Test Setting Configurations - O] x|

[7 Load Test Settings From File: |<< Henwe b

Setting Files: Files - Ileletel

K1_TESTSETTIMG
K2_TESTSETTIMG
K3_TESTSETTIMG

A I

Save Current Test Settings HS..,l

(K | Cancel | Help |

B | i

4. Depending on what you want to do, you can:
+ Choose a test setting file from which to load test settings for the current session;
click the Load Test Settings From File check box.

+ Save the current test settings (as defined on the Test Setting dialog box, which you
open by choosing Options > Test Settings) as a test settings file; click the Save
Current Test Settings As button.

+ Delete a test setting file; click Delete.

Rational Statemate 17



Using the Check Model Tool

18

Check Model Guide



Charts and GDS Relation Checks

This section provides the Check Model checks for chart and Global Definition Set (GDS)
relations. The checks are listed in numerical order:

(C7601) Loop in chart usage

There are generic/off-page charts whose usage of each other causes a loop.
Error In:

Correctness
Example:

AAA is an off-page chart used in a generic chart GGG; BBB is an off-page chart used in chart AAA.
GGG (generic) is instantiated in chart BBB.

Erroneous Elements:

All charts in the loop

(C7603) lllegal usage type of charts

Charts that exist in the model are used as charts of another type.
Error In:

Correctness
Example:

Activity-chart AAA is used as an off-page chart of a state S@AAA. Generic chart GGG is used as an
off-page chart S@GGG.

Erroneous Elements:

Charts
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(C7605) Multiple offpage instances

There are charts referenced as off-page charts of more than one box.
Error In:

Correctness
Example:

SSs is a statechart. There are two states in the model using this statechart as an off-page chart,
S1@SSS and S2@sssS.

Erroneous Elements:

Charts

(C7607) Inconsistent usage of chart

Charts that are not defined in the model are used inconsistently, both as off-page and generic,
or in one place as a statechart and in another as an activity-chart.

Error In:
Correctness
Example:
Sss does not exist in the model. There are two states in the model: S1@sSS and S2<Sss.

AAA does not exist in the model. There is a control activity CTRL@AAA (AAA is used as a
statechart) and a regular activity A1@AAA (AAA is used as an activity-chart).

Erroneous Elements:

Charts
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(C7609) Inconsistency of parameter bindings in different generic instances

(C7609) Inconsistency of parameter bindings in
different generic instances

Instance boxes of the same generic chart have an inconsistent binding to the same formal
parameter.

Error In:
Correctness
Example:
A<GGG and B<GGG are two instances of the generic GGG.

¢ InA, event E is bound to formal parameter P1 and in B, data-item D is bound to P1.
¢ InA eventGisboundto P2 and in B, there is no actual binding to pP2.

Erroneous Elements:

Instance boxes

(C7611) Mutual references in global definition sets

Global Definition Sets (GDSs) have references to elements in other global definition sets (in a
“circular” manner).

Error In:
Correctness
Example:
GLOBAL_TYPES is a GDS that contains the following definitions:

¢ BIG_ARRAY is an integer array from 1 to K.
¢ MY_INT is an integer from 1 to 10.
CONSTANTS is a GDS that contains the following definitions:

¢ Kisdefined as a constant integer equal to 5.
¢ Mis defined to be of type MY_INT.
GLOBAL_TYPES and CONSTANTS are two global definition sets that have mutual references.
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Erroneous Elements:

Global definition sets

(C7701) Multiple root charts in Workarea

The workarea contains multiple regular charts (non-generic) that are not used as off-page
charts of other boxes. Therefore, the static structure of charts has multiple roots.

Error In:
Completeness
Erroneous Elements:

Charts

(C7703) Missing charts in Workarea

Charts are referenced as generics or off-page, but are not defined in the workarea.
Error In:

Completeness
Erroneous Elements:

Charts

22 Check Model Guide



(C7705) Multiple subroutines with the same name

(C7705) Multiple subroutines with the same name

Subroutines are defined in different charts with the same name.
Error In:

Completeness
Format:

The format is as follows:

<subroutine name> i i
<Task/Procedure/Function> <chart name>:<subroutine name>

Example:

MULT
Function SCH:MULT
Function SCH_ADA:MULT

Erroneous Elements:

Subroutines

(C7707) Procedural charts not connected to any
subroutine

Procedural statecharts/flowcharts are not connected to any subroutine.
Error In:

Completeness
Erroneous Elements:

Charts
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(C7709) Procedural charts connected to more than one
subroutine

Procedural statecharts/flowcharts are connected to more than one subroutine.
Error In:

Completeness
Erroneous Elements:

Charts
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Statechart Checks

This section provides the Check Model checks for statecharts. The checks are listed in numerical
order.

(C1001) Loops in element definition

Textual elements use themselves in their own definition, via a “chain” definition.
Error In:

Correctness
Example:

Compound event E1 is defined as ‘E2 or E3~; E2 is defined as “E1 or E4”.
Erroneous Elements:

All textual elements in the loop

(C1003) Aliases defined as non variable

Aliases are illegally defined because the element appearing in the definition of the alias is
defined as a non-variable compound or constant, or it is not a bit-array.

Error In:
Correctness
Erroneous Elements:

Data-items
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(C1005) Arrays with an out of range index

Arrays or bit-arrays are used with an index value that is out of the defined index range.
Error In:

Correctness
Example:

A‘is an integer array from 1 to 100. The model contains the following action:

A(101)=1

Erroneous Elements:

Data-items, fields, conditions, and events

(C1007) Arrays with indices in reverse order

There are arrays or bit-arrays for which there are references to slices whose borders are in a
reverse order relative to their type definition.

Error In:
Correctness
Example:

A'is a bit-array from 31 down to 0. The model contains the following action:

A(0..7)=3

Erroneous Elements:

Data-items, fields, conditions, and events
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(C1009) Constants with inconsistent definition

(C1009) Constants with inconsistent definition

There are either constant data-items or conditions whose values do not match their type
definition; constant strings, arrays, or integers whose length does not match their defined
length; or a constant integer whose value is not in the defined value range.

Error In:
Correctness
Erroneous Elements:

Data-item or condition

(C1010) Data elements defined as arrays of bit

Elements are defined as array of a user-defined type (UDT), which is defined as bit.
Error In:

Correctness
Example:

D11 defined as array of BIT1, which is defined as bit.
Erroneous Elements:

Data-items, UDTs, and fields

Rational Statemate 27



Statechart Checks

(C1011) Elements using uninitialized context variables

Elements contain action expressions that use an uninitialized context variable.
Error In:

Correctness
Example:

There is a transition labeled with the following label:

E 7 Y=8$X; $X=Z

$X is used before any value is assigned to it.

Erroneous Elements:

States, transitions, and actions

(C1013) Elements containing infinite while loops

This check detects cases in which the whi Ie loop control expression does not contain a context
variable and there is no break statement in the loop.

Error In:
Correctness
Erroneous Elements:

States, transitions, and actions
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(C1015) Elements containing for loops with erroneous range indices

(C1015) Elements containing for loops with erroneous
range indices

Elements contain action expressions in which there are for loop statements with invalid
ranges.

Error In:
Correctness
Example:
There is an action that contains the following for loop statements:
for $1 in 10 to 1 loop
for $1 in 1 down to 10 loop
Erroneous Elements:

States, transitions, and actions

(C1017) Numeric expressions using bit-arrays longer
than 32 bits

There are elements containing numeric expressions that use bit-arrays longer than 32 bits.
There is an automatic conversion from a bit-array to a numeric value only for a bit-array that is
less than or equal to 32 bits.

Error In:
Correctness
Erroneous Elements:

States, transitions, and actions
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(C1019) Expressions containing operation between
arrays with unequal length

Elements contain assignments or comparisons between arrays or array slices of different
lengths.

Error In:
Correctness
Example:

There is an action that contains the assignment A=B, where A is defined as an array from 1 to 3,
and B is an array from 1 to 5.

Erroneous Elements:

States, transitions, and actions

(C1021) Loops in index definition

Data elements use constants in their definition in a “circular” manner.
Error In:

Correctness
Example:

AR is an array from 1 to N, while N is defined as rindex (AR).
Erroneous Elements:

Data-items, conditions, events, and user-defined types
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(C1023) Defined data elements that are used incorrectly

(C1023) Defined data elements that are used
incorrectly

Elements contain expressions in which data-items that are explicitly defined to be of some
data-type are used in a way that does not match the type consistency and conversion rules.

Error In:
Correctness
Example:

1 is defined as an integer; S is defined as a string. There is an action that contains the following
assignment:

1=S
Erroneous Elements:

States, transitions, events, conditions, data-items, and actions

(C1025) Data elements without type definition that are
used inconsistently

There are unresolved or explicitly defined data-items with no type definition that are used in
expressions in an inconsistent manner.

Error In:
Correctness
Example:

D is an unresolved element (it is not explicitly defined); 1 is an integer; S is a string. D appears
in the following assignments:

D=1; D=S
Erroneous Elements:

Data-items, conditions, and user-defined types
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(C1027) Predefined Statemate functions that are used
incorrectly

Predefined Rational Statemate functions are used with parameters of a wrong type, the wrong
number of parameters, or the wrong return type.

Error In:
Correctness
Erroneous Elements:

Functions

(C1029) Subroutines that are used incorrectly

User functions are used inconsistently in different expressions (for example, with different
return type, different parameter type, or a different number of parameters).

Note: When working with MicroC components, this test also reports situations where

a subroutine is called with an actual ‘out’ parameter that is bound to an external
symbol with get/set APlIs.

Error In:
Correctness
Erroneous Elements:

Functions

(C1031) Loops in compound transitions

A group of transition segments, linked through connectors, creates a loop (cycle) that does not
contain a state.

Error In:
Correctness
Erroneous Elements:

Transition segments in the loops
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(C1033) Default transitions with illegal sources

(C1033) Default transitions with illegal sources

Transitions have multiple sources and one of them is either a conditional connector or a
history connector.

Error In:
Correctness
Example:

In the following figure, the compound transition entering s4 (whose source set consists of the
default connector in s1 and the state S2) is an erroneous transition.

- EN

e

51

[c2] [::::::::::::]
C L 54

[c1]

S 7/

Erroneous Elements:

Components of the erroneous transitions
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(C1035) Default transitions with illegal targets

There are transitions whose source is a conditional connector or a history connector, and
whose targets are not descendants of the state in which the source connector resides.

Error In:
Correctness
Example:

In the following figure, there are two possible default states when entering s1. One entrance
leads to s3 (which is a substate of s1) and the other leads to s2 (which is not a descendant of
S1 and is therefore an invalid transition).

s N

: ’i 52 I

Erroneous Elements:

Components of the erroneous transitions
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(C1037) Compound transitions with nonorthogonal sources

(C1037) Compound transitions with nonorthogonal
sources

There are compound transitions whose source set of states contains nonorthogonal (exclusive-
or) states.

Error In:
Correctness
Example:

In the following figure, s1 and S2 are nonorthogonal states whose exiting transitions are
contained in an illegal compound transition.

RE

52

Erroneous Elements:

Components of the erroneous transitions
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(C1039) Compound transitions with nonorthogonal
targets

There are compound transitions whose target set of states contains nonorthogonal (exclusive-
or) states.

Error In:
Correctness
Example:

In the following figure, the target states of s1 contain the exclusive-or states s2 and s3.

4 ™
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Erroneous Elements:

Components of the erroneous transitions

36 Check Model Guide



(C1041) Or states without a default entrance

(C1041) Or states without a default entrance

There are states of type “or” (decomposed into exclusive states) with entering transitions but
with no “default” entrance.

Error In:
Correctness
Example:

In the following figure, s1 is an or state consisting of s2 and s3. A transition triggered by
event E enters S1, but because s1 has no default entrance, the actual target of this transition is
not defined.

4 N
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Erroneous Elements:

States
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Statechart Checks

(C1043) The tested statechart has multiple top-level
states and no default entrance

There are several top-level states in the statechart and no default transition is drawn to any of
them.

Error In:
Correctness
Erroneous Elements:

The test chart

(C1045) Instance off-page connectors with same name
as in-page connector

Diagram connectors drawn in an instance state have the same name as another in-page
connector in the chart.

Error In:
Correctness
Example:

In the following figure, the instance off-page connector AB12 erroneously has the same name
as the in-page connector, the target of the transition from b.

4 N

AB12 =« ! o I
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(C1047) Multiple instance off-page connectors with conflicting arrow directions

Erroneous Elements:

Instance connectors

(C1047) Multiple instance off-page connectors with
conflicting arrow directions

Diagram connectors are drawn in an instance state in which another connector having the
same name but conflicting arrow directions is drawn.

Error In:
Correctness
Erroneous Elements:

Instance connectors
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Statechart Checks

(C1049) Definition off-page connectors with same
name as in-page connector

Definition off-page connectors match to an instance off-page connector and have the same
name as an in-page diagram connector.

Error In:
Correctness
Example:

In the following figure, the definition chart B has an off-page diagram connector AB12. The
off-page connector has the same name as the in-page connector and is therefore illegal.

s A e
Erroneous Elements:

Connectors
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(C1051) Definition off-page connectors with conflicting arrow directions in instance off-page

(C1051) Definition off-page connectors with conflicting
arrow directions in instance off-page connector

There are definition off-page connectors whose matching connector in the instance chart has a
conflicting arrow direction.

Error In:
Correctness
Example:

In the following figure, the instance A@B has an arrow entering the diagram connector AB12. Its
definition chart B, however, has an arrow exiting the top-level box to the connector AB12.

|
AB12 | P

Erroneous Elements:

Definition off-page connectors
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Statechart Checks

(C1053) Generic instances with inconsistent parameter
binding
There is inconsistency between the actual bindings in the instance box and the defined formal
parameters in the generic chart.
Error In:
Correctness
Erroneous Elements:

Instance boxes

(C1055) The tested chart has combinational
assignments and it is instantiated by states

The tested chart contains combinational assignments and is used on an off-page chart for some
state. This situation is illegal because it is misleading.

Error In:
Correctness
Erroneous Elements:

The tested chart
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(C1057) Combinational elements aliases of registered elements or vice versa

(C1057) Combinational elements aliases of registered
elements or vice versa

An alias data-item is used as a combinational element—it is assigned a value in a
combinational assignment, whereas the element that appears in its definition is used as a
registered element, or vice versa.

Error In:
Correctness
Erroneous Elements:

Data-items

(C1059) Combinational elements assigned a value
multiple times in the same entity

A data-item is assigned a value in two separate combinational assignments in the tested
statechart.

Error In:
Correctness
Erroneous Elements:

Data-items
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Statechart Checks

(C1061) Elements using field references that do not
appear in the record/union definition

Elements contain expressions in which a field of an explicitly defined record or union is used,
but the field does not appear in the record or union definition.

Error In:
Correctness
Erroneous elements:

States, transitions, and textual elements

(C1062) Elements erroneously using field references

Elements erroneously reference fields.
Error In:

Completeness
Erroneous Elements:

Any element referencing fields.
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(C1063) Formal parameters whose data-type is not global

(C|:186|3) Formal parameters whose data-type is not
globa

Formal parameters are defined to be of some User-Defined Type (UDT), but the UDT is
defined in the generic chart. The UDT is not visible outside the generic chart; therefore, an
actual binding cannot have this type.

Error In:
Correctness
Erroneous Elements:

Data-items (formal parameters)

(C1065) Actual binding whose data-type is not global

Data-items used as actual bindings in an instance box are defined to be of some User-defined
Type (UDT), but the UDT is not global (it is defined in some chart, and not in a GDS). This
UDT is not visible to the generic chart; therefore, a formal parameter cannot have this type.

Error In:
Correctness
Erroneous Elements:

Data-items
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Statechart Checks

(C1067) Empty Records/Unions

Data-items or data-types are defined to be a record or union, but there are no fields defined in
the structure. This is a correctness error because it is a fatal error situation for some tools.

Error In:
Correctness
Erroneous Elements:

Data-items or user-defined types

(C1071) Tasks/Procedures that are used incorrectly

Tasks can be bound only to activities. Any other usage (for example, in expressions) is
incorrect. Procedures and functions cannot be bound to activities.

Error In:

Correctness
Example:

TASK PRINTER is used as procedure/function in the definition of SCH:AN1.
Erroneous Elements:

Subroutines
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(C1075) Elements containing out of range assignments of enumerated values

(C1075) Elements containing out of range assignments
of enumerated values

An element of some subtype is assigned a value that belongs to the enumerated type, but is not
in the range of the subtype.

Error In:
Correctness
Example:

in definition of SCH_ADA:ACTION WORKING_DAY=SAT

Erroneous Elements:

Textual elements, boxes, and arrows

(C1077) Procedures/Functions that are used
incorrectly

Either procedures are used as functions (treated in some expression as if they return a value),
or functions are used as procedures (called in expression where an action is expected).

Error In:
Correctness
Example:

Function FACTORIAL used as Procedure in definition of SCH_ADA:ACTION:
FACTORIAL(Y)

Erroneous Elements:

Subroutines
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Statechart Checks

(C1079) Callback procedures that are used/defined
incorrectly

Procedures are used as callbacks, whose first parameter is not of type string or not of mode
Input.

Error In:
Correctness
Example:

CALLBACK P1, is an “Output” parameter

Erroneous Elements:

Subroutines

(C1081) Elements containing subroutine calls with
conflicting length of parameters

There are subroutine calls where the actual parameter’s length conflicts with the
corresponding formal parameter definition, or whose length is unknown.

Error In:
Correctness

Example:

STATE1
CALLBACK(A,ARRAY,3)
ARRAY - Unknown length

Erroneous Elements:

Textual elements, boxes, and arrows
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(C1083) Procedural statechart without termination connector

(C1083) Procedural statechart without termination
connector

There is a procedural statechart with no termination connector. This means that any call to the
connected subroutine will never end.

Error In:
Correctness
Erroneous Elements:

Charts

(C1085) Elements not declared as parameters or as
variables

There are elements used in the tested procedural statechart/flowchart that are not declared as
local variables, parameters, or global data of the connected procedure.

Error In:
Correctness

Example:

data-item L2
condition C

Erroneous Elements:

Data-items and conditions
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Statechart Checks

(C1087) Local variables overriding parameters or
global definitions

A local variable of the tested procedural statechart/flowchart overrides a parameter or global
definition of the connected procedure.

Error In:
Correctness
Example:

P1 overriding parameter

Erroneous Elements:

Local variables

(C1089) Subroutines using recursive calls

Subroutines use recursive calls (either directly or by other subroutines).
Error In:
Correctness

Example:

SR3 called from SR2
SR2 called from SR3

Erroneous Elements:

Subroutines
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(C1091) Subroutines using elements not declared as parameters, local-variables or globals

(C1091) Subroutines using elements not declared as
parameters, local-variables or globals

Subroutines that use elements are not declared as parameters, local-variables, or globals. All
elements used in the subroutine code should be declared, including constant data-items and
conditions, enumerated values, other subroutines, and user-defined types.

Error In:
Correctness
Example:

subroutine F L2

Erroneous Elements:

Subroutines

(C1093) Subroutines that contain references to
activities
The subroutine contains references to activities.
Error In:
Correctness
Erroneous Elements:

Subroutines
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Statechart Checks

(C1095) Subroutines with illegal parameter type or
return type

There is a subroutine where a User-Defined Type (UDT) is the return type, or the type of a
parameter. The following table below lists the illegal definitions for UDTSs.

Type Return Type Parameter
UDT array of string *) **||legal**
UDT array of bit-array *) **||legal**
UDT array of direct R/U *) **||legal**
UDT queue of anything **[|legal** **||legal**
Array of queue (any **[llegal** **||legal**
dimension)

(*) In these cases, a middle UDT is needed. For example, if the return type of a function
should be an array of string, it should be defined as:

UDT array of STR_UDT, and STR_UDT, a string

Error In:
Correctness
Format:
subroutine <subroutine name>
return type <user-def type>, defined as <type>
<user-def type>, type of parameter <parameter>,
defined as <type>
Example:

subroutine F1
return type ARR_STR1, defined as array of string
STR_QUEUE1l, type of parameter P1l, defined as queue

Erroneous Elements:

Subroutines
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(C1097) Subroutines with illegal local variables type

(C1097) Subroutines with illegal local variables type

Local variables are defined as a User-Defined Type (UDT), as a queue, or an array (of any
dimension) of a queue.

Error In:
Correctness
Erroneous Elements:

Subroutines

(C1099) Local variables with illegal type

Local variables are defined as a user-defined type (UDT), as a queue, or an array (of any
dimension) of a queue.

Error In:
Correctness

Example:

subroutine F1

STR_QUEUE1, type of local variable LV1, defined
as queue

Erroneous Elements:

Subroutines
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Statechart Checks

(C1101) Subroutines with illegal/missing return
command

There are functions without a RETURN command, procedures with a RETURN command, or a
function with a return type that conflicts with the returned value’s type.

Error In:
Correctness
Erroneous Elements:

Subroutines

(C1103) Subroutines that call other subroutines whose
global elements are missing from the calling
subroutine definition

Global elements of a subroutine, sus, must be declared as global elements of any other
subroutine that calls SuB.

Error In:
Correctness
Erroneous Elements:

Subroutines

(C1105) Subroutines with local variables/parameters
overriding parameters/globals

There are subroutines with local variables that override parameters or globals, or there are
parameters that override globals.

Error In:
Correctness
Erroneous Elements:

Subroutines
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(C1107) Subroutines with illegal combination of type and implementation

(C1107) Subroutines with illegal combination of type
and implementation

There are subroutines with an illegal combination of type and implementation.
Error In:

Correctness
Erroneous Elements:

Subroutines

(C1109) Elements containing a truth table with illegal
factorization structure

United input cells are not nested in a previous union; or, there are two or more rows that share
the same input section, but have different output sections.

Error In:
Correctness
Erroneous Elements:

Subroutines and actions

(C1111) Elements containing a truth table with illegal
combination of inputs

Elements are described by truth tables using the same element twice as an input (via aliases).
This check ensures that the same element is not used twice as a whole, but does not check
overlapping of slices.

Error In:
Correctness
Erroneous Elements:

Subroutines and actions
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Statechart Checks

(C1113) Elements containing a truth table with illegal
combination of outputs

Elements are described by truth tables using the same element twice as an output (via aliases).
Error In:

Correctness
Erroneous Elements:

Subroutines and actions

(C1115) Elements containing out of range integer/real
assignments

Elements contain assignments of integers, where an out-of-range value is assigned to a
restricted range integer, or one restricted range integer is assigned to another where there is no
intersection of ranges. It tests if an integer or real value is compared with a value outside its
range, as well as values assigned to integer or real variable.

Error In:
Correctness
Erroneous Elements:

States, actions, data-items, and transitions
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(C1117) Transitions without a return command whose target is a termination connector

(C1117) Transitions without a return command whose
target is a termination connector

If a procedural statechart implements a function and not a procedure, any transition that ends
in a termination connector must return a value. Otherwise, the function is terminated without a
return value.

Error In:
Correctness
Erroneous Elements:

Transitions

(C1119) Transitions containing a return command
whose target is not a termination connector

Functions end, but not in a termination connector.
Error In:

Correctness
Erroneous Elements:

Transitions

(C1121) Transitions with incomplete source definition

There are transitions whose source is not connected to a state or connector. The source of such
a transition appears in the statechart as a small line perpendicular to the transition.

Error In:
Completeness
Erroneous Elements:

Transitions
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Statechart Checks

(C1123) Transitions with incomplete target definition

There are transitions whose target is not connected to a state or connector. The target of such a
transition appears in the statechart as a small line perpendicular to the transition.

Error In:
Completeness
Erroneous Elements:

Transitions

(C1125) Switch/Case structure contains more than one
default entry

The switch_c statement has more than one default case entry, or the case_ada Statement has

more than one others when_ada entry.

Error In:
Correctness

Example:

switch_c (X)
{

case c 1:
Y=1;
default:
Y=0;

case_c 2:
Y=2;
default:
Y=3;

b

Erroneous Elements:

Actions, states, and transition labels
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(C1127) lllegal switch structure: contains conditional break

(bC11§7) lllegal switch structure: contains conditional
rea

The break action is not supported in i ¥ blocks.
Error In:

Correctness
Example:

switch(X) {
case RED: y=5;
iT(COND1) then break
endif;
break
Erroneous Elements:

Actions, states, and transition labels

(C1129) More than one arrow with the ‘else’ trigger exit
single source

There is more than one arrow with the ‘else’ trigger that are exiting from the same source.
Error In:

Correctness
Erroneous Elements:

Transitions, Flow Arrows
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Statechart Checks

(C1131) lllegal switch structure: non-unique selected
entries

The switch_c structure contains a case entry that is repeated. Only the first entry will be
executed.

Error In:
Correctness
Example:

switch_c (X)
{

case_c 1:
Y=1;
case_c 1:
Y=2;
default:
Y=3;
}

Erroneous Elements:

Actions, states, and transition labels

(C1133) Inconsistent initial value

An element has a default value that is inconsistent with its type and range definition.
Error In:

Correctness
Example:

Integer data-item x has a minimum value of 0, maximum value of 20, and a default value A.
Integer data-item A is a constant set to 40. Because A is outside the minimum and maximum for
X, it is an inconsistent initial value.

Erroneous Elements:

Integer and real data-items
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(C1135) Inconsistent range definition

(C1135) Inconsistent range definition

This test warns about user-defined type definitions where the sub-type ranges are inconsistent
with the parent type definition.

Error In:
Correctness

Example:

INT_TYPE is an integer User Defined Type and has a defined minimum/maximum range of
10 - 100 (as shown in the first figure below). SUB_INT_TYPE is a User Defined Type of
INT_TYPE and has a range defined outside of 10 - 100 (as shown in the second figure below).
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Structures ISingle j

Data Type: IInteger‘ j Hin:ll() Hax:llOO Default '-z'alue:l
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Definitiong | -

|Name ||DeFine-:I In || Type || Dief :|ch:|e ||i|
INT_TYPE GCIs1 UzerDef Typ Yes  Update

SUB_INT_TYPE UserDef Tup
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Gereral Definition Iﬂttr-ibutes I]]esign Attributes |Descr‘iption I F i
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Data Type: IUSEI" Type j IINT_T’T’PE j
Subtype Rangea...l Subtype Ranges ﬂ
Definition: |- Hin: |2 Has | 102
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Statechart Checks

Erroneous Elements:

User-defined types

(C1137) Empty information-flows

Array index expression does not result in an integer or contain elements with illegal type.
Error In:
Correctness
Example:
Case I:
Arr2 is an integer array from LeftInd2 to Rightind2.
LeftInd2 is defined as:
Single, Constant, with Data Type set to None, and definition set to SubDef2
SubDef2 is defined as:
Single None Constant with definition set to 2.34
Case ll:
Arrl is an integer array from LeftInd to Rightind.
LeftInd is defined as:
Single, Constant, with Data Type set to None, and definition set to SubDef
SubDef is defined as:

Single String Constant with definition set to 'My Definition’
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(C1139) Transitions with priority settings which violate Statechart semantics

(C1139) Transitions with priority settings which violate

Statechart semantics

Transitions who's priority settings contradict the Statechart hierarchical Transition Priority
rule, by which priority is given to the transition for which the parent state common to both
source and target states is of a higher hierarchical level.

Error In:
Correctness
Example:

In the following figure, according to the Statechart hierarchy Transition Priority rule the
transition to S3 has higher priority than the transition to S2, but the user-defined priority is
lower, and thus prioritization will be ignored.
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Erroneous Elements:

Transitions
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Statechart Checks

(C1141) 'else’ Transitions with priority

Prioritized transition labeled with 'else’ trigger.
Prioritization of 'else' triggered transitions is not supported.

Error In:
Correctness
Erroneous Elements:

Transitions

(C1143) Default Transitions with priority (not
supported)

Prioritization of default transitions is not supported.
Error In:

Correctness
Erroneous Elements:

Default Transitions
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(C2001) Missing actual values

(C2001) Missing actual values

There is an instance box in whose property sheet there are formal parameters, without an
actual binding.

Error In:
Completeness
Erroneous Elements:

Instance boxes

(C2003) Elements with incorrect or incomplete
attribute definitions

There are elements in whose property sheet there is an attribute name without a corresponding
attribute value, or vice-versa.

Error In:
Completeness
Erroneous Elements:

Elements of all types

(C2004) Elements with non-unique attribute definitions

Element contains more than one attribute with the same name.
Error In:

Completeness
Erroneous Elements:

Any element with attributes
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Statechart Checks

(C2005) Elements that are not referenced in Statemate
expressions and definitions

There are textual elements explicitly defined in the properties, but there is no reference to them
in the model.

Error In:
Completeness
Erroneous Elements:

Textual elements

(C2007) Elements using redundant context variables

Elements contain actions with context variables that are assigned a value, but not used in the
action.

Error In:
Completeness
Erroneous Elements:

States, transitions, and actions

(C2009) Elements that could be defined lower in the
hierarchy of charts

There are textual elements explicitly defined in the tested chart that are used only in other
charts, which could be defined in the lower chart hierarchy without changing the resolution
results.

The lowest chart in which they could be defined is the lowest common ancestor of all the
charts in which references to this element exist.

Error In:
Completeness
Erroneous Elements:

Textual elements
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(C2011) Elements that reference unnamed boxes

(C2011) Elements that reference unnamed boxes

Elements contain references to states that have no names. This situation can occur if a name of
a referenced state is deleted.

Error In:
Completeness
Erroneous Elements:

Events, conditions, actions, states, and transitions

(C2013) Elements containing references to
components of non-array elements

Error In:
Completeness
Description:

Elements contain data-item expressions with indices, but the accessed data-item is not an
array.

Erroneous Elements:

Actions, states, conditions, and transitions

(C2015) Elements containing comparisons of unions:
(not supported in Code Generation)

Elements contain comparisons of two union data-items. The comparisons of two unions is
ambiguous because the result depends on which field of the unions is the current field in each
element.

Error In:
Completeness
Erroneous Elements:

Actions, states, conditions, and transitions
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Statechart Checks

(C2021) Unlabeled transitions exiting from selection or
condition connectors

There are transition segments whose source is either a selection connector or a condition
connector, and no label is attached to them.

Error In:
Completeness
Erroneous Elements:

Transitions

(C2023) Compound transitions without a trigger

There are compound transitions, none of whose segments contains a trigger part in their labels.
Error In:

Completeness
Example:

The following figure shows two compound transitions, where the second transition is in
correct. The transition from S1 to S2 contains the trigger event E. The transition from s1 to S3
is labeled with an action A, but the trigger is missing.
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(C2025) States without incoming transitions

Erroneous Elements:

Components of the erroneous transitions

(C2025) States without incoming transitions

There are states with no entering transition. Therefore, they are unreachable.
Error In:

Completeness
Erroneous Elements:

States

(C2027) Basic states with a history connector

There are states that have no descendants, but have a history or deep history connector.
Error In:

Completeness
Erroneous Elements:

States

(C2029) Basic states that are “history-cleared”

There are states that have no descendants, but are referenced in a clear history (hc?) action.
Error In:

Completeness
Erroneous Elements:

States
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Statechart Checks

(C2031) States with incomplete static reactions

There are states in which there is a static reaction that contains either a trigger or action, but
not both.

Error In:
Completeness
Erroneous Elements:

States

(C2033) States with static reaction triggered by
condition

There are states with a static reaction whose trigger contains a condition without a preceding
event (for example, [Cc]). When the condition is true, it is possible that a stationary situation is
never reached. The static reaction is performed repeatedly, unless the condition changes its
value or an event occurs that causes an exit from the state.

Error In:
Completeness
Erroneous Elements:

States

(C2035) Isolated connectors

There are connectors with no entrances and no exits.
Error In:

Completeness
Erroneous Elements:

Connectors
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(C2037) Junction, selection, condition, history or diagram connectors with exits but no entrance

(C2037) Junction, selection, condition, history or
diagram connectors with exits but no entrance

There are junction, selection, condition, or history connectors, or a group of in-page diagram
connectors with the same name, having exits but no entrance. Therefore, there is no compound
transition between states, including the existing transitions.

Error In:
Completeness
Erroneous Elements:

Connectors

(C2039) Junction, selection, condition, or diagram
connectors with entrances but no exit

There are junction, selection, or condition connectors or a group of in-page diagram
connectors with the same name, having entrances but no exit. Therefore, there is no compound
transition between states, including the entering transitions.

Error In:
Completeness
Erroneous Elements:

Connectors
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Statechart Checks

(C2041) Junction connectors with a single entrance
and a single exit

There are junction connectors with a single entrance and a single exit. Therefore, they are
probably redundant.

Error In:
Completeness
Erroneous Elements:

Connectors

(C2043) Selection and condition connectors with
entrances but only a single exit

There are selection and condition connectors with entrances, but only a single exit. Therefore,
they are probably redundant.

Error In:
Completeness
Erroneous Elements:

Connectors

(C2045) Unresolved elements

The referenced element is not defined.
Error In:

Completeness
Erroneous Elements:

All types of elements
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(C2047) The tested chart is a definition chart with multiple top-level boxes

(C2047) The tested chart is a definition chart with
multiple top-level boxes

The tested chart is used as an off-page definition of an instance state and has multiple top-level
states.

Error In:
Completeness
Example:

In the following figure, the off-page chart B erroneously has more than one top level box (c
and D).

Erroneous Elements:

The tested chart
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Statechart Checks

(C2049) The tested chart is a definition chart with
empty top-level box

The tested chart is used as an off-page definition of an instance state and has a single, empty,
top-level state with no static reactions.

Error In:
Completeness
Erroneous Elements:

The tested chart

(C2051) Instance off-page connectors without a
matching definition off-page connector

Instance off-page connectors have no matching definition diagram connector.
Error In:

Completeness
Erroneous Elements:

The tested chart

(C2053) “In” parameters not used in the chart

Input or InOut parameters are not used in the statechart.
Error In:

Completeness
Erroneous Elements:

Textual elements and activities (parameters)
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(C2055) “Out” parameters not affected (generated or modified) in the chart

(C2055) “Out” parameters not affected (generated or
modified) in the chart

Output or InOut parameters are not generated or modified in the statechart.
Error In:

Completeness
Erroneous Elements:

Textual elements and activities (parameters)

(C2057) Elements that are used in the chart are neither
“Iin” parameter nor affected (generated or modified)
internally

Elements are used in a statechart but are neither input parameters nor affected internally.
Error In:

Completeness
Erroneous Elements:

Events, conditions, data-items, and activities
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Statechart Checks

(C2058) Elements affected (generated or modified) by
the chart, but are neither “out” parameter nor used
internally

Elements affected by the statechart are neither output parameters nor used internally.
Error In:

Completeness
Erroneous Elements:

Events, conditions, data-items, and activities

(C2059) “In” parameters affected (generated or
modified) in the chart

Input or InOut parameters are generated or modified in the statechart.
Error In:

Completeness
Erroneous Elements:

Textual elements and activities (parameters)

(C2060) “Out” parameters used in the chart

Output or InOut parameters are used in the statechart.
Error In:

Completeness
Erroneous Elements:

Textual elements and activities (parameters)

76 Check Model Guide



(C2061) Data elements with incomplete type definition

(C2061) Data elements with incomplete type definition

There are data elements whose type definition is missing or incomplete.
Error In:

Completeness
Erroneous Elements:

Events, conditions, data-items, and user-defined types

(C2063) Constant parameter arrays with incomplete
length definition

There are constant parameter arrays where either the definition of the formal parameter in the
generic chart is incomplete, or they are bound to an actual parameter of undefined length.

Error In:
Completeness
Erroneous Elements:

Data-items and conditions
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Statechart Checks

(C2065) Defined elements that can be merged with
elements from ancestor charts

Textual elements are explicitly defined in a chart that have matching, explicitly defined
elements with the same name in ancestor charts. Both elements have the same type in both
charts; therefore, they could probably be merged.

Error In:
Completeness
Erroneous Elements:

Textual elements

(C2067) The tested statechart contains termination
connector

The tested statechart contains a termination connector. This is improper in HW style, where all
activities are always active.

Error In:
Completeness
Erroneous Elements:

The tested statechart

(C2069) States with “throughout” or “within” activities

There are states with “throughout” or “within” activities. This is improper in HW style, where
all activities are always active.

Error In:
Completeness
Erroneous Elements:

States
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(C2071) The tested Statechart contains actions, events or conditions related to activities

(C2071) The tested Statechart contains actions, events
or conditions related to activities

The tested statechart contains actions, events, or conditions related to activities. This is
improper in HW style, where all activities are always active.

Error In:
Completeness
Erroneous Elements:

The tested statechart

(C2073) The tested statecharts contains combinational
assignments

The tested statechart contains combinational assignments.
Error In:

Completeness
Erroneous Elements:

The tested statechart

(C2075) Elements overriding global definitions

There are textual elements with the same name as elements that are defined in a global
definition set.

Error In:
Completeness
Erroneous Elements:

Textual elements
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Statechart Checks

(C2077) The tested statechart contains no states

The tested statechart contains no states.
Error In:

Completeness
Erroneous Elements:

The tested statechart

(C2079) Subroutines not implemented in any language

There are subroutines that have no implementation in the Rational Statemate Action
Language, Procedural Statechart/Flowchart, Ada Code, K&R C Code, or ANSI C Code.

Error In:
Completeness

Example:

CALLBACK

Erroneous Elements:

Subroutines

(C2081) Elements containing triggers that use
functions with potential side effects

There are functions used in the trigger part of labels, static- reactions, or mini-specs that have
side-effects (they affect global data).

Error In:
Completeness
Example:

activity Al Function F1 accessing global data,
used in trigger: [Y==F1(X)]
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(C2083) Subroutines containing parameters defined as a nonunique User-defined type

Erroneous Elements:

States, activities, and transitions

(C2083) Subroutines containing parameters defined as
a nonunique User-defined type

A parameter of a subroutine is defined as a user-defined type, whose name is not unique in the
model.

Error In:
Completeness
Example:

P2 parameter of procedure CALLBACK

Using nonunique user-defined type DAYS

Erroneous Elements:

Subroutines

(C2085) Enumerated Types with nonunique value
names

Enumerated types with values appear in other, unrelated enumerated type definitions (that is,
not in a subtype).

Error In:
Completeness
Example:

user-defined type COLORS has a value of BLUE
UDT MOODS also has a value of BLUE

Erroneous Elements:

User-defined types
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Statechart Checks

(C2086) Data-Elements with Enumerated Value names

Textual element has same name as enumerated values.
Error In:

Correctness
Erroneous Elements:

Textual elements

(C2087) Local variables that are not used

Local variables of a procedural statechart/flowchart are not used.
Error In:
Completeness

Example:

LOCAL1

Erroneous Elements:

Local variables

82 Check Model Guide



(C2089) Local variables used but not affected (generated or modified)

EC2089) Local variables used but not affected
generated or modified)

Local variables are used, but not generated or modified anywhere (any such usage is
uninitialized).

Error In:
Completeness
Example:

LOCAL1

Erroneous Elements:

Local variables

(C2091) Local variables affected (generated or
modified) but not used

Local variables are generated or modified, but are not used anywhere. These variables are
redundant.

Error In:
Completeness

Example:

LOCAL1

Erroneous Elements:

Local variables
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Statechart Checks

(C2093) Textual subroutines using uninitialized local
variables

Local variables of a textual procedure or function are used before they are assigned some
value.

Error In:
Completeness
Example:

LOCAL1 in F1

Erroneous Elements:

Subroutines

(C2095) Textual subroutines using redundant local
variables

Local variables of a textual procedure or function are generated or modified, but are not used.
Error In:
Completeness

Example:

LOCAL1 in F1

Erroneous Elements:

Subroutines
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(C2097) Subroutines containing wrong usage of parameters or globals

(C2097) Subroutines containing wrong usage of
parameters or globals

In/Out/InOut parameters are not generated or modified, or are not used by the subroutine.
Error In:
Completeness

Example:

subroutine CALLBACK

Input parameter Pl not used
Erroneous Elements:

Subroutines

(C2099) Subroutines with incomplete type definition

There are subroutines with incomplete type definitions.
Error In:

Completeness
Erroneous Elements:

Subroutines
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Statechart Checks

(C2101) Local variables not used in the subroutine

Local variables are not used in the subroutine code.
Error In:
Completeness
Example:
subroutine A
Local variable L3 not used
Erroneous Elements:

Subroutines

(C2103) Elements with illegal “ Selected
Implementation”

The selected implementation is not one of the existing implementations of the element.
Error In:

Completeness
Erroneous Elements:

Subroutines, actions, and activities

(C2105) Elements containing a truth table with empty
default row

Elements described by truth tables contain a default row with the output columns blank and
the action section empty.

Error In:
Completeness
Erroneous Elements:

Subroutines and actions
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(C2106) Elements containing a truth table with no inputs

(C2106) Elements containing a truth table with no
mputs
Elements contain a truth table with no input column(s).
Error In:
Completeness
Erroneous Elements:

Elements containing truth tables

(CﬁlO?) Elements containing a truth table with empty
cells

Elements described by truth tables contain cells that are blank (cells that are not part of the
default row).

Error In:
Completeness
Erroneous Elements:

Subroutines and actions

(C2111) “when others” not last in case structure

Textual elements use themselves in their own definition, via a “chain” definition.
Error In:

Completeness
Example:

case_ada (X) is
when_ada 1 =>
Y=1;
when_ada others =>
Y=3;
when_ada 2 =>
Y=2;
end case_ada;

Rational Statemate 87



Statechart Checks

Erroneous Elements:

Actions, states, and transition labels

(C2113) Switch/Case structure missing default entry

The switch_c statement is missing the default case entry, or the case_ada statement is
missing the others when_ada entry.

Error In:
Completeness

Example:

switch_c (X)
{

case_c 1:
Y=1;
case_c 2:
Y=2;

¥

Erroneous Elements:

Actions, states, and transition labels

(C2115) Prioritized Transitions with illegal (non-state)
source/target

Prioritized transitions which their source or target is not a state (e.g. connector).
Error In:

Completeness
Erroneous Elements:

Transitions
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(C2117) Arrows with illegal Transition Priority valuet

(C2117) Arrows with illegal Transition Priority valuet

Prioritized transitions which their priority value is not a positive integer value.
Error In:

Completeness
Erroneous Elements:

Transitions

(C2119) Complex Data elements not defined by User-
type

There are data elements defined directly as Record, Union or Array of non-primitive type (not
Integer or Real), and not by User-defined types.

Error In:
Completeness
Erroneous Elements:

Data-items, Conditions, Record or Union fields, Subroutine parameters and local-variables
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Statechart Checks

C2121) 'else’ Transitions exiting from connector
‘else’ is alternative to transitions exiting the
connector, not the source state)

There are “else’ labeled transitions exiting from connectors, not from states.
Error In:
Completeness

Example:

The following 2 figures seem similar, but figure 2 may run into non-determinism. The ‘else’
transition checks negation of all other arrows exiting the same source, connector in this case,
not negation of all transitions exiting the same source state. When execution is in state S1 and
E2 is generated, figure 1 will transition to S5, whereas figure 2 will create non-determinism
between S5 and S3 (the 'else’ trigger evaluates to 'not E1').

Figure 1
51 | e2  .lss
i
& else
52 53
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(C2121) 'else’ Transitions exiting from connector (‘else’ is alternative to transitions exiting the

Figuve 2 I
s1 - e2 lgg
el else
52 =3

Erroneous Elements:

‘else’ labeled transitions

Rational Statemate

91



Statechart Checks

(C2123) Transitions with priority settings not
supported in current mode (Classic)

Error In:
Completeness
Description:

Statemate is currently running in Classic mode, but the model contains transitions with priority
settings, feature which is not supported in Classic mode.

Erroneous Elements:

Transitions

(C2125) Elements containing wrong type Array indices

Error In:

Completeness
Description:

Elements containing expressions with Array Indices of the wrong type.
Erroneous Elements:

Activities, States, Transitions, Data-items, Conditions, Events, Actions and Subroutines
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(C15000) Events marked as ‘Task Event’ are not connected with EXTENDED Task

(C15000) Events marked as ‘Task Event’ are not
connected with EXTENDED Task

There are Events, which their “Its Task” Design-Attribute is not referring to a Task of type
“Extended.”

Error In:
Design
Erroneous Elements:

Events

(C15001) Event(s), ‘Its Task’ is defined as ‘default’

There are Events with their “Its Task” Design-Attribute set to “default.”
Error In:

Design
Erroneous Elements:

Events

(C15002) Either ‘'send’ or ‘receive’ are operated on non-
message elements

There are Data-Items, which are used with the operators send (sn!()) or receive (rc!()), without
being defined as Messages in their Design-Attributes.

Error In:
Design
Erroneous Elements:

Data-Items
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Statechart Checks

(C15003) Either ‘get’ or ‘release’ are operated on non-
resource elements

There are Conditions, which are used with the operators get (gt!()) or release (rlI'()), without
being defined as Resources in their Design-Attributes.

Error In:
Design
Erroneous Elements:

Conditions

(C15004) Data-items and/or conditions mapping to
external symbol, which is not unique

There is more than one Element with the same value to their “Bind Symbol Name” Design-
Attribute.

Error In:
Design
Erroneous Elements:

Data-ltems and Conditions

(C15005) Operands in expressions, defined neither as
double-buffered nor as having buffered access mode

There are Elements that are used with the operators changed (ch()), became-true (tr()) or
became-false (fs()), and are not defined as “Double Buffered” or “Buffered Access” in their
Design-Attributes.

Error In:
Design
Erroneous Elements:

Data-Items and Conditions
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(C15006) Multiple events, that are ‘Task Event’, with the same ‘Its Task’ and the same ‘Event

(C15006) Multiple events, that are ‘Task Event’, with
the same ‘Its Task’ and the same
‘Event Mask’

There is more than one Event that are defined as “Task Event” in their Design-Attributes, and
have the same value in their “Event Mask” Design-Attribute.

Error In:
Design
Erroneous Elements:

Events
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Statechart Checks

(C15007) Events that their its task is not appropriate

There are Events, which their “Its Task” Design-Attribute is set to an invalid “Task” name.

Error In:
Design
Erroneous Elements:

Events

(C15008) Derived events that their its task is not
appropriate

There are Events that their “Its-Task” Design-Attribute value is referring to a Task that is not

any ancestor Activity.
Error In:

Design
Erroneous Elements:

Data-ltems and Conditions
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(C15009) Elements unnecessarily defined as double-buffered

(C15009) Elements unnecessarily defined as double-
buffere

There are Elements that defined as “Double Buffered” in their Design-Attributes
unnecessarily.

Error In:
Design
Example:

Data-Item DI1 has its Design-Attribute “Double Buffered” set to “yes”, but it is not used with
any of the operators tr(), fs() or ch().

Erroneous Elements:

Data-Items and Conditions

(C15010) Elements defined neither as double-buffered
nor as having buffered access mode, bound to double-
buffered generic paraneter

Error In:
Design
Description:

There are Elements, not defined as double-buffered, which are binded as actual parameters to
generic parameters that are define as double-buffered. It may lead to code generation errors.

Erroneous Elements:

Data-Items, Conditions and Events
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Statechart Checks

(C15011) And State component with entering
reactions, causing delay of default transition step

Error In:

Design

Description:

This warning is relevant when using the MicroC Code Generator optimization Clutch
Entrance to State Hierarchy.

In MicroC generated code, static-reaction and default-transition inside the same state are
executed in consecutive steps, and not on the same step as in Simulation or C/ADA generated
code.

Example:

In this Statechart, component STATE_1 of the And-state ENTERING_TEST_CTRL has an
entering static-reaction. In MicroC generated code, upon entering ENTERING_TEST_CTRL,
in STATE_2 the default-transition will be taken, and in STATE_1 the entering reaction will be
executed, and only in the next step, the default-transition will be taken. This warning is
reported only for And-state components, where the synchronization between the component
states may be significant.

!

TOP_ST
EV1 | DT A
\ / STATE__L'\
e
STATE A »| STATE B
I STATE 2
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-
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(C15011) And State component with entering reactions, causing delay of default transition step

Erroneous Elements:

And State components

Rational Statemate 99



Statechart Checks

(C16000) Boxes contain ‘Combinational assignment’
— Usage of incompatible feature

A state or statechart contains a combinational assignment that is not supported by the MicroC
Code Generator.

Error In:
Compatibility between MicroC and Rational Statemate
Erroneous Elements:

Statecharts or states

(C16003) Functions implemented with incompatible
language

A subroutine is implemented using a language such as Ada, which is not supported by the
MicroC Code Generator.

Error In:
Compatibility between MicroC and Rational Statemate

Erroneous Elements:

Subroutines
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(C16007) Usage of incompatible operators/functions

(C16007) Usage of incompatible operators/functions

A statechart is using a built-in operator or function that is not supported by the MicroC Code
Generator.

Error In:
Compatibility between MicroC and Rational Statemate
Erroneous Elements:

Actions, conditions, data-items, states, subroutines, and transition labels

(C16008) Usage of incompatible operators on arecord
data-item

A statechart is using a built-in operator on a data-item of type record, which is not supported
by the MicroC Code Generator.

Error In:
Compatibility between MicroC and Rational Statemate
Erroneous Elements:

Actions, conditions, data-items, states, subroutines, and transition labels
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Statechart Checks
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Flow Chart Checks

This section documents the Check Model checks for flow charts. The checks are listed in
numerical order.

(C17001) Missing actual values for parameters.

Error In:
Completeness
Description:

There is an instance box in whose property sheet there are formal parameters, without an
actual binding.

Erroneous Elements:

Instance boxes

(C17003) Elements with incorrect or incomplete
attribute definitions

Error In:
Completeness
Description:

There are elements in whose property sheet there is an attribute name without a corresponding
attribute value, or vice-versa.

Erroneous Elements:

Elements of all types
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Flow Chart Checks

(C17004) Elements with non-unique attribute
definitions

Error In:

Completeness
Description:

Element contains more than one attribute with the same name.
Erroneous Elements:

Any element with attributes

(C17005) Elements are not referenced in Statemate
expressions and definitions

Error In:
Completeness
Description:

There are textual elements explicitly defined in the properties, but there is no reference to them
in the model.

Erroneous Elements:

Textual elements
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(C17007)Elements using redundant context variables

(C17007)Elements using redundant context variables

Error In:
Completeness
Description:

Elements contain actions with context variables that are assigned a value, but not used in the
action.

Erroneous Elements:

States, transitions, and actions

(C17009) Elements that could be defined lower in the
hierarchy of charts

Error In:
Completeness
Description:

There are textual elements explicitly defined in the tested chart that are used only in other
charts, which could be defined in the lower chart hierarchy without changing the resolution
results.

The lowest chart in which they could be defined is the lowest common ancestor of all the
charts in which references to this element exist.

Erroneous Elements:

Textual elements
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Flow Chart Checks

(C17011)Elements that reference unnamed boxes

Error In:
Completeness
Description:

Elements contain references to states that have no names. This situation can occur if a name of
a referenced state is deleted.

Erroneous Elements:

Events, conditions, actions, states, and transitions

(C17013) Elements containing references to
components of non-array elements

Error In:
Completeness
Description:

Elements contain data-item expressions with indices, but the accessed data-item is not an
array.

Erroneous Elements:

Actions, states, conditions, and transitions
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(C17015) Elements containing comparisons of unions: (not supported in Code Generation)

EC17015) Elements containing comparisons of unions:
not supported in Code Generation

Error In:
Completeness
Description:

Elements contain comparisons of two union data-items. The comparisons of two unions is
ambiguous because the result depends on which field of the unions is the current field in each
element.

Erroneous Elements:

Actions, states, conditions, and transitions

(C17017) Transitions with incomplete source definition

Error In:
Completeness
Description:

There are transitions whose source is not connected to a state or connector. The source of such
a transition appears in the statechart as a small line perpendicular to the transition.

Erroneous Elements:

Transitions
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Flow Chart Checks

(C17019) Transitions with incomplete target definition

Error In:
Completeness
Description:

There are transitions whose target is not connected to a state or connector. The target of such a
transition appears in the statechart as a small line perpendicular to the transition.

Erroneous Elements:

Transitions

(C17025) States without incoming transitions

Error In:

Completeness
Description:

There are states with no entering transition. Therefore, they are unreachable.
Erroneous Elements:

States

(C17045) Unresolved elements

Error In:

Completeness
Description:

The referenced element is not defined.
Erroneous Elements:

All types of elements
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(C17049) The tested chart is a definition with empty top-level box

(C17049? The tested chart is a definition with empty
top-level box

Error In:
Completeness
Description:

The tested chart is used as an off-page definition of an instance state and has a single, empty,
top-level state with no static reactions.

Erroneous Elements:

The tested chart

(C17051) Instance off-page connectors without a
matching definition off-page connector

Error In:

Completeness
Description:

Instance off-page connectors without a matching definition off-page connector.
Erroneous Elements:

The tested chart

(C17053) “In” parameters not used in the chart

Error In:

Completeness
Description:

Input or InOut parameters are not used in the statechart.
Erroneous Elements:

Textual elements and activities (parameters)
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Flow Chart Checks

(C17055) “Out” parameters not affected (generated or
modified) in the chart

Error In:

Completeness
Description:

Output or InOut parameters are not generated or modified in the statechart.
Erroneous Elements:

Textual elements and activities (parameters)

(C17057) Elements that are used in the chart but are
neither “in” parameter not affected (generated or
modified) internally

Error In:
Completeness
Description:

Elements that are used in the chart but are neither “in” parameter nor affected (generated or
modified) internally.

Erroneous Elements:

Events, conditions, data-items, and activities
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(C17058) Elements affected (generated or modified) by the chart but are neither “out” parameter

(C17058) Elements affected (generated or modified) by
the chart but are neither “out” parameter not used
internally

Error In:
Completeness
Description:

Elements affected (generated or modified) by the chart but are neither “out” parameter nor
used internally.

Erroneous Elements:

Events, conditions, data-items, and activities

(C17059) “In parameters affected (generated or
modified) in the chart

Error In:

Completeness
Description:

Input or InOut parameters are generated or modified in the statechart.
Erroneous Elements:

Textual elements and activities (parameters)
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Flow Chart Checks

(C17060) “Out” parameters used in the chart

Error In:

Completeness
Description:

Output or InOut parameters are used in the statechart.
Erroneous Elements:

Textual elements and activities (parameters)

(C17061) data elements with incomplete type definition

Error In:

Completeness
Description:

There are data elements whose type definition is missing or incomplete.
Erroneous Elements:

Events, conditions, data-items, and user-defined types

(C17063) Constant parameter arrays with incomplete
length definition

Error In:
Completeness
Description:

There are constant parameter arrays where either the definition of the formal parameter in the
generic chart is incomplete, or they are bound to an actual parameter of undefined length.

Erroneous Elements:

Data-items and conditions
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(C17065) Defined elements that can be merged with elements from ancestor charts

(C17065) Defined elements that can be merged with
elements from ancestor charts

Error In:
Completeness
Description:

Textual elements are explicitly defined in a chart that have matching, explicitly defined
elements with the same name in ancestor charts. Both elements have the same type in both
charts; therefore, they could probably be merged.

Erroneous Elements:

Textual elements

(C17071) The tested statechart contains actions,
events, or conditions related to activities

Error In:
Completeness
Description:

The tested statechart contains actions, events, or conditions related to activities. This is
improper in HW style, where all activities are always active.

Erroneous Elements:

The tested statechart
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Flow Chart Checks

(C17075) Elements overriding global definition

Error In:
Completeness
Description:

There are textual elements with the same name as elements that are defined in a global
definition set.

Erroneous Elements:

Textual elements

(C17077) The test flowchart contains no flow-boxes

Error In:

Completeness
Description:

The tested flowchart contains no flow-boxes.
Erroneous Elements:

The tested flow chart
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(C17079) Subroutines not implemented in any language

(C17079) Subroutines not implemented in any
language

Error In:

Completeness

Description:

There are subroutines that have no implementation in the Rational Statemate Action
Language, Procedural Statechart/Flowchart, Ada Code, K&R C Code, or ANSI C Code.

Example:

CALLBACK

Erroneous Elements:

Subroutines

(C17081) Elements containing triggers that use
functions with potential side affects

Error In:
Completeness
Description:

There are functions used in the trigger part of labels, static- reactions, or mini-specs that have
side-effects (they affect global data).

Example:

activity Al Function F1 accessing global data,
used in trigger: [Y==F1(X)]

Erroneous Elements:

States, activities, and transitions
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Flow Chart Checks

(C17083) Subroutines containing parameters defined
as a nonunique User-defined type

Error In:
Completeness
Description:

A parameter of a subroutine is defined as a user-defined type, whose name is not unique in the
model.

Example:

P2 parameter of procedure CALLBACK

Using nonunique user-defined type DAYS

Erroneous Elements:

Subroutines

(C17085) Enumerated Types with nonunique value
names

Error In:
Completeness
Description:

Enumerated types with values appear in other, unrelated enumerated type definitions (that is,
not in a subtype).

Example:
user-defined type COLORS has a value of BLUE
UDT MOODS also has a value of BLUE

Erroneous Elements:

User-defined type
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(C17086) Data-Elements with Enumerated Value names

(C17086) Data-Elements with Enumerated Value names

Error In:

Correctness
Description:

Textual element has same name as enumerated values.
Erroneous Elements:

Textual elements

(C17087) Local variables that are not used

Error In:

Completeness
Description:

Local variables of a procedural statechart/flowchart are not used.
Example:

LOCAL1

Erroneous Elements:

Local variables
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Flow Chart Checks

EC17089) Local variables used but not affected
generate or modified)

Error In:
Completeness
Description:

Local variables are used, but not generated or modified anywhere (any such usage is
uninitialized).

Example:

LOCAL1

Erroneous Elements:

Local variables

(C17091) Local variables affected (generated or
modified) but not used

Error In:
Completeness
Description:

Local variables are generated or modified, but are not used anywhere. These variables are
redundant.

Example:

LOCAL1

Erroneous Elements:

Local variables
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(C17093) Textual subroutines using uninitialized local variables

(C17093) Textual subroutines using uninitialized local
variables

Error In:
Completeness
Description:

Local variables of a textual procedure or function are used before they are assigned some
value.

Example:

LOCAL1 in F1

Erroneous Elements:

Subroutines

(C17095) Textual subroutines using redundant local
variables

Error In:
Completeness
Description:
Local variables of a textual procedure or function are generated or modified, but are not used.

Example:

LOCALL in F1

Erroneous Elements:

Subroutines
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Flow Chart Checks

(C17097) Subroutines containing wrong usage of
parameters or globals

Error In:
Completeness
Description:
In/Out/InOut parameters are not generated or modified, or are not used by the subroutine.

Example:

subroutine CALLBACK

Input parameter P1 not used
Erroneous Elements:

Subroutines

(C17099) Subroutines with incomplete type definition

Error In:

Completeness
Description:

There are subroutines with incomplete type definitions.
Erroneous Elements:

Subroutines
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(C17101) Local variables not used in the subroutine

(C17101) Local variables not used in the subroutine

Error In:
Completeness
Description:
Local variables are not used in the subroutine code.

Example:

subroutine A

Local variable L3 not used
Erroneous Elements:

Subroutines

(C17103) Elements with illegal “ Selected
Implementation”

Error In:

Completeness
Description:

The selected implementation is not one of the existing implementations of the element.
Erroneous Elements:

Subroutines, actions, and activities
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Flow Chart Checks

(C17105) Elements containing a truth table with empty
default

Error In:
Completeness
Description:

Elements described by truth tables contain a default row with the output columns blank and
the action section empty.

Erroneous Elements:

Subroutines and actions

(Cﬁ?lO?) Elements containing a truth table with empty
cells

Error In:
Completeness
Description:

Elements described by truth tables contain cells that are blank (cells that are not part of the
default row).

Erroneous Elements:

Subroutines and actions
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(C17108) Elements containing a truth table with no inputs

(C17108) Elements containing a truth table with no
inputs
Error In:
Completeness
Description:
Elements contain a truth table with no input column(s).
Erroneous Elements:

Elements containing truth tables

(C17109) “when others” not last in case structure

Error In:

Completeness
Description:

Textual elements use themselves in their own definition, via a “chain” definition.
Example:

case_ada (X) is
when_ada 1 =>
Y=1;
when_ada others =>
Y=3;
when_ada 2 =>
Y=2;
end case_ada;

Erroneous Elements:

Actions, states, and transition labels
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Flow Chart Checks

(C17111) Switch/case structure is missing default
entry

Error In:
Completeness
Description:

The switch_c statement is missing the default case entry, or the case_ada statement is
missing the others when_ada entry.

Example:

switch_c (X)
{

case c 1:
Y=1;
case Cc 2:
Y=2;
}
Erroneous Elements:

Actions, states, and transition labels

(C17113) Complex Data elements not defined by User-
type

There are data elements defined directly as Record, Union or Array of non-primitive type (not
Integer or Real), and not by User-defined types.

Error In:
Completeness
Erroneous Elements:

Data-items, Conditions, Record or Union fields, Subroutine parameters and local-variables
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(C17115) Elements containing wrong type Array indices

(C17115) Elements containing wrong type Array
indices
Error In:
Completeness
Description:
Elements containing expressions with Array Indices of the wrong type.
Erroneous Elements:

Activities, States, Transitions, Data-items, Conditions, Events, Actions and Subroutines
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(C18000) Compound boxes with no start arrow and not
default transition

Error In:
Completeness
Description:
Compound boxes with no start arrow and not default transition.

Erroneous Elements:

(C18001) Compound boxes with no end connector

Error In:
Correctness
Description:
Compound box does not contain an end connector.

Example:

Start

7 - End

Ho end connector in
this box

Erroneous Elements:

Flow chart compound box
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(C18002) Arrows crossing box boundaries

(C18002) Arrows crossing box boundaries

Error In:

Correctness
Description:

Arrow starts inside one box and ends in another box.
Erroneous Elements:

Arrows
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Flow Chart Checks

(C18003) Loops in element definition

Error In:

Correctness
Description:

Textual elements use themselves in their own definition, via a “chain” definition.
Example:

Compound event E1 is defined as “E2 or E3~; E2 is defined as “E1 or E4”.
Erroneous Elements:

All textual elements in the loop

(C18004) Aliases defined as non variable or non bit-
array

Error In:
Correctness
Description:

Aliases are illegally defined because the element appearing in the definition of the alias is
defined as a non-variable compound or constant, or it is not a bit-array.

Erroneous Elements:

Data-items
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(C18005) Arrays with an out of range index

(C18005) Arrays with an out of range index

Error In:

Correctness
Description:

Arrays or bit-arrays are used with an index value that is out of the defined index range.
Example:

A'is an integer array from 1 to 100. The model contains the following action:

A(101)=1

Erroneous Elements:

Data-items, fields, conditions, and events

(C18007) Arrays with indices in reverse order

Error In:
Correctness
Description:

There are arrays or bit-arrays for which there are references to slices whose borders are in a
reverse order relative to their type definition.

Example:
Ais a bit-array from 31 down to 0. The model contains the following action:

A(0..7)=3

Erroneous Elements:

Data-items, fields, conditions, and events
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Flow Chart Checks

(C18009) Constants in inconsistent definition

Error In:
Correctness
Description:

There are either constant data-items or conditions whose values do not match their type
definition; constant strings, arrays, or integers whose length does not match their defined
length; or a constant integer whose value is not in the defined value range.

Erroneous Elements:

Data-item or condition

(C18010) Data elements defined as arrays of bit

Error In:
Correctness
Description:
Elements are defined as array of a User-Defined Type (UDT), which is defined as bit.
Example:
D11 defined as array of B1T1, which is defined as bit.
Erroneous Elements:

Data-items, UDTs, and fields
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(C18011) Elements using uninitialized context variables

(C18011) Elements using uninitialized context
variables

Error In:

Correctness
Description:

Elements contain action expressions that use an uninitialized context variable.
Example:

There is a transition labeled with the following label:

E 7 Y=8X; $X=Z

$X is used before any value is assigned to it.

Erroneous Elements:

States, transitions, and actions

(C18013) Elements containing infinite while loops

Error In:
Correctness
Description:

This check detects cases in which the whi e loop control expression does not contain a context
variable and there is no break statement in the loop.

Erroneous Elements:

States, transitions, and actions
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Flow Chart Checks

(C18015) Elements containing for loops with
erroneous range indices

Error In:
Correctness
Description:

Elements contain action expressions in which there are for loop statements with invalid
ranges.

Example:
There is an action that contains the following for loop statements:

for $1 in 10 to 1 loop
for $1 in 1 down to 10 loop

Erroneous Elements:

States, transitions, and actions

(C18017) Numeric expressions using bit-arrays longer
than 32 bits

Error In:
Correctness
Description:

There are elements containing numeric expressions that use bit-arrays longer than 32 bits.
There is an automatic conversion from a bit-array to a numeric value only for a bit-array that is
less than or equal to 32 bits.

Erroneous Elements:

States, transitions, and actions
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(C18019) Expressions containing operation between arrays with unequal length

(C18019) Expressions containing operation between
arrays with unequal length

Error In:
Correctness
Description:

Elements contain assignments or comparisons between arrays or array slices of different
lengths.

Example:

There is an action that contains the assignment A=B, where A is defined as an array from 1 to 3,
and B is an array from 1 to 5.

Erroneous Elements:

States, transitions, and actions

(C18021) Loops in index definition

Error In:

Correctness
Description:

Data elements use constants in their definition in a “circular” manner.
Example:

AR is an array from 1 to N, while N is defined as rindex (AR).
Erroneous Elements:

Data-items, conditions, events, and user-defined types
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Flow Chart Checks

(C18023) Defined data elements that are used
incorrectly

Error In:
Correctness
Description:

Elements contain expressions in which data-items that are explicitly defined to be of some
data-type are used in a way that does not match the type consistency and conversion rules.

Example:

1 is defined as an integer; S is defined as a string. There is an action that contains the following
assignment:

1=S

Erroneous Elements:

States, transitions, events, conditions, data-items, and actions
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(C18025) Data elements without type definition that are used inconsistently

(C18025) Data elements without type definition that are
used inconsistently

Error In:
Correctness
Description:

There are unresolved or explicitly defined data-items with no type definition that are used in
expressions in an inconsistent manner.

Example:

D is an unresolved element (it is not explicitly defined); 1 is an integer; S is a string. D appears
in the following assignments:

D=1; D=S

Erroneous Elements:

Data-items, conditions, and user-defined types

(C18027) Predefined Statemate functions that are used
incorrectly

Error In:
Correctness
Description:

Predefined Rational Statemate functions are used with parameters of a wrong type, the wrong
number of parameters, or the wrong return type.

Erroneous Elements:

Functions
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Flow Chart Checks

(C18029) Subroutines that are used incorrectly

Error In:
Correctness
Description:

User functions are used inconsistently in different expressions (for example, with different
return type, different parameter type, or a different number of parameters).

Note

When working with MicroC components, this test also reports situations where a subroutine
is called with an actual “‘out’ parameter that is bound to an external symbol with get/set
APIs.

Erroneous Elements:

Functions

(C18031) Decision box(es) with same boolean value on
both exiting arrows

Error In:
Correctness
Description:
A decision box has two exiting arrows with the same value.

Example:

<---yes---/\---yes--->
v

Erroneous Elements:

Decision box
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(C18033) Default transitions with illegal sources

(C18033) Default transitions with illegal sources

Error In:
Correctness
Description:

Transitions have multiple sources and one of them is either a conditional connector or a
history connector.

Example:

In the following figure, the compound transition entering sS4 (whose source set consists of the
default connector in S1 and the state S2) is an erroneous transition.

e SN

.

51

[c2] :]
c > Y

[c1]

N 7/

Erroneous Elements:

Components of the erroneous transitions
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Flow Chart Checks

(C18043) The tested statechart has multiple top-level
states and no default entrance

Error In:
Correctness
Description:

There are several top-level states in the statechart and no default transition is drawn to any of
them.

Erroneous Elements:

The test chart

(C18045) Instance off-page connectors with same
name as in-page connector

Error In:
Correctness
Description:

Diagram connectors drawn in an instance state have the same name as another in-page
connector in the chart.

Example:

In the following figure, the instance off-page connector AB12 erroneously has the same name
as the in-page connector, the target of the transition from b.
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(C18047) Multiple instance off-page connectors with conflicting arrow directions

. /

Erroneous Elements:

Instance connectors

(C18047) Multiple instance off-page connectors with
conflicting arrow directions

Error In:
Correctness
Description:

Diagram connectors are drawn in an instance state in which another connector having the
same name but conflicting arrow directions is drawn.

Erroneous Elements:

Instance connectors
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Flow Chart Checks

(C18049) Definition off-page connectors with same
name as in-page connectors

Error In:
Correctness
Description:

Definition off-page connectors match to an instance off-page connector and have the same
name as an in-page diagram connector.

Example:

In the following figure, the definition chart B has an off-page diagram connector AB12. The
off-page connector has the same name as the in-page connector and is therefore illegal.

AEB

4
‘ c I | » AB12 |

= “ T

Erroneous Elements:

Connectors
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(C18051) Definition off-page connectors with conflicting arrow directions in instance off-page

(C18051) Definition off-page connectors with
conflicting arrow directions in instance off-page
connector

Error In:
Correctness
Description:

There are definition off-page connectors whose matching connector in the instance chart has a
conflicting arrow direction.

Example

Erroneous Elements:

Definition off-page connectors

Rational Statemate 141



Flow Chart Checks

(C18053) Generic instances with inconsistent
parameter binding

Error In:
Correctness
Description:

There is inconsistency between the actual bindings in the instance box and the defined formal
parameters in the generic chart.

Erroneous Elements:

Instance boxes

(C18057) Combinational elements aliases of registered
elements or vice versa

Error In:
Correctness
Description:

An alias data-item is used as a combinational element—it is assigned a value in a
combinational assignment, whereas the element that appears in its definition is used as a
registered element, or vice versa.

Erroneous Elements:

Data-items
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(C18061) Elements using field references that do not appear in the record/union definition

(C18061) Elements using field references that do not
appear in the record/union definition

Error In:
Correctness
Description:

Elements contain expressions in which a field of an explicitly defined record or union is used,
but the field does not appear in the record or union definition.

Erroneous Elements:

States, transitions, and textual elements

(C18062) Elements erroneously using field references

Error In:

Completeness
Description:

Elements erroneously reference fields.
Erroneous Elements:

Any element referencing fields.
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Flow Chart Checks

(CI:1I§OI63) Formal parameters whose data-type is not
globa

Error In:
Correctness

Description:

Formal parameters are defined to be of some User-Defined Type (UDT), but the UDT is
defined in the generic chart. The UDT is not visible outside the generic chart; therefore, an

actual binding cannot have this type.
Erroneous Elements:

Data-items (formal parameters)

(C18065) Actual binding whose data-type is not global

Error In:
Correctness

Description:

Data-items used as actual bindings in an instance box are defined to be of some User-Defined
Type (UDT), but the UDT is not global (it is defined in some chart, and not in a GDS). This
UDT is not visible to the generic chart; therefore, a formal parameter cannot have this type.

Erroneous Elements:

Data-items
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(C18067) Empty Records/Unions

(C18067) Empty Records/Unions

Error In:
Correctness
Description:

Data-items or data-types are defined to be a record or union, but there are no fields defined in
the structure. This is a correctness error because it is a fatal error situation for some tools.

Erroneous Elements:

Data-items or user-defined types

(C18075) Elements containing out of range
assignments of enumerated values

Error In:
Correctness
Description:

An element of some subtype is assigned a value that belongs to the enumerated type, but is not
in the range of the subtype.

Example:

in definition of SCH_ADA:ACTION WORKING_DAY=SAT

Erroneous Elements:

Textual elements, boxes, and arrows
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Flow Chart Checks

(C18077) procedures/Functions that are used
incorrectly

Error In:
Correctness
Description:

Either procedures are used as functions (treated in some expression as if they return a value),
or functions are used as procedures (called in expression where an action is expected).

Example:

Function FACTORIAL used as Procedure in definition of SCH_ADA:ACTION:
FACTORIAL(Y)

Erroneous Elements:

Subroutines

(C18079) Callback procedures that are used/defined
incorrectly

Error In:
Correctness
Description:

Procedures are used as callbacks, whose first parameter is not of type string or not of mode
Input.

Example:

CALLBACK P1, is an “Output” parameter

Erroneous Elements:

Subroutines
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(C18081) Elements containing subroutine calls with conflicting length of parameters

(C18081) Elements containing subroutine calls with
conflicting length of parameters

Error In:
Correctness
Description:

There are subroutine calls where the actual parameter’s length conflicts with the
corresponding formal parameter definition, or whose length is unknown.

Example:

STATE1
CALLBACK(A,ARRAY, 3)
ARRAY - Unknown length

Erroneous Elements:

Textual elements, boxes, and arrows

(C18085) Elements not declared as parameters or as
variables

Error In:
Correctness
Description:

There are elements used in the tested procedural statechart/flowchart that are not declared as
local variables, parameters, or global data of the connected procedure.

Example:

data-item L2
condition C

Erroneous Elements:

Data-items and conditions

Rational Statemate 147



Flow Chart Checks

(C18087) Local variables overriding parameters or
global definitions

Error In:
Correctness
Description:

A local variable of the tested procedural statechart/flowchart overrides a parameter or global
definition of the connected procedure.

Example:

P1 overriding parameter

Erroneous Elements:

Local variables

(C18089) Subroutine using recursive calls

Error In:

Correctness
Description:

Subroutines use recursive calls (either directly or by other subroutines).
Example:

SR3 called from SR2
SR2 called from SR3

Erroneous Elements:

Subroutines
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(C18091) Subroutines using elements not declared as parameters, local-variables, or globals

(C18091) Subroutines using elements not declared as
parameters, local-variables, or globals

Error In:
Correctness
Description:

Subroutines that use elements are not declared as parameters, local-variables, or globals. All
elements used in the subroutine code should be declared, including constant data-items and
conditions, enumerated values, other subroutines, and user-defined types.

Example:

subroutine F L2

Erroneous Elements:

Subroutines

(C18093) Subroutines that contain references to
activities
Error In:
Correctness
Description:
The subroutine contains references to activities.

Example:

subroutine F
Activity A used in GLOBAL1

Erroneous Elements:

Subroutines

Rational Statemate 149



Flow Chart Checks

(C18095) Subroutines with illegal parameter type or
return type

Error In:
Correctness
Description:

There is a subroutine where a User-Defined Type (UDT) is the return type, or the type of a
parameter. The following table below lists the illegal definitions for UDTSs.

Type Return Type Parameter
UDT array of string * **|llegal**
UDT array of bit-array *) **||legal**
UDT array of direct R/U *) **[|legal**
UDT queue of anything **||legal** **||legal**
Array of queue (any **||legal** **[|legal**
dimension)

(*) In these cases, a middle UDT is needed. For example, if the return type of a function
should be an array of string, it should be defined as:

UDT array of STR_UDT, and STR_UDT, a string

Format:
subroutine <subroutine name>
return type <user-def type>, defined as <type>
<user-def type>, type of parameter <parameter>,
defined as <type>
Example:

subroutine F1
return type ARR_STR1, defined as array of string
STR_QUEUE1l, type of parameter P1l, defined as queue

Erroneous Elements:

Subroutines
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(C18097) Subroutines with illegal local variable type

(C18097) Subroutines with illegal local variable type

Error In:
Correctness
Description:

Local variables are defined as a User-Defined Type (UDT), as a queue, or an array (of any
dimension) of a queue.

Erroneous Elements:

Subroutines

(C18099) Local variables with illegal type

Error In:
Correctness
Description:

Local variables are defined as a user-defined type (UDT), as a queue, or an array (of any
dimension) of a queue.

Example:

subroutine F1
STR_QUEUE1, type of local variable LV1, defined
as queue

Erroneous Elements:
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Subroutines

(C18101) Subroutines with illegal/missing return
command

Error In:
Correctness
Description:

There are functions without a RETURN command, procedures with a RETURN command, or a
function with a return type that conflicts with the returned value’s type.

Erroneous Elements:

Subroutines

(C18103) Subroutines that call other subroutines
whose global elements are missing from the calling
subroutine definition

Error In:
Correctness
Description:

Global elements of a subroutine, sus, must be declared as global elements of any other
subroutine that calls suB.

Erroneous Elements:

Subroutines
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(C18105) Subroutines with local variables/parameters overriding parameters/globals

(C18105) Subroutines with local variables/parameters
overriding parameters/globals

Error In:
Correctness
Description:

There are subroutines with local variables that override parameters or globals, or there are
parameters that override globals.

Erroneous Elements:

Subroutines

(C18107) Subroutine with illegal combination of type
and implementation

Error In:

Correctness
Description:

There are subroutines with an illegal combination of type and implementation.
Erroneous Elements:

Subroutines
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Flow Chart Checks

§C18109) Elements containing a truth table with illegal
actorization structure

Error In:
Correctness
Description:

United input cells are not nested in a previous union; or, there are two or more rows that share
the same input section, but have different output sections.

Erroneous Elements:

Subroutines and actions

(C18111) Elements containing a truth table with illegal
combination of inputs

Error In:
Correctness
Description:

Elements are described by truth tables using the same element twice as an input (via aliases).
This check ensures that the same element is not used twice as a whole, but does not check
overlapping of slices.

Erroneous Elements:

Subroutines and actions
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(C18113) Elements containing a truth table with illegal combination of outputs

(C18113) Elements containing a truth table with illegal
combination of outputs

Error In:

Correctness
Description:

Elements are described by truth tables using the same element twice as an output (via aliases).
Erroneous Elements:

Subroutines and actions

(C18115) Elements containing out of range integer/real
assignments

Error In:
Correctness
Description:

Elements contain assignments of integers, where an out-of-range value is assigned to a
restricted range integer, or one restricted range integer is assigned to another where there is no
intersection of ranges. It tests if an integer or real value is compared with a value outside its
range, as well as values assigned to integer or real variable.

Erroneous Elements:

States, actions, data-items, and transitions
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Flow Chart Checks

(C18117) Switch/Case structure contains more than
one default entry

Error In:
Correctness
Description:

The switch_c statement has more than one default case entry, or the case_ada statement has
more than one others when_ada entry.

Example:

switch_c (X)
{

case c 1:
Y=1;
default:
Y=0;

case Cc 2:
Y=2;
default:
Y=3;

}

Erroneous Elements:

Actions, states, and transition labels
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(C18119) lllegal switch structure: contains conditional break

t(JC18&19) lllegal switch structure: contains conditional
rea

Error In:

Correctness
Description:

The break action is not supported in i blocks.
Example:

switch(X) {
case RED: y=5;
if(COND1) then break
endif;
break

Erroneous Elements:

Actions, states, and transition labels
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Flow Chart Checks

(C18121) lllegal switch structure: non-unique selected
entries

Error In:
Correctness
Description:

The switch_c structure contains a case entry that is repeated. Only the first entry will be
executed.

Example:

switch_c (X)
{

case c 1:
Y=1;
case c 1:
Y=2;
default:
Y=3;

Erroneous Elements:

Actions, states, and transition labels

(C18123) Inconsistent initial value

Error In:

Correctness
Description:

An element has a default value that is inconsistent with its type and range definition.
Example:

Integer data-item X has a minimum value of 0, maximum value of 20, and a default value A.
Integer data-item A is a constant set to 40. Because A is outside the minimum and maximum for
X, it is an inconsistent initial value.

Erroneous Elements:

Integer and real data-items
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(C18125) Inconsistent range definition

(C18125) Inconsistent range definition

Error In:
Correctness

Description:

This test warns about user-defined type definitions where the sub-type ranges are inconsistent
with the parent type definition.

Example:

INT_TYPE is an integer User Defined Type and has a defined minimum/maximum range of
10 - 100 (as shown in the first figure below). SUB_INT_TYPE is a User Defined Type of
INT_TYPE and has a range defined outside of 10 - 100 (as shown in the second figure below).

INT_TYPE {(User Defined Type) -0l x|

IDE®B X+ BR 08
Hame | Defined In | Type | Def || Hode ]i!
INT_TWPE

SUB_INT_TYFE GIS1 UzerlefTyp Yez lpdate

fmg

General Definition Iﬂttr‘ibutes I]]esign Attributes IDescriptiDn

Structure: ISingle =l
Data Type: IIntegeP j Min:llO Maxz |100 Default 'u'alue:l
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UzerlefTyp Yez lpdate
UzerlefTyp Yes  Update

Erroneous Elements:

User-defined types
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(C18127) Arrays with illegal indices

(C18127) Arrays with illegal indices

Error In:
Correctness
Description:
Array index expression does not result in an integer or contain elements with illegal type.
Example:
Case I:
Arr2 is an integer array from LeftInd2 to Rightind2.
LeftInd2 is defined as:
Single, Constant, with Data Type set to None, and definition set to SubDef?2
SubDef2 is defined as:
Single None Constant with definition set to 2.34
Case I1:
Arrl is an integer array from Leftind to Rightind.
Leftind is defined as:
Single, Constant, with Data Type set to None, and definition set to SubDef
SubDef is defined as:

Single String Constant with definition set to 'My Definition'

(C19000) Events(s), ‘Its Task’ is defined as ‘default’

Error In:
Design
Description:

There are Events with their “Its Task” Design-Attribute set to “default”.
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Flow Chart Checks

Erroneous Elements:

Events
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(C19001) Events marked as ‘Task Event’ are not connected with ENTENDED Task.

(C19001) Events marked as ‘Task Event’ are not
connected with ENTENDED Task.

Error In:
Design
Description:

There are Events, which their “Its Task” Design-Attribute is not referring to a Task of type
“Extended”.

Erroneous Elements:

Events

(C19002) Either ‘send’ or receive’ are operated on non-
message elements

Error In:
Design
Description:

There are Data-ltems, which are used with the operators send (sn!()) or receive (rc!()), without
being defined as Messages in their Design-Attributes.

Erroneous Elements:

Data-Items
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(C19003) Either ‘get’ or ‘release’, are operated on non-
resource elements

Error In:
Design
Description:

There are Conditions, which are used with the operators get (gt!()) or release (rl'()), without
being defined as Resources in their Design-Attributes.

Erroneous Elements:

Conditions

(C19004) Data-items or/and conditions, mapping to
external symbol, which is not unique

Error In:
Design
Description:

There is more than one Element with the same value to their “Bind Symbol Name” Design-
Attribute.

Erroneous Elements:

Data-Items and Conditions
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(C19005) Operands in expression, defined neither as double-buffered nor as having buffered

(C19005) Operands in expression, defined neither as
double-buffered nor as having buffered access mode

Error In:
Design
Description:

There are Elements that are used with the operators changed (ch()), became-true (tr()) or
became-false (fs()), and are not defined as “Double Buffered” or “Buffered Access” in their
Design-Attributes.

Erroneous Elements:

Data-Items and Conditions

(C19006) Multiple events, that are ‘Task Event’, with
the same ‘Its Task’ and the same ‘Event Mask’

Error In:
Design
Description:

There is more than one Event that are defined as “Task Event” in their Design-Attributes, and
have the same value in their “Event Mask” Design-Attribute.

Erroneous Elements:

Events
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(C19007) Events that their its task is not appropriate

Error In:

Design
Description:

There are Events, which their “Its Task” Design-Attribute is set to an invalid “Task” name.
Erroneous Elements:

Events

(C19008) Event(s), that are not ‘Task Event”, used in
flowchart

Error In:

Design
Description:

Event element is defined in a flow chart but in not used as a “Task Event”.
Erroneous Elements:

Event Element

(C19009) Derived events that their its task is not
appropriate

Error In:
Design
Description:

There are Events that their “Its-Task” Design-Attribute value is referring to a Task that is not
any ancestor Activity.

Erroneous Elements:

Data-Items and Conditions
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(C19010) Elements unnecessarily defined as double-buffered

(C19010) Elements unnecessarily defined as double-
buffere

Error In:
Design
Description:

There are Elements that defined as “Double Buffered” in their Design-Attributes
unnecessarily.

Example:

Data-Item DI1 has its Design-Attribute “Double Buffered” set to “yes”, but it is not used with
any of the operators tr(), fs() or ch().

Erroneous Elements:

Data-ltems and Conditions

(C19011) Elements defined neither as double-buffered
nor as having buffered access mode, bound to double-
buffered generic paraneter

Error In:
Design
Description:

There are Elements, not defined as double-buffered, which are binded as actual parameters to
generic parameters that are define as double-buffered. It may lead to code generation errors.

Erroneous Elements:

Data-ltems, Conditions and Events
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Flow Chart Checks

(C20003) Usage of incompatible operators/functions

Error In:
Compatibility between MicroC and Rational Statemate
Description:

A statechart is using a built-in operator or function that is not supported by the MicroC Code
Generator.

Erroneous Elements:

Actions, conditions, data-items, states, subroutines, and transition labels
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(C20004) Usage of incompatible operators on a record data-item

(C20004) Usage of incompatible operators on arecord
data-item

Error In:
Compatibility between MicroC and Rational Statemate
Description:

A statechart is using a built-in operator on a data-item of type record, which is not supported
by the MicroC Code Generator.

Erroneous Elements:

Actions, conditions, data-items, states, subroutines, and transition labels
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Activity Chart Checks

This section documents the Check Model checks for activity charts. The checks are listed in
numerical order.

(C3001) Loops in element definition

Error In:

Correctness
Description:

Textual elements use themselves in their definition via “chain” definitions.
Example:

Compound event E1 is defined as ‘E2 or E3’; E2 is defined as “E1 or E4.’
Erroneous Elements:

All textual elements in the loop
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Activity Chart Checks

(C3003) Aliases defined as non variable or non bit-
array

Error In:
Correctness
Description:

Aliases, illegally defined because of the element appearing in the definition of the alias, are
defined as non-variable (compound or constant) or non-bit-array.

Example:

X2 is a single bit-array from 1 to 14, defined in chart TOP. X2_INIT is a single integer, with
usage of Alias, defined in chart TOP to be x2(2). The error occurs on data-item X2_INIT.

Erroneous Elements:

Data-items

(C3005) Arrays with an out of range index

Error In:

Correctness
Description:

Arrays or bit-arrays are used with an index value out of the defined index range.
Example:

A is an integer array from 1 to 100. There is an action in the model:
A(101)=1

Erroneous Elements:

Data-items, fields, conditions, and events
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(C3007) Arrays with indices in reverse order

(C3007) Arrays with indices in reverse order

Error In:
Correctness
Description:

Arrays or bit-arrays reference slices whose borders are in reverse order relative to their type
definition.

Example:
A'is a bit-array from 31 down to 0. There is an action in the model:

A(0..7)=3

Erroneous Elements:

Data-items, fields, conditions, and events
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Activity Chart Checks

(C3009) Constants with inconsistent definition

Error In:
Correctness
Description:

One of the following situations:

¢ There are constant data-items or conditions whose values do not match their type
definition.

¢ There are constant strings, arrays, or integers whose length does not match their defined
length.

*

There are constant integers whose values are not in the defined value range.

Erroneous Elements:

Data-items and conditions

(C3010) Data elements defined as arrays of bit

Error In:
Correctness

Description:

There are elements defined as arrays of a user-defined type (UDT) that is defined as bit.

Example:

D11 defined as array of BIT1, which is defined as bit

Erroneous Elements:

Data-items, user-defined types, and fields
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(C3011) Elements using uninitialized context variables

(C3011) Elements using uninitialized context variables

Error In:

Correctness
Description:

Elements contain action expressions in which an uninitialized context variable is used.
Example:

A transition has the following label:

E/Y=$X; $X=Z

$x is used before any value is assigned to it.
Erroneous Elements:

Activities and actions
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Activity Chart Checks

(C3013) Elements containing infinite While Loops

Error In:
Correctness
Description:

Elements contain action expressions that have infinite while loop statements. The check
detects cases where the whi le loop control expression does not contain a context variable or a
break statement in the loop.

Example:
A mini-spec contains the following expression:

EV /7 while COND1 loop
A=B;

end loop

The expression contains no context variable or break statement.
Erroneous Elements:

Activities and actions
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(C3015) Elements containing For Loops with erroneous range indices

(C3015) Elements containing For Loops with
erroneous range indices

Error In:

Correctness
Description:

Elements contain action expressions that have for loops statements with an invalid range.
Example:

An action contains the following for loop statement:

for $1 in 10 to 1 loop

The correct statement would use downto.
Erroneous Elements:

Activities and actions

(C3017) Numeric expressions using bit-arrays longer
than 32 bits

Error In:
Correctness
Description:

Elements contain numeric expressions that have bit-arrays longer than 32 bits. Conversion
occurs automatically from a bit-array to a numeric value only for a bit-array with less than or
equal to 32 bits.

Erroneous Elements:

Activities and actions
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(C3019) Expressions containing operations between
arrays with unequal length

Error In:
Correctness
Description:

Elements contain assignments or comparisons between arrays or array slices of different
lengths.

Example:
An action contains the following assignment:

A=B
when A is defined as an array from 1 to 3,
and B is an array from 1 to 5.

Erroneous Elements:

Activities, events, conditions, and actions

(C3021) Loops in index definition

Error In:
Correctness
Description:
Data elements use constants in their definition in a “circular” manner.
Example:
AR 1s an array from 1 to N
whille N is defined as rindex (AR)
Erroneous Elements:

Data-items, conditions, events, and user-defined types
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(C3023) Defined data elements that are used incorrectly

(C3023) Defined data elements that are used
incorrectly

Error In:
Correctness
Description:

Elements contain expressions in which data-items that are explicitly defined to be of some
data-type are used in a way that does not match the type consistency and conversion rules.

Note

This is reported even if the definition chart of the regarded element is not included in the
profile, but charts using that element are in the profile.

Example:

1 is defined as an integer; s is defined as a string. There is an action that contains the following
assignment:

Erroneous Elements:

Activities, events, conditions, data-items, and actions
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(C3025) Data elements without type definition that are
used inconsistently

Error In:
Correctness
Description:

Unresolved or explicitly defined data-items with no type definition or specified type are used
in expressions in an inconsistent manner.

Example:

D is an unresolved or not explicitly defined element. 1 is an integer; s is a string. D appears in
the following assignments:

D=1; D=S

Erroneous Elements:

Data-items, conditions, and user-defined types
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(C3027) Predefined functions that are used incorrectly

(C3027) Predefined functions that are used incorrectly

Error In:
Correctness
Description:

Predefined functions are used with parameters of a wrong type, the wrong number of
parameters, or an incorrect return type.

Example:

A mini-spec contains the following expression, where THETA is defined as a real and C is
defined as a condition:

EV /C = sin(THETA)

C should be a real.

Erroneous Elements:

Functions
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Activity Chart Checks

(C3029) Subroutines that are used incorrectly

Error In:
Correctness
Description:

User functions are used inconsistently in different expressions as in a different return type,
parameter type, or number of parameters.

Note

When working with MicroC components, this test also reports situations where a subroutine
is called with an actual “‘out’ parameter that is bound to an external symbol with get/set
APIs.

Example:

A subroutine suB_1 is defined as a function with two input parameters that returns an integer.
An activity ACT_1 contains the following mini-spec, where Y is defined as an integer:

EV_1/Y=SUB_1(A1,B1)

A second activity on the same chart contains the following mini-spec, where z is defined as a
condition:

EV_2/7=SUB_1(A2,B2)

The error is generated on the SUB_1 function because the return type is used as an integer in the
first activity and as a condition in the second activity.

A third activity on the same chart contains the following mini-spec:

EV_3/W=SUB_1(A3,B3,C3)
The error is also generated in this case due to an inconsistent number of parameters.

Erroneous Elements:

Functions
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(C3031) Loops in compound flow-lines

(C3031) Loops in compound flow-lines

Error In:
Correctness
Description:

A group of flow-line segments, linked through connectors, create a loop or cycle that does not
contain an activity or data-store.

Example:

In the following figure, the data-flow with label z is shown as having the same source and
target (diagram connector AB), thus creating a loop.
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Erroneous Elements:

Flow-line segments in loops.
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Activity Chart Checks

(C3033) Compound flow-lines with identical sources
and targets

Error In:
Correctness

Description:

Compound flow-lines with identical sources and targets (loopback flow-lines).

Example:

The following figure shows the simplest case:

Erroneous Elements:

Compound flow-lines

A

L
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(C3035) Flow-line segments with illegal joints

(C3035) Flow-line segments with illegal joints

Error In:
Correctness
Description:
Compound flow-lines are constructed by using joint connectors in a confusing order.

Example:

Erroneous Elements:

Components of the erroneous flow-lines
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Activity Chart Checks

(C3037) Flow-lines between data-stores

Error In:
Correctness
Description:

Compound flow-lines denote a flow of information between data-stores, which are passive
elements.

Example:

In the following figure, data-item A is shown flowing from STORE_1 to STORE_2 via a junction
connector.
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.?;
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(C3039) Flow-lines between external activities

(C3039) Flow-lines between external activities

Error In:
Correctness
Description:

There are compound flow-lines between external activities. These flow-lines, even if they
exist, should not be specified in the chart where the source and target activities are external,
and therefore out of the description scope.

Example:

In the following figure, data-item A is shown flowing between external activities INPUT_1 and

INPUT_2.
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Erroneous Elements:

¢ Components of the erroneous flow-lines
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Activity Chart Checks

(C3041) Conflicting labels on flow-line components

Error In:

Correctness
Description:

There are compound flow-lines whose segments are labeled with conflicting labels.
Example:

In the following figure, if X and Y include different data elements (such as events, conditions,
or data-it ems), the flow-line from A1 and A2 to A3 is incorrect.

As shown in the following figure, the compound flow-line from A2 to A3 is incorrect because
its labels are x and Y. However, the compound flow-line from A1 to A3 is correct.

Erroneous Elements:

Components of the erroneous flow-lines
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(C3043) Composition connectors with multiple entrances and multiple exits

(C3043) Composition connectors with multiple
entrances and multiple exits

Error In:
Correctness
Description:

There are composition connectors with multiple entering flow-lines and multiple exiting flow-
lines.

Erroneous Elements:

Connectors

(C3045) Instance off-page connectors with same name
as in-page connector

Error In:
Correctness
Description:

There are off-page diagram connectors drawn in an instance activity that have the same name
as another in-page connector in the chart.

Example:

As shown on the following figure, the off-page diagram connector drawn in @ACT_1 has the
same name as the in-page connector CON1.
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Activity Chart Checks
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Erroneous Elements:

Instance connectors
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(C3047) Multiple instance off-page connectors with conflicting arrow directions

(C3047) Multiple instance off-page connectors with
conflicting arrow directions
Error In:
Correctness
Description:

There are off-page diagram connectors drawn in an instance activity in which another
connector with the same name, but conflicting arrow directions, is drawn.

Example:

The following figure shows an off-page diagram connector drawn in @ACT_1 with an incoming
arrow, which conflicts with a second off-page diagram connector with an outgoing arrow.
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Erroneous Elements:

Instance connectors
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Activity Chart Checks

(C3049) Definition off-page connectors with same
name as in-page connector

Error In:
Correctness
Description:

There is a definition off-page connector that matches an instance off-page connector and has
the same name as an in-page diagram connector.

This check is performed only when you specify with definition charts. The error is reported in
the definition chart.

Erroneous Elements:

Connectors

(C3051) Definition off-page connectors with conflicting
arrow directions in instance
off-page connector

Error In:
Correctness
Description:

There are definition off-page connectors whose matching connector in the instance chart has a
conflicting arrow direction.

This check is performed only when you specify with definition charts. The error is reported in
the definition chart.

Erroneous Elements:

Definition off-page connectors
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(C3053) Elements that flow to/from instance with contradicting source/target name in definition

(C3053) Elements that flow to/from instance with
contradicting source/target name in
definition chart

Error In:
Correctness
Description:

There are elements that flow to or from both an instance activity and an external activity in the
off-page definition chart, but the source or target name in the off-page definition chart is not
the same as the name or synonym in the instance chart.

This check is performed only when you specify with definition charts. The error is reported in
the instance chart.

Example:

In the following figure, this error is generated when testing chart A2, where IN_FLOW flows
from external activity INPUT_1 to instance activity ACT_1. However, in the off-page definition
chart, IN_FLow is shown flowing from external activity INPUT_2.
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Activity Chart Checks
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Erroneous Elements:

Events, conditions, data-items, information-flows, and fields
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(C3055) Elements that flow to/from definition with contradicting source/target name in instance

(C3055) Elements that flow to/from definition with
contradicting source/target name in instance chart

Error In:
Correctness

Description:

There are elements that flow to or from both an external activity in the off-page definition
chart and the instance activity, but the source or target and the name or synonym in the
instance are not the same as the name in the off-page definition chart. This check is performed
only when you specify with definition charts. The error is reported in the definition chart.

Example:
In the following figure, this error is generated when testing chart AXT1, where IN_FLOW flows

from external activity INPUT_2 to activity ACT_1. However, in the off-page definition chart,
IN_FLOW is shown flowing from external activity INPUT_1.
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Erroneous Elements:

Events, conditions, data-items, and information-flows
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Activity Chart Checks

(C3059) Generic instances with inconsistent parameter
binding
Error In:
Correctness
Description:

There is inconsistency between the actual bindings in the instance box and the defined, formal
parameters in the generic chart.

Example:

A generic activity chart has a formal parameter X, which is defined as an integer. An activity

chart contains an instance of this generic chart and has an actual parameter x1, which is bound
to X. The actual parameter X1 is defined as a condition and is, therefore, inconsistent with the
formal parameter definition.

Erroneous Elements:

Instance boxes
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(C3061) Controlled-termination activities that contain stop action

(C3061) Controlled-termination activities that contain
stop action

Error In:
Correctness
Description:

There are activities of reactive-controlled termination type, with STOP (sp!) action in their
mini-spec.

Erroneous Elements:

Activities

(C3063) Self-termination activities that do not contain
stop action

Error In:
Correctness
Description:

There are activities of reactive-self termination type, but there is no STOP (sp!) action in their
mini-spec.

Erroneous Elements:

Activities
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Activity Chart Checks

(C3065) Combinational elements aliases of registered
elements or vice versa

Error In:
Correctness

Description:

An alias data-item is used as a combinational element and assigned a value in a combinational

assignment, but the element that appears in its definition is used as a registered element, or
vice versa.

Example:

In the following figure:

¢ Xxxis defined as a bit-array from 1 to 10.
¢ XX_INIT is defined as a single bit alias of xx defined as xx(2).
¢ Activity ACT_1_1 contains the following combinational assignment:
XX_INIT=1
* Activity ACT_1_2 contains the following mini-spec:
EV/XX(1)=1
The error is reported on XX_INIT.
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(C3067) Combinational elements assigned a value multiple times in the same entity
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Erroneous Elements:

Data-items

(C3067) Combinational elements assigned a value
multiple times in the same entity

Error In:
Correctness
Description:

A combinational assignment is assigned a value in two separate, combinational assignments in
the tested activity.

Erroneous Elements:

Data-items
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Activity Chart Checks

(C3069) Elements using field references that do not
appear in the record / union definition

Error In:
Correctness
Description:

There are elements that contain expressions in which a field of an explicitly defined record or
union is used, but the field does not appear in the definition of the record or union.

Example:

A record data-item ReC_21 flows from activity ACT_1. REC_1 is defined to have two fields, F1
and F2, both of which are integers. The activity ACT_1 contains the following mini-spec:

EV/REC.F3 = 4

The error occurs because F3 does not appear in the definition of REC_1.
Erroneous Elements:

Activities and textual elements
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(C3070) Elements erroneously using field references

(C3070) Elements erroneously using field references

Error In:

Completeness
Description:

Elements erroneously reference fields.
Erroneous Elements:

Any element referencing fields.

(C|:3lg)7|1) Formal parameters whose data-type is not
globa

Error In:
Correctness
Description:

Formal parameters are defined in terms of a User-Defined Type (UDT), but the UDT is
defined in the generic chart. Because the UDT is not visible outside the generic chart, any
actual binding cannot have this type. The error is generated in the tested generic chart.

Note
UDTs are normally defined in a Global Definition Set (GDS).

Erroneous Elements:

Data-items with formal parameters
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Activity Chart Checks

(C3073) Actual binding whose data-type is not global

Error In:
Correctness
Description:

Data-items, used as actual bindings in an instance box, are defined to be of some User-Defined
Type (UDT), but the UDT is not global. It is defined in some chart, not in a GDS. Because this
UDT is not visible to the generic chart, a formal parameter cannot have this type.

Note
UDTs are normally defined in a GDS.

Erroneous Elements:

Data-items

(C3075) Empty Records/Unions

Error In:
Correctness
Description:

There are data-items or data-types defined to be a record or union, but there are no fields
defined in the structure. (This is a correctness error because it is a fatal error situation for some
tools.)

Erroneous Elements:

Data-items and user-defined types
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(C3077) Non-generic instance blocks with explicit ports

(C3077) Non-generic instance blocks with explicit
ports

Error In:
Correctness
Description:
There are blocks that are not instances of generic charts and have explicit ports.
Erroneous Elements:

Blocks

(C3079) Blocks containing multiple ports with same
name

Error In:

Correctness
Description:

Instance blocks of generic charts have more than one port with the same name.
Erroneous Elements:

Blocks

(C3081) Bus/Signal flowing between two “in ports”

Error In:

Correctness
Description:

There is a bus or signal flowing between two “in” ports.
Erroneous Elements:

The components of the erroneous buses or signals
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Activity Chart Checks

(C3083) Bus/Signal flowing between two “out ports”

Error In:

Correctness
Description:

There is a bus or signal flowing between two “out” ports.
Erroneous Elements:

The components of the erroneous buses or signals

(C3085) Sub-types that conflict with enumerated type
definition
Error In:
Correctness
Description:
One of the following situations:

¢ Values that do not appear in the definition of an enumerated type are used.

+ Values in the subtype definition are not in the same order as in the definition of
the enumerated type.

¢ Values are missing from the subtype definition.

Format:
<subtype name> (sub range of <enumerated-type name>):
<enum-value> - missing In <enumerated-type name>
<enum-value> - missing in <subtype name>
<enum-value> - incorrect ordinal in <subtype name>
Example:

WORKING_DAYS (sub range of DAYS)

MONDAY - missing in DAYS

TUE - missing in WORKING_DAYS

WED - incorrect ordinal in WORKING_DAYS

Erroneous Elements:

User-defined types
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(C3087) Tasks/procedures that are used incorrectly

(C3087) Tasks/procedures that are used incorrectly

Error In:
Correctness
Description:

Tasks can be bound only to activities. Any other usage, including expressions, is incorrect.
Procedures and functions cannot be bound to activities.

Format:
<subroutine name> (defined as <task/procedure/ function>) used as <procedure/
function/task> in definition of <element name>
Example:
A procedure PROC_1 is bound (using subroutine binding) to a reactive activity ACT_1.
Erroneous Elements:

Subroutines
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(C3089) Elements containing out-of-range
assignments of enumerated values

Error In:
Correctness
Description:

An element of some subtype is assigned a value that belongs to the enumerated type, but is not
in the range of the subtype.

Format:
in <definition/mini-spec...> of <element name>
<the assignment expression>

Example:

An enumerated type DAYS is defined as {MON, TUE ,WED, THU, FRI,SAT, SUN}. WEEKEND is
defined as a subtype of DAYS {SAT,SUN}. A mini-spec contains the following expression:

EV/WEEKEND=MON;

Erroneous Elements:

Textual elements, boxes, and arrows
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(C3091) Procedures/Functions that are used incorrectly

(C3091) Procedures/Functions that are used
incorrectly

Error In:
Correctness
Description:

Procedures are used as functions or treated in some expression as if they return a value.
Functions are used as procedures, or called in expressions where an action is expected.

Format:

<Function/Procedure> <subroutine name>
used as <Procedure/Function> in definition of
<element name> <expression of subroutine call>

Example:
Function FACTORIAL (returning an integer) is used as a procedure in the following mini-spec:

EV/FACTORIAL(X,Y)

Erroneous Elements:

Subroutines
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(C3093) External activities in generic chart with “User-
Added Code Bindings”

Error In:
Correctness
Description:

External activities defined in generic charts (or descendants of generic charts) have a
subroutine binding to a task, function, or procedure. The error is reported in the tested generic
chart.

Format:

<Function/Procedure> <subroutine name>

Erroneous Elements:

Activities
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(C3095) Callback procedures that are used/defined incorrectly

(C3095) Callback procedures that are used/defined
incorrectly

Error In:
Correctness
Description:

Procedures are used as callbacks, whose first parameter is either not of type string or of mode
Input.

Format:

<subroutine name> <parameter name>,
is an <“Output”/”InOut”> parameter

Example:
An activity ACT_1 has a callback binding to a subroutine defined as a procedure:

C_BACK(X1,Y1)

The subroutine is defined with the following parameters:

¢ X - Astring output parameter
¢ Y- An integer output parameter

The error is generated because the first parameter, x1, should be an input string.
Erroneous Elements:

Subroutines
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(C3097) Elements containing subroutine calls with

conflicting length of parameters

Error In:
Correctness

Description:

There are subroutine calls where the actual parameter’s length conflicts with the
corresponding formal parameter definition, or whose length is unknown.

Format:

<element name> i
<expression of subroutine call>
<actual parameters> - Unknown length

Example:
Activity ACT_21 contains the following mini-spec:

EV/SUB_LEN(X1,Y1)

In this mini-spec:

¢ X1 isan unbounded array of integers.
¢ Y1lisastring.

¢ SUB_LEN is a subroutine with the following parameters:

— X - An array of integers, from 1 to 5
— Y- Astring
The error is generated because x1 is of unknown length.

Erroneous Elements:

Textual elements, boxes, and arrows
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(C3099) Subroutines using recursive calls

(C3099) Subroutines using recursive calls

Error In:
Correctness
Description:
Subroutines use recursive calls, either directly or by other subroutines.

Format:

<subroutine namel> called from <subroutine name2>
<subroutine name2> called from <subroutine namel>

Example:

SR3 called from SR2
SR2 called from SR3

Erroneous Elements:

Subroutines
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Activity Chart Checks

(C3101) Subroutines that are used incorrectly

Error In:
Correctness
Description:

Subroutines use elements that are not declared as parameters, local variables, or globals. All
elements used in the subroutine code should be declared, including constant data-items or
conditions, enumerated values, other subroutines, and user-defined types.

Format:

subroutine <subroutine name>
<used element name>

Erroneous Elements:

Subroutines
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(C3105) Subroutines that contain references to activities

(C3105) Subroutines that contain references to
activities
Error In:
Correctness
Description:

Subroutines contain references to activities. This can happen only by using a global variable
that contains a reference to an activity.

Format:

subroutine <subroutine name> Activity <activity name>
used in <global variable name>

Example:

subroutine F
Activity A used in GLOBAL1

Erroneous Elements:

Subroutines
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Activity Chart Checks

(C3107) Subroutines with illegal parameter type or
return type

Error In:
Correctness
Description:

A subroutine uses an illegal parameter type or return type. The following table lists the illegal
definitions for UDTSs.

Type Return Type Parameter
UDT array of string * ** |llegal **
UDT array of bit-array *) ** [llegal **
UDT array of direct record or union *) ** [llegal **
UDT queue of anything ** |llegal ** ** [llegal **
Array of queue (any dimension) ** |llegal ** ** |llegal **

(*) In these cases, an interim UDT is needed. For example, if the return type of a function
should be an array of string, it should be defined as UDT array of STR_UDT, and STR_UDT, a
string.

Format:

subroutine <subroutine name>
return type <user-def type>, defined as <type> <user-def type>, type of
parameter <parameter>, defined as <type>

Example:

A subroutine, defined as a function, has a return type T_ARR_STR. T_ARR_STR is defined as an
array of strings from 1 to 5. The error is generated because T_ARR_STR is defined directly. To
correct this error, an intermediate UDT is required:

T_ARR_STR is defined as an array from 12 to 5 of UDT T_STR
T_STR is defined as a string

Erroneous Elements:

Subroutines
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(C3109) Subroutines with illegal local variables type

(C3109) Subroutines with illegal local variables type

Error In:
Correctness
Description:

Local variables are defined as a user-defined type (UDT) that is a queue or an array (of any
dimension) of a queue.

Format:

subroutine <subroutine name>
<user-def type>, type of local variable
<local variable>, defined as <type>

Example:

A subroutine F1, defined as a procedure, has a local variable Lv1 defined in terms of a UDT
T_Lvi1.T_Lv1 is defined as a queue of integers, which is an illegal type for local variables.

Erroneous Elements:

Subroutines
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Activity Chart Checks

(C3111) Subroutines with illegal/missing RETURN
command

Error In:
Correctness
Description:

There are functions without a RETURN command, procedures with a RETURN command, or a
function with a return type that conflicts with the returned value’s type.

Erroneous Elements:

Subroutines

(C3113) Subroutines that call other subroutines whose
global elements are missing from the calling
subroutine definition

Error In:
Correctness
Description:

Global elements of a subroutine, sus, must be declared as global elements of any other
subroutine calling sus.

Erroneous Elements:

Subroutines
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(C3115) Subroutines with local variables/parameters overriding parameters/globals

(C3115) Subroutines with local variables/parameters
overriding parameters/globals

Error In:
Correctness
Description:

There are subroutines with local variables that override parameters or globals, or parameters
overriding globals.

Erroneous Elements:

Subroutines

(C3117) Subroutines with illegal combination of type
and implementation

Error In:

Correctness
Description:

There are subroutines with an illegal combination of type and implementation.
Example:

A subroutine is defined as a task, having an implementation of procedural statechart.
Procedural statecharts can be only the implementation of either a function or a procedure.

Erroneous Elements:

Subroutines
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Activity Chart Checks

§C3119) Elements containing a truth table with illegal
actorization structure

Error In:
Correctness
Description:

Either joined input cells are not nested in a previous join or there are two or more rows that
share the same input section, but have different output sections.

Example:

The following figure show the truth table definition for activity ACT_1. An error is generated
because the joined cells in column 2 are not a subset of any previous join. The tool will warn
of this situation when you save the truth table.
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(C3119) Elements containing a truth table with illegal factorization structure

Truth Table of ACT_1_3

Truth Table of ACT_1_3

(I0267) Truth Table of ACT_1_3 successfully saved

Erroneous Elements:

Subroutines, actions, and activities
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Activity Chart Checks

(C3121) Elements containing a truth table with illegal
combination of outputs

Error In:
Correctness

Description:
Elements described by truth tables use the same element twice as an output, via aliases.

Note
This check ensures that the same element is not used twice as a whole. The check does not

compare overlapping of slices.

Example:
The following figure shows the truth table definition for activity ACT_1. co_2 is defined to be
an integer. AL_Co_2 is defined to be an alias of co_2. An error is generated because co_2 is the

same as AL_CO_2.

Truth Table of ACT_1_3 - 0| x|
File Edit Worksheet Help
Input output
coz2 AL CO 2 CON_1 DATA 1
3 1 false 70
4 2 true 80
2 || 2 | 3 || 4 |
[ =
Hessages
j
’ 4

Erroneous Elements:

Subroutines, actions, and activities
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(C3123) Elements containing a truth table with illegal combination of inputs

(C3123) Elements containing a truth table with illegal
combination of inputs

Error In:
Correctness
Description:

Elements described by truth tables use the same element twice as an input, via aliases.

Example:
The following figure shows the truth table definition for activity ACT_1. DATA_1 is defined to
be an integer. AL_DATA_1 is defined to be an alias of DATA_1. An error is generated because

DATA 1 is the same as AL_DATA 1.

Truth Table of ACT_1_3 — | O |i|
File Edit Worksheet Help
Input output
co 1 co 2 CON 1 DATA 1 AL DATA 1
7 | tue 1 false 70 50
[2 | 2 true §0 100
| ? || 2 || 3 || 4 l s |
=
Hessages
|
f .

Erroneous Elements:

Subroutines, actions, and activities
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Activity Chart Checks

(C3125) Elements containing out of range integer/real
assignments

Error In:
Correctness
Description:

Elements contain assignments of integers, where an out-of-range value is assigned to a
restricted range integer, or one restricted range integer is assigned to another where there is no
intersection of ranges. It tests if an integer or real value is compared with a value outside its
range, as well as values assigned to integer or real variable.

Erroneous Elements:

States, actions, data-items, and transitions

(C3127) Activities that contain more than one control
activity
Error In:
Correctness
Description:
Activities contain more than one control activity, via transparent activities.
Example:

As shown in the following figure, the top-level activity Top contains a control activity cTL and
subactivity A3. A3 is defined within its property as being transparent. The definition chart A3
also contains a control activity CTL_2. The error is generated because activity Top effectively
contains two control activities (because A3 is transparent).
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(C3127) Activities that contain more than one control activity

AEEJ:TRANSJEEI [Update] _|o il
File Edi View Luyowi ZTools Options Help
Refresh| Create Sub-Chart | Check Hodel |

[DEEE AR -« bR X | BaaaldE
*

b
<
i, 708
0
Foilioag
@
B H
ANSTL CGEN AEEJS:AE [update]
....... H H File Edit View Layout Tools Opiions
: o pra—
H ¢ :
e o ¥ H I

([DEEE dR -« X BRaa i
w

________

N

Ne&e 0O

Do eens.

Hessages

Erroneous Elements:

Activities
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Activity Chart Checks

(C3129) Activities that contain sub-activities with the
same name

Error In:

Correctness
Description:

Activities contain subactivities with the same name, via transparent activities.
Example:

As shown in the following figure, the top-level activity TOP contains subactivities A2 and A3.
A3 is defined within its property as being transparent. The definition chart A3 also contains a
subactivity A2. The error is generated because activity Top effectively contains two
subactivities with the same name (because A3 is transparent).

PUf Ace_aTraxs_TEST [Uneate] =|0lx
File Edir View Layour Tool Options lielp
| DEWa 4B ~o | s B X Haaa fH
A
& W
NN
o, 00
1 ';;;’":
o @ :
o :
an o
LTl eEn
reeeeenn g : M"wli o
—— | - ¥ ! i Flle Edir View Layout Tools Options
: H - : ] =]
= . DFEEG AR v | ShRAX HEaS|
=1
e
N
(=5 ¥
=}
o @ i
@0
e [
=1e]

Huilding data structure , Please wait .,
G ahead. ..

Erroneous Elements:

Activities
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(C3131) lllegal usage of components

(C3131) lllegal usage of components

Error In:

Correctness
Description:

Illegal usage of components.
Erroneous Elements:

Components

(C3133) Instance components with illegal port
bindings
Error In:
Correctness
Description:
A component instance activity has a port connected to an element of incorrect type.
Example:

A port of type integer data-item has been connected to a data-flow flowing to a string data-
item.

Erroneous Elements:

Component instance activities
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Activity Chart Checks

(C3135) Continuous instances with inconsistent
parameter binding

Error In:

¢ Correctness

Description:

There are continuous instances where the actual parameters are not consistent with the formal
parameters of the definition continuous diagram. Parameter bindings might be missing, or
parameter types might be inconsistent.

Example:

In the figure, A22<A22 is a continuous instance with actual parameters INT_1, INT_2, and
INT_3, all integers. As shown in the properties for this instance, the actual parameter INT_3 is
not bound to formal parameter 13, and an error is generated. Similarly, binding 11 (a real) to
INT_1 (an integer) also generates this warning.

=1
Help

| DFES @R 2o thRX Baae | i
™

[ ostovctimavisor -lojx|
< { File Edit View lryemeniulion Tools Options Help
om et it Hamn Dafined In Tups m?ﬂ?

ﬂ IxreTT [ T Netlvit Ye
s @
e
[+ -3
o] | = =
Long Desc... | Httribaten... ] Upon References [
gy [ ] swesmea | S erevioss |
! overs 4,“"—’! e - :m H TInstance of Contimous Diagros
Chart: TRANS_TEST
------------------ Mane: R Syroming |
Description: |
Paranster Ture. Binding Tnsnrt ]
i Data=Iten INT_1
Fesnages Vi Data-Tten |l B Blnding
| | | Fill Forkals
| ! E‘ Chansn, . .
Inplenented by Module: |
&4
| 10219} A2 suecessfully saved ‘l

Erroneous Elements:

Continuous instances
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(C3137) lllegal switch structure contains conditional break

t(JCSllC(%?) lllegal switch structure contains conditional
rea

Error In:

Correctness
Description:

Switch/Case structures within an activity’s mini-spec have a conditional break action.
Example:

Activity ACT_1 contains the following mini-spec:

ch(SWITCH_VAL)/switch_c (SWITCH_VAL) {

case_c 1: OUT1=RED;break;

case_c 2: OUT1=AMBER;break;if COND1 then break;end if;
case_c 3: OUT1=GREEN;break;

default : OUT=AMBER;}

The error is generated because there is a conditional break action statement for case_c=2.
Erroneous Elements:

Switch/Case structures
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Activity Chart Checks

(C3138) Switch/Case structure contain more than one
default entry

Error In:

Correctness
Description:

Switch/Case expression with more than one “default” entry.
Example:

The following Rational Statemate Language expression is illegal:

/switch_c (D1) {
case_c 1:
DI++;
break;
default :
DI--;
break;
default :
DI--;
break;

}

Erroneous Elements:

Activities, States, Action-Box, Transition, Action
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(C3138) Switch/Case structure contains more than one default entry

(C3138) Switch/Case structure contains more than one
default entry

Error In:

Correctness
Description:

Switch/Case structures within an activity’s mini-spec have more than one default statement.
Example:

Activity ACT_1 contains the following mini-spec:

(SWITCH_VAL)/switch_c (SWITCH_VAL) {
case_c 1: OUT1=RED;break;
case_c 2: OUT1=AMBER;break;
case_c 3: OUT1=GREEN;break;
default : OUT1=RED;
default : OUT=AMBER;}

The error is generated because there is more than one default statement.
Erroneous Elements:

Switch/Case structures
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Activity Chart Checks

(C3139) lllegal switch structure: non-unique selected
entries

Error In:

Correctness
Description:

Switch/Case structures within an activity’s mini-spec have non-unique entries.
Example:

Activity ACT_1 contains the following mini-spec:

ch(SWITCH_VAL)/switch_c (SWITCH_VAL) {
case_c 1: OUT1=RED;break;
case_c 2: OUT1=AMBER;break;
case_c 2: OUT1=GREEN;break;
default : OUT=AMBER;}

The error is generated because two statements reference case_c=2.

Erroneous Elements:

Switch/Case structures
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(C3141) Inconsistent initial value

(C3141) Inconsistent initial value

Error In:
Correctness
Description:

Checks that the default or initial value of integer and real data-items is consistent with the
minimum and maximum value definitions. Note that this error is likely to occur when
constructing data definitions outside of Rational Statemate (for example, when using
Dataport). The tool checks that no default value outside the minimum and maximum ranges
can be entered using the GUI.

Example:

An integer data-item is defined with a minimum value of 1, maximum value of 5, and an initial
or default value of 7.

Erroneous Elements:

Integer and real data-items
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Activity Chart Checks

(C3143) Inconsistent range definition

Error In:
Correctness
Description:

This test warns about user-defined type definitions where the sub-type ranges are inconsistent
with the parent type definition.

Example:

INT_TYPE is an integer User Defined Type and has a defined minimum/maximum range of
10 - 100 (as shown in the first figure below). SUB_INT_TYPE is a User Defined Type of
INT_TYPE and has a range defined outside of 10 - 100 (as shown in the second figure below).

-loixd
DEB B X5 e B % )%  e \
Mare | Defined In | Tupe | Def ||tode ||ia]

INT_TYPE IS UserDefTyp Yes  Update

SUB_INT_TYPE G051 UzserlefTyp Yes lpdate

General Definition |Httributes |Design Attributes |]Jesc:ription I EE

Structure? ISingle j
Data Typst |Integer ¥ Hini|10 Mz |100 Default Value:|

—
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(C3143) Inconsistent range definition

UserlefTyp Yez  Update
UserDef Typ Yez Update

Erroneous Elements:

User-defined types
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Activity Chart Checks

(C3145) Arrays with illegal indices

Error In:
Correctness
Description:
Array index expression does not result in an integer or contain elements with illegal type.
Example:
Case I:
Arr2 is an integer array from LeftInd2 to Rightind2.
LeftInd2 is defined as:
Single, Constant, with Data Type set to None, and definition set to SubDef?2
SubDef2 is defined as:
Single None Constant with definition set to 2.34
Case I1:
Arrl is an integer array from Leftind to Rightind.
Leftind is defined as:
Single, Constant, with Data Type set to None, and definition set to SubDef
SubDef is defined as:

Single String Constant with definition set to 'My Definition'
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(C4001) Empty information-flows

(C4001) Empty information-flows

Error In:

Completeness
Description:

There are information-flows whose Consists of field in the properties is empty.
Erroneous Elements:

Information-flows

(C4003) Missing actual values for parameters

Error In:
Completeness
Description:

There is a generic instance activity in whose properties there are formal parameters, but no
actual binding.

Erroneous Elements:

Instance activities

(C4005) Elements with incomplete attribute definitions

Error In:
Completeness
Description:

There are elements in whose properties there is an attribute name without a corresponding
attribute value, or vice versa.

Erroneous Elements:

Elements of all types
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Activity Chart Checks

(C4006) Elements with non-unique attribute definitions

Error In:

Completeness
Description:

Element contains more than one attribute with the same name.
Erroneous Elements:

Any element with attributes

(C4007) Elements that are not referenced

Error In:
Completeness
Description:

Textual elements are explicitly defined in the properties, but there is no reference to them in
the model.

Erroneous Elements:

Textual elements
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(C4009) Elements using redundant context variables

(C4009) Elements using redundant context variables

Error In:
Completeness
Description:

Elements contain actions with context variables that are assigned values, but not used in the
action.

Example:

TICK/$1=0;$J=0;

for $J in 1 to 60 loop
ARRAY ($J)=0;

end loop;

Erroneous Elements:

Activities and actions
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Activity Chart Checks

(C4011) Elements that could be defined lower in the
hierarchy of charts

Error In:
Completeness
Description:

Textual elements explicitly defined in the tested chart are used only in other charts, and could
be defined lower in the chart hierarchy without changing the resolution results. The lowest
chart in which these could be defined is the lowest common ancestor of all the charts in which
references to this element exist.

Example:
Consider the following hierarchy of charts:

An element defined in sMS_SYSTEM but used only in PERFORM_RELEASE_GEN and its
descendants should be defined in PERFORM_RELEASE_GEN.

Erroneous Elements:

Textual elements

[ _Isms_sysTem
HORMAL OPERATIONS
PERFORM_RELEASE GEN
| <STATION CONTROL
{(__) GENERATE_RELEASES_FUNCTION
<CALC
NORMAL OPERATTONS CTRL

—{:%;1§§§ENTOR?_MANAGEMENT

STORE DISPLAY CTRL

_{:EEE?%%RGENCY_OPERATIONS
PERFORM_EMERGENCY JETTISON

“‘[%;}E?ETIALIZATION
INITTALIZATION CTRL

) sMs_sYSTEM_CTRL
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(C4013) Elements containing references to components of non-array elements

(C4013) Elements containing references to
components of non-array elements

Error In:
Completeness
Description:

Elements contain data-item expressions with indices, but the accessed data-item is not an
array.

Erroneous Elements:

Actions, activities, conditions, and events

(C4015) Elements containing comparisons of unions:
(not supported in Code Generation

Error In:
Completeness
Description:

Elements contain comparisons of two union data-items. The comparisons of two unions is
ambiguous, because the result depends on which field of the unions is the current field in each.

Erroneous Elements:

Actions, activities, conditions, and events
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Activity Chart Checks

(C4017) Unlabeled compound flow-lines

Error In:

Completeness
Description:

There are compound flow-lines that have unlabeled components.
Example:

Consider the following activity chart.

:"| FTh

Erroneous Elements:

Components of erroneous flow-lines
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(C4019) Unlabeled flow-lines entering or exiting compaosition connectors

(C4019) Unlabeled flow-lines entering or exiting
composition connectors

Error In:
Completeness
Description:

There are flow-line segments whose source or target is a composition connector and to which
no label is attached.

Erroneous Elements:

Unlabeled flow-line segments

(C4020) Arrows not a component of any compound
data-flow

Error In:
Completeness
Description:

This test is pointing out flow-lines in activity charts which are not recognized as valid flow-
lines, and in some cases might cause other Check Model errors like C4058 and C4059.

Erroneous Elements:

Flow Lines
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Activity Chart Checks

(C4021) Flow-lines with incomplete source definition

Error In:
Completeness

Description:

There are flow-lines whose source is not connected to an activity, data-store, or connector. The
source of such flow-lines appears in the activity chart as a small line perpendicular to the flow-

line.
Erroneous Elements:
Flow-lines

Example:

rop

ETL

t  INPHTZ !

h 4

A3> X

R A

OUTPUT3

az
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(C4023) Flow-lines with incomplete target definition

(C4023) Flow-lines with incomplete target definition

Error In:
Completeness
Description:

There are flow-lines whose target is not connected to an activity, data-store, or connector. The
target of such flow-lines appears in the activity chart as a small line perpendicular to the flow-
line.

Example:

See the following figure.

rop

:
.

F Y

L @CTL
:

:

A3> ®

h J

: H B P H
' INPOT? ': ourPT3 L

a2

S S

Erroneous Elements:

Flow-lines
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Activity Chart Checks

(C4025) Compound flow-lines with identical sources

Error In:
Completeness
Description:

There are compound flow-lines whose source set contains the same activity more than once, or
an activity and one of its descendants.

Example:

Components of flow-line x in the following chart:

Top

. B
: ECTL

: : 43> —‘ : :
. H B X H .
1 INPOTZ ouTPHT3 H

\ 4
A §

a2z

. AR
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(C4027) Compound flow-lines with identical targets

(C4027) Compound flow-lines with identical targets

Error In:
Completeness
Description:

There are compound flow-lines whose target set contains the same activity more than once, or
an activity and one of its descendants.

Example:

Components of flow-line B in the following chart.

rop

r| ECTL

: : A3> H H
H H B X o :
: INPuTZ ' | . OUTPUT3 :

a2

k4

Erroneous Elements:

Components of compound flow-lines
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Activity Chart Checks

(C4029) Basic activities without any output

Error In:

Completeness
Description:

Basic activities and their ancestors have no outgoing flow-lines.
Example:

The output of activity A3 in the following chart. See the following figure.

rop

L | a&CTL

A3>

T INPUTZ » OUTPUTI !

4

a4z st
[

v

Erroneous Elements:

Activities
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(C4031) Data-stores without incoming flow-lines or without outgoing flow-lines

(C4031) Data-stores without incoming flow-lines or

without outgoing flow-lines

Error In:
Completeness

Description:

There are data-stores for which there are no input flow-lines, or there are no output flow-lines.

Both inputs and outputs must exist.

Example:

The data-store STORE has no input in the following chart. See the following figure.

Top

'l ECTL

STORE

. A3>
' INDHTZ

A 4

a2

' H
. oUTPyTI )
H

h 4

Erroneous Elements:

Data-stores
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Activity Chart Checks

(C4033) Activities with a single subactivity or data-
store

Error In:
Completeness
Description:

Activities contain a single subelement: an internal activity or a data-store. Activities that
contain a control activity but no other subactivities are allowed.

Erroneous Elements:

Activities

(C4035) Activities containing “to-control” connector
without control-activity

Error In:
Completeness
Description:

There are activities in which a “to-control” connector is drawn, but do not contain a control
activity.

Erroneous Elements:

Activities
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(C4037) Composition connectors with illegally located sources or targets

(C4037) Composition connectors with illegally located

sources or targets

Error In:
Completeness

Description:

There are composition connectors whose components flow from sources or to targets that are

outside the activity in which the connectors reside.

Example:

B
b 4
A
«
E

Erroneous Elements:

Connectors

(C4039) Isolated connectors

Error In:
Completeness

Description:

There are connectors with no entrances and no exits.

Erroneous Elements:

Connectors

Rational Statemate
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Activity Chart Checks

(C4041) Connectors with an entrance and no exit

Error In:
Completeness
Description:

There are junction or composition connectors, or a group of in-page diagram connectors with
the same name, with an entrance but no exit.

Erroneous Elements:

Connectors

(C4043) Connectors with an exit and no entrance

Error In:
Completeness
Description:

There are junction or composition connectors, or a group of in-page diagram connectors of the
same name, with an exit but no entrance.

Erroneous Elements:

Connectors
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(C4045) Junction or composition connectors with a single entrance and a single exit

(C4045) Junction or compaosition connectors with a
single entrance and a single exit

Error In:
Completeness
Description:

There are junction or composition connectors with a single entrance and a single exit.
Therefore, they are redundant.

Erroneous Elements:

Connectors
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Activity Chart Checks

(C4047) Composition connectors with missing flow
elements

Error In:

Completeness
Description:

There are composition connectors whose record decomposition is not complete.
Example:

In the figure, data-item B is defined in terms of a record having three fields - F1, F2, and F3.
Field F3 is missing from the chart.

ror

'l ECTL

A3>

.
H .
. INPuT2 \  OUTPHT3
H .

az at
[

Erroneous Elements:

Data-items
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(C4048) Unresolved elements

(C4048) Unresolved elements

Error In:
Completeness
Description:

There are reference elements for which no element with the same name is explicitly defined in
the relevant scope. This check also checks resolution of external activities in an off-page chart
to activities, data-stores, or modules in the parent chart.

Example:

The following figure shows that the external activity E2 in the definition chart B has no
matching external activity in the instance chart.

Example 2:

A data-item, used within the mini-spec of an activity, is not defined in the relevant scope. The
data-item appears as textual in the properties.

Erroneous Elements:

All types of elements
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Activity Chart Checks

(C4049) The tested chart is a definition chart with
multiple top-level boxes

Error In:
Completeness
Description:

The tested chart is used as an off-page definition of an instance module and has multiple top-
level modules.

This check is performed only when you specify with definition charts. The error is reported in
the definition chart.

Erroneous Elements:

The tested chart

(C4050) The tested chart is a definition chart with
empty top-level box

Error In:
Completeness
Description:

Either the tested chart is used as an off-page definition of an instance activity and has a single,
empty, top-level activity; or, a single activity chart is tested that has a single, empty, top-level
activity.

This check is performed only when you specify with definition charts. The error is reported in
the definition chart.

Erroneous Elements:

The tested chart
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(C4051) Instance off-page connectors without a matching definition off-page connector

(C4051) Instance off-page connectors without a
matching definition off-page connector

Error In:
Completeness
Description:
There are instance off-page connectors that have no matching definition diagram connector.

This check is performed only when you specify with definition charts. Both instance and
definition charts should be included in the Check Model profile. The error is reported in the
instance chart.

Example:

Considering the decomposition of activity A2, the diagram connector shown on the instance
chart is not shown on the definition chart.

Erroneous Elements:

Tested chart
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Activity Chart Checks

(C4052) In parameters not used in the chart

Error In:
Completeness
Description:

There are Input or InOut parameters of a generic chart that are not used (as part of the trigger
in any mini-spec or statechart) within the chart. The error is reported when performing a
standalone test of the generic chart and when the chart containing the generic instance is
tested. The error is reported in the generic definition chart.

Erroneous Elements:

Generic parameters - events, conditions, and data-items

(C4053) Out parameters not affected (generated or
modified) in the chart

Error In:
Completeness
Description:

There are Output or InOut parameters of a generic chart that are not affected (as part of the
action in any mini-spec or statechart) within the chart. The error is reported when performing a
standalone test of the generic chart and when the chart containing the generic instance is
tested. The error is reported in the generic definition chart.

Erroneous Elements:

Generic parameters - events, conditions, and data-items
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(C4054) In parameters not used in the chart

(C4054) In parameters not used in the chart

Error In:

Completeness
Description:

There are Input or InOut parameters that are not used in the chart.
Erroneous Elements:

Textual elements and activities parameters

(C4055) Out parameters not affected in the chart

Error In:
Completeness
Description:

There are Output or InOut parameters that are not affected (modified or generated) in the
chart.

Erroneous Elements:

Textual elements and activities parameters

(C4056) In parameters affected in the chart

Error In:

Completeness
Description:

There are Input or InOut parameters that are affected (modified or generated) in the chart.
Erroneous Elements:

Textual elements and activities parameters
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Activity Chart Checks

(C4057) Out parameters used in the chart

Error In:

Completeness
Description:

There are Output or InOut parameters that are used in the chart.
Erroneous Elements:

Textual elements and activities parameters

(C4058) Elements that flow from/to instance without a
matching flow in definition chart

Error In:
Completeness
Description:

There are elements that flow from or to the instance activity without matching flow-lines to or
from an external activity in the off-page definition chart. Note that the elements flowing on
flow-lines are matched, not the sources or targets of the flow.

This check is performed only when you specify with definition charts. The error is reported in
the instance chart.

Example:

In the following figure, C is an input to the instance @A2. In the off-page definition chart A2,
there is no matching flow from an external activity.
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(C4058) Elements that flow from/to instance without a matching flow in definition chart
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Erroneous Elements:

Events, conditions, data-items, information-flows, and fields
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Activity Chart Checks

(C4059) Elements that flow from/to definition without a
matching flow in instance chart

Error In:

Completeness

Description:

There are elements that flow to or from an external activity in the definition chart without
matching flow-lines from or to the instance. Note that the elements flowing on the flow-lines
are matched, not the sources or targets of the flow.

This check is performed only when you specify with definition charts. The error is reported in
the definition chart.

Example:

In the following figure, C is an input to an activity A2 in the off-page definition chart.
However, in the chart containing the instance @A2, there is no matching flow.
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Erroneous Elements:

Events, conditions, data-items, information-flows, and fields
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(C4061) Elements that are input to an activity and output of another activity without a flow-line

(C4061) Elements that are input to an activity and
output of another activity without a flow-line between

the two activities

Error In:
Completeness

Description:
There are elements that flow on separate flow-lines.

If an activity that is a source of one flow-line changes the value of the element and this value is
used by a target activity of the other flow-line, the drawing might be misleading.
Example:

In Figure a, x is changed by activity A and is used by D, but there is no flow-line between A and
D. Therefore, an error is generated.

However, the separate flow-lines in Figure b are allowed because they have the same source.
Therefore, no error is generated.
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Erroneous Elements:

Events, conditions, data-items, information-flows, and fields
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Activity Chart Checks

(C4063) Actual parameters not flowing to/from generic
instance

Error In:
Completeness
Description:

There are actual parameters bound to some Input/Output formal parameter in an instance box,
but are not shown graphically as being Input/Output to that box. Parameters must be defined.

Example:

In the following figure, the actual parameters P1 and S1 are bound to the formal parameters in
the properties, but they are not shown as being input or output to the instance box in chart A2.
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Erroneous Elements:

Events, conditions, data-items, and fields
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(C4065) Elements that flow to/from generic instance but are not used as actual parameters

(C4065) Elements that flow to/from generic instance
but are not used as actual parameters

Error In:
Completeness
Description:

There are elements that flow into or from an instance box of a generic chart, but are not
declared as actual Input or Output parameters. Parameters must be defined.

Example:

In the following figure, the actual parameters P1 and S1 are shown as being input/output to the
instance box in chart A2, but they have not been bound to the formal parameters in the
properties.

AEE_Z:AZ [Update] _I_I— [m] il
Fite Edit View Layoui Tools Oplions Help
Check Hodel | Refresh| |

[ D2HES R | o= | s X |HER] ||

51
H Data Dictionary Editor : =13
8 i\: File Edit View implenuninfivn Tools Options Help
I Update
Hane Defined In Type Def /Read
o] ol
®® a2 INSTI<GEN 3 Activity Yes|Update &4
o| reeeeeeen | — | e
it rem2 :
I msm2 + RTRES .
o
l,,l 51] x Long Desc... | fttributes... |  Open Referencos |
. —
—
save I Save 8 Mext | Save 2 Provious |
sz ccan
________________ Instance Activity of Generic Chart
Chart: A2
Hane: [INSTL<GEN Synonyn: |
Description: |1
~ Paraneter Type Binding Insert |
P Data-Iten A
elete
[ty 5 Data-Tten
(I1143) Check completed with: 1 correctness errors, 11 completeness warnings Auto Binding
Fill Fornals|
4 Choose...
Inplenented by Module: |1
o
Nessages
(I0219) INSTL successfully saved &
=
i/

Erroneous Elements:

Events, conditions, data-items, and fields
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Activity Chart Checks

(C4067) External elements not declared as formal
parameters

Error In:
Completeness
Description:

There are elements that flow to or from an external activity, to or from the top-level activity in
a generic chart, but do not appear as In or Out formal parameters of the generic chart.

Erroneous Elements:

Events, conditions, and data-items

(C4069) Formal parameters not appearing on external
flow-lines

Error In:
Completeness
Description:

There are elements declared as In or Out parameters of a generic activity chart, but they do not
flow into or out of the top-level activity to an external box in the generic chart.

Erroneous Elements:

Events, conditions, and data-items
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(C4071) Elements affected by an activity but are neither used internally nor output

(C4071) Elements affected by an activity but are
neither used internally nor output

Error In:
Completeness
Description:

There are elements that are affected (modified or generated) in the mini-spec of an activity, but
are neither used in this mini-spec nor as output of the activity.

Example:
In the figure, activity INST2 has the following mini-spec:

C/X=4;Y=2

X is not shown as an output on the chart and is not used internally within the mini-spec;
however, it is affected by INST2.

C TNSTR>

Erroneous Elements:

Events, conditions, and data-items
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Activity Chart Checks

(C4073) Elements that are used by an activity but are
neither input nor affected internally

Error In:
Completeness
Description:

There are elements used in the mini-spec of an activity, but they are neither input nor affected
(modified or generated) in the mini-spec.

Example:
In the figure, activity INST2 has the following mini-spec:

C and D/X=4;Y=2

D is not shown as an input to the chart and is not affected internally within the mini-spec;
however, it is used by INST2.
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Erroneous Elements:

Events, conditions, and data-items
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(C4075) Elements output from activity that are not affected internally

(C4075) Elements output from activity that are not
affected internally

Error In:
Completeness
Description:

There are elements that are output of an activity, but they are not affected (modified or
generated) in its mini-spec.

Example:
In the figure, activity INST2 has the following mini-spec:

C and D/Y=2
X is shown as an output from activity INST2, but is not affected within the mini-spec of INST2.
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Erroneous Elements:

Events, conditions, and data-items
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Activity Chart Checks

(C4076) Flow of empty Information flow

Error In:

Completeness
Description:

There are Information-Flows with no Elements in their “Consist Of” matrix.
Erroneous Elements:

low-lines

(C4077) Elements input to activity that are not used
internally

Error In:

Completeness
Description:

There are elements that are input to an activity, but they are not used in its mini-spec.
Example:

In the figure, activity INST2 has the following mini-spec:

C/X=4;Y=2
D is shown as an input to activity INST2, but is not used within the mini-spec of INST2,

.................

Erroneous Elements:

Events, conditions, and data-items
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(C4079) Data elements with incomplete type definition

(C4079) Data elements with incomplete type definition

Error In:

Completeness
Description:

There are data elements whose type definition is missing or incomplete.
Example:

Element X is defined within the chart A2. X is defined in terms of a user-defined type (UDT)
T_X, where T_X has not been defined.

Erroneous Elements:

Events, conditions, data-items, and UDTs

(C4081) Constant parameter arrays with incomplete
length definition

Error In:
Completeness
Description:

There are constant parameter arrays where either the definition of the formal parameter in the
generic chart is incomplete, or they are bound to an actual parameter of undefined length.

Erroneous Elements:
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Activity Chart Checks

Data-items and conditions
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(C4083) Defined elements that can be merged with elements from ancestor charts

(C4083) Defined elements that can be merged with
elements from ancestor charts

Error In:
Completeness
Description:

There are textual elements explicitly defined in a chart that have matching, explicitly defined
elements with the same name in ancestor charts. Both elements have the same type in both
charts; therefore, they could probably be merged.

Erroneous Elements:

Textual elements

(C4085) Activities whose mini-specs contain started’
trigger or ‘stop' action (in HW style)

Error In:
Completeness
Description:

There are activities whose mini-specs contain started triggers or stop actions. This is improper
in HW style, where all activities are always active.

Erroneous Elements:

Activities
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Activity Chart Checks

(C4087) Procedure-like or self-terminated activities (in
HW style)

Error In:
Completeness
Description:

There are activities defined in the properties as procedure-like or reactive self-terminated
activities. This is improper in HW style, where all activities are always active.

Erroneous Elements:

Activities

(C4089) Activities with combinational assignments

Error In:

Completeness
Description:

There are activities with combinational assignments.
Erroneous Elements:

Activities

(C4091) The tested activity chart contains no activities

Error In:

Completeness
Description:

The tested activity chart contains no activities.
Erroneous Elements:

The tested activity chart
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(C4093) Elements overriding global definitions

(C4093) Elements overriding global definitions

Error In:

Completeness
Description:

There are textual elements with the same name as elements defined in a global definition set.
Erroneous Elements:

Textual elements

(C4095) Subroutines not implemented in any language

Error In:
Completeness
Description:

There are subroutines that have no implementation in the Rational Statemate Action
Language, Procedural Statechart/Flowchart, Ada Code, K&R C Code, ANSI C Code, and so
on.

Erroneous Elements:

Subroutines
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Activity Chart Checks

§C4097) Elements containing triggers that use
unctions with potential side effects

Error In:
Completeness
Description:

Functions are used in the trigger part of labels, static reactions, or mini-specs and have side
effects (that is, they affect global data).

Format:

<element name> i i i i
Function <function name> accessing global data, used in trigger: <trigger
expression>

Example:

Activity A1 has the following mini-spec, where F1 is a function returning an integer that
accesses global data (through Globals Usage in the properties):

EV and [F1(X)==6]/Y=4

Erroneous Elements:

States, activities, and transitions
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(C4099) Textual subroutines using uninitialized local variables

(C4099) Textual subroutines using uninitialized local
variables

Error In:

Completeness
Description:

Local variables of a textual subroutines are used before they are affected or assigned a value.
Format:

<local variable name> in <subroutine name>

Example:

Subroutine F1 is defined to be a function with input parameter x that returns an integer vy and
has two local variables (A and B) defined:

In this case, B is used before it is initialized.
Erroneous Elements:

Subroutines
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Activity Chart Checks

(C4101) Textual subroutines using redundant local
variables

Error In:

Completeness
Description:

Local variables of a textual subroutines are affected (modified or generated) but not used.
Format:

<local variable name> in <subroutine name>

Example:

Subroutine F1 is defined to be a function with input parameter x that returns an integer vy and
has two local variables (A and B) defined:

In this case, A is a redundant local variable.

Erroneous Elements:

Subroutines
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(C4103) Subroutines containing parameters defined as a non-unique user-defined type

(C4103) Subroutines containing parameters defined as
a non-unigque user-defined type

Error In:
Completeness
Description:

A parameter of a subroutine is defined as a user-defined type (UDT), whose name is not
unique in the model.

Example:

DAYS, a parameter of function F1 is defined in terms of a UDT T_DAYS. This UDT is defined
twice in the model and therefore is not unique.

Erroneous Elements:

Subroutines

(C4105) Enumerated types with non-unique value
names

Error In:
Completeness
Description:

There are enumerated types with values that appear in other unrelated enumerated type
definitions (not in a subtype).

Example:
The enumerated value BLUE exists in both UDTs COLORS and MOOD.
Erroneous Elements:

User-defined types
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Activity Chart Checks

(C4106) Data-Elements with Enumerated Value names

Error In:
Correctness
Description:
Textual element has same name as enumerated value.

Note

This is reported even if the definition chart of the regarded element is not included in the
profile, but charts using that element are in the profile.

Erroneous Elements:

Textual elements

(C4107) Subroutines containing wrong usage of
parameters or globals

Error In:
Completeness
Description:
Subroutines contain the wrong usage of parameters or globals. For example:

+ In parameters that are affected by the subroutine.

* In parameters that are not used by the subroutine.

+ Qut parameters that are used by the subroutine.

+ QOut parameters that are not affected by the subroutine.
+ InOut parameters that are not used by the subroutine.

+ InOut parameters that are not affected by the subroutine

Example:
DAYS, an input parameter of function FUNC1, is not used within the subroutine.
Erroneous Elements:

Subroutines
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(C4109) Subroutines with incomplete type definition

(C4109) Subroutines with incomplete type definition

Error In:
Completeness
Description:
Local variables are not used in the subroutine code.
Example:
DAYS, an input parameter of function FUNC1, is not defined within the model.
Erroneous Elements:

Subroutines

(C4111) Local variable not used in the subroutine

Error In:

Completeness
Description:

Local variables are not used in the subroutine code.
Format:

subroutine <subrtn name> Local variable <local var name> not used

Example:
DAYS, a local variable of function FUNC1, is not used within the model.
Erroneous Elements:

Subroutines
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Activity Chart Checks

(C4113) Elements with illegal “ Selected
Implementation”

Error In:

Completeness
Description:

The selected implementation is not one of the existing implementations of the element.
Example:

Subroutine function FUNC1 is described with an implementation of action language. However,
the Selected Implementation in the properties is set to procedural statechart, an
implementation that does not actually exist.

Erroneous Elements:

Subroutines

(C4115) Elements containing a truth table with empty
default row

Error In:
Completeness
Description:

Elements described by truth tables contain a default row with the output columns blank and
the action section empty.

Erroneous Elements:

Subroutines and actions
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(C4117) Elements containing a truth table with empty cells

(Cﬁll?) Elements containing a truth table with empty
cells

Error In:
Completeness
Description:

Elements described by truth tables contain blank cells (that is, cells that are not part of the
default row).

Erroneous Elements:

Subroutines and actions

(C4118) Elements containing a truth table with no
Inpu ts
Error In:
Completeness
Description:
Elements contain a truth table with no input column(s).
Erroneous Elements:

Elements containing truth tables
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Activity Chart Checks

(C4119) Activities with attribute
TRANSPARENT _LEVEL set to ON which are not
instances of an off-page activity chart

Error In:
Completeness
Description:

Activities contain an attribute named TRANSPARENT _LEVEL that is set to ON when there are not
instances of an off-page activity chart.

Note
Check Model does not report on top-level activities of transparent activities.

Example:

The following chart contains an activity A3, which has an attribute called TRANSPARENT_LEVEL
set to ON. However, A3 is not decomposed onto an off-page chart (no @ symbol); therefore,
the warning is generated.

Erroneous Elements:

Activities
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(C4121) Continuous instances with Algebraic loops
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(C4121) Continuous instances with Algebraic loops

Error In:
Completeness

Description:

The logic in a continuous diagram contains an algebraic loop, which makes it impossible to
calculate the output values.

Erroneous Elements:

Continuous diagrams
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Activity Chart Checks

(C4123) Actual port binding not flowing to/from
continuous diagram instance

Error In:
Completeness
Description:

Textual elements, bound to the parameters of a continuous diagram, are not shown as flowing
to or from the continuous instance.

Example:

Activity chart A2 contains an instance of a continuous diagram CALC. A data-item is bound to
one of the parameters of CALC in the properties of the instance. However, X is not shown
flowing to the instance of CALC in chart A2.

Erroneous Elements:

Textual elements

(C4125) Elements that flow to/from continuous
instance but are not used as actual parameters

Error In:

Completeness
Description:

Textual elements, flowing to or from a continuous instance, are not used as actual parameters.
Example:

Activity chart A2 contains an instance of a continuous diagram CALC. Data-item X is shown
flowing into the instance of CALC; however, X is not bound to one of the parameters of CALC in
the properties of the instance.

Erroneous Elements:

Textual elements
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(C4129) “When others” not last in case structure

(C4129) “When others” not last in case structure

Error In:
Completeness
Description:

In a Switch/Case expression written in the Ada style, when_others must be the last statement
in the expression.

Example:
The following expression within an activity’s mini-spec will generate an error:

ch(SWITCH_VAL)/case_ada SWITCH_VAL is

when_ada 1 => OUT1=RED;

when_ada 2 => OUT1=GREEN;
when_ada others => OUT1=NONE;
when_ada 3 => OUT1=AMBER;

end case_ada;

It can be corrected as follows:

ch(SWITCH_VAL)/case_ada SWITCH_VAL is

when_ada 1 => OUT1=RED;
when_ada 2 => OUT1=GREEN;
when_ada 3 => OUT1=AMBER;

when_ada others => OUT1=NONE;
end case_ada;

Erroneous Elements:

Mini-specs
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Activity Chart Checks

(C4131) Switch/Case structure missing default entry

Error In:

Completeness
Description:

A Switch/Case expression within an activity’s mini-spec has no default statement.
Example:

The following expression will generate an error:

ch(SWITCH_VAL)/switch_c SWITCH_VAL {
case_c 1: OUT1=RED;break;
case_c 2: OUT1=GREEN;break;
case_c 3: OUT1=AMBER;break;

It can be corrected as follows:

ch(SWITCH_VAL)/switch_c SWITCH_VAL {
case_c 1: OUT1=RED;break;
case_c 2: OUT1=GREEN;break;
case_c 3: OUT1=AMBER;break;
default: OUT1:NONE;

3

Erroneous Elements:

Mini-specs
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(C4132) Elements input to router that are not output

(C4132) Elements input to router that are not output

Error In:
Completeness
Description:

Textual elements (data-items, conditions, and events) that are shown flowing into a router on
an activity chart are not shown flowing out.

Example:

In the figure, data-item D is shown as an input to ROUTER_1, but is not shown flowing out of
ROUTER_1.
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Erroneous Elements:

Textual elements
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Activity Chart Checks

(C4133) Elements output from router that are not input

Error In:
Completeness

Description:

Textual elements (data-items, conditions, and events) that are shown flowing out of a router on

an activity chart are not shown flowing in.

Example:

In the figure, data-item D is shown as an output of ROUTER_1, but is not shown flowing into

ROUTER_1.
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Erroneous Elements:

Textual elements
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(C4135) Elements that flow from/to router without a matching flow in descendant chart

(C4135) Elements that flow from/to router without a
matching flow in descendant chart

Error In:

Completeness

Description:
There are elements that flow from or to the router without matching flow-lines in descendant

charts lower in the hierarchy.
Note that this test avoids warnings for empty information-flows. (This behavior is consistent
with Check-Model tests C4058 and C4059.)
Example:
Consider the example in the following figure - Tested Activity-chart: TOP1
(C4135) Elements that flow from/to router without a matching flow in descendent chart:

Y flows to @AC_2 through ROUTER_1 from AC3
W flows from @AC_2 through ROUTER_1 to AC3
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Erroneous Elements:
Events, conditions, data-items, information-flows, and fields
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Activity Chart Checks
(C4137) Elements that flow from/to router without a

matching flow in ancestor chart

Error In:
Completeness

Description:
There are elements that flow from or to the router without matching flow-lines higher in the

hierarchy.
Note that this test avoids warnings for empty information-flows. (This behavior is consistent

with Check-Model tests C4058 and C4059.)

Example:
Consider the example in the following figure - Tested Activity-chart: AC2_3

(C4137) Elements that flow from/to router without a matching flow in ancestor chart:

Y flows from ROUTER_1 to AC2_3
W flows from AC2_3 to ROUTER_1
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Erroneous Elements:
Events, conditions, data-items, information-flows, and fields
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(C4139) Elements that flow from/to instance without a matching flow in descendant chart

(C4139) Elements that flow from/to instance without a
matching flow in descendant chart

Error In:
Completeness
Description:

There are elements that flow from or to the instance activity without matching flow-lines to or
from an external activity in a descendant chart.

This test is similar to C4058, but is reported when working in “Non-Strict External-Activity
Resolution” mode, or when the regarded flow-lines pass through routers.

Erroneous Elements:

Events, conditions, data-items, information-flows, and fields

(C4141) Elements that flow from/to definition chart
without a matching flow in ancestor chart

Error In:
Completeness
Description:

There are elements that flow to or from an external activity in the definition chart without
matching flow-lines in an ancestor chart higher in the hierarchy.

This test is similar to C4059, but is reported when working in “Non-Strict External-Activity
Resolution” mode, or when the regarded flow-lines pass through routers.

Erroneous Elements:

Events, conditions, data-items, information-flows, and fields
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Activity Chart Checks

(C4143) Elements flowing to router from basic activity
without flowing from the router to another target

Error In:
Completeness
Description:

This test warns about elements that flow to a router from a basic activity and the only possible
target is the same basic activity (flow-line loopback).

Erroneous Elements:

Events, conditions, data-items, information-flows, and fields

(C4145) Elements flowing from router to basic activity
without flowing to the router from another source

Error In:
Completeness
Description:

This test warns about elements that flow from a Router to a basic activity and the only possible
source is the same basic activity (flow-line loopback).

Erroneous Elements:

Events, conditions, data-items, information-flows, and fields
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(C4147) Complex Data elements not defined by User-type

(C4147) Complex Data elements not defined by User-
type

Error In:

Completeness

Description:

There are data elements defined directly as Record, Union or Array of non-primitive type (not
Integer or Real), and not by User-defined types.

Erroneous Elements:

Data-items, Conditions, Record or Union fields, Subroutine parameters and local-variables
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Activity Chart Checks

(C4149) Elements input to data-store that are not
output

Error In:
Completeness
Description:

Textual elements (data-items, conditions, and events) that are shown flowing into a data-store
on an activity chart are not shown flowing out.

Erroneous Elements:

Textual elements

(C4151) Elements output from data-store that are not
iInput
Error In:
Completeness
Description:

Textual elements (data-items, conditions, and events) that are shown flowing out of a data-
store on an activity chart are not shown flowing in.

Erroneous Elements:

Textual elements
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(C4153) Elements containing wrong type Array indices

(C4153) Elements containing wrong type Array indices

Error In:

Completeness
Description:

Elements containing expressions with Array Indices of the wrong type.
Erroneous Elements:

Activities, States, Transitions, Data-items, Conditions, Events, Actions and Subroutines
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Activity Chart Checks

(C13000) Events marked as ‘Task Event’ are not
connected with EXTENDED Task

Error In:
Design
Description:

There are Events, which their “Its Task” Design-Attribute is not referring to a Task of type
“Extended”.

Erroneous Elements:

Events

(C13001) Multiple tasks with the same priority

Error In:
Design
Description:

There is more than one Activity defined as “Task” in its Design-Attributes, and that have the
same value in their “Priority” Design-Attribute.

Erroneous Elements:

Activities
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(C13002) Nested tasks

(C13002) Nested tasks

Error In:
Design
Description:

There is an Activity defined as “Task” in its Design-Attributes, and that have a Parent Activity
that is defined as “Task” too.

Erroneous Elements:

Activities

(C13003) Event(s), ‘Its Task’ is defined as default

Error In:

Design
Description:

There are Events, which their “Its Task” Design-Attribute is set to “default”.
Erroneous Elements:

Events

(C13004) Either ‘'send’ or ‘receive’ are operated on non-
message elements

Error In:
Design
Description:

There are Data-Items, which are used with the operators send (sn!()) or receive (rc!()), without
being defined as Messages in their Design-Attributes.

Erroneous Elements:

Data-Items
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Activity Chart Checks

(C13005) Either ‘get’ or ‘release’ are operated on non-
resource elements

Error In:
Design
Description:

There are Conditions, which are used with the operators get (gt!()) or release (rl'()), without
being defined as Resources in their Design-Attributes.

Erroneous Elements:

Conditions

(C13006) Data-items or/and conditions, mapping to
external symbol, which is not unique

Error In:
Design
Description:

There is more than one Element with the same value to their “Bind Symbol Name” Design-
Attribute.

Erroneous Elements:

Data-Items and Conditions
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(C13007) Operands in expressions, defined neither as double-buffered nor as having buffered

(C13007) Operands in expressions, defined neither as
double-buftered nor as having buffered access mode

Error In:
Design
Description:

There are Elements that are used with the operators changed (ch()), became-true (tr()) or
became-false (fs()), and are not defined as “Double Buffered” or “Buffered Access” in their
Design-Attributes.

Erroneous Elements:

Data-Items and Conditions

(C13008) Multiple events, that are ‘Task Event’, with
the same ‘Its Task’ and the same ‘Event Mask’

Error In:
Design
Description:

There is more than one Event that are defined as “Task Event” in their Design-Attributes, and
have the same value in their “Event Mask” Design-Attribute.

Erroneous Elements:

Events
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Activity Chart Checks

(C13009) Events that their its task is not appropriate

Error In:

Design
Description:

There are Events, which their “Its Task” Design-Attribute is set to an invalid “Task” name.
Erroneous Elements:

Events

(C13010) Derived events that their task is not
appropriate

Error In:

Design

Description:

There are Events that their “Its-Task” Design-Attribute value is referring to a Task that is not
any ancestor Activity.

Erroneous Elements:

Data-Items and Conditions
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(C13011) Elements unnecessary defined as double-buffered

(C13011) Elements unnecessary defined as double-
buffere

Error In:
Design
Description:

There are Elements that defined as “Double Buffered” in their Design-Attributes
unnecessarily.

Example:

Data-Item DI1 has its Design-Attribute “Double Buffered” set to “yes”, but it is not used with
any of the operators tr(), fs() or ch().

Erroneous Elements:

Data-ltems and Conditions

(C13012) Elements defined neither as double-buffered
nor as having buffered access mode, bound to double-
buffered generic paraneter

Error In:
Design
Description:

There are Elements, not defined as double-buffered, which are binded as actual parameters to
generic parameters that are define as double-buffered. It may lead to code generation errors.

Erroneous Elements:

Data-ltems, Conditions and Events
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Activity Chart Checks

(C13013) Activities defined as Task in a generic scope

Error In:
Design
Description:

It is not allowed to define any Activity inside a generic scope as Task (Design Attribute: Type
= Task/ISR). This may lead to code generation errors.

Erroneous Elements:

Activities

(C13014) Instance of ‘as function’ generic chart
defined as task

Error In:
Design
Description:

It is not allowed to define Activity which is an instance of a generic ‘as function’ as Task
(Design Attribute: Type = Task/ISR). Generic ‘as function’ is a Generic chart that has the
design attribute ‘as function’ set to ‘yes’. This may lead to code generation errors.

Erroneous Elements:

Activities
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(C14002) Functions implemented with incompatible language

(C14002) Functions implemented with incompatible
language
Error In:
Compatibility between MicroC and Rational Statemate
Description:

A subroutine is implemented using a language such as Ada, that is not supported by the
MicroC Code Generator.

Erroneous Elements:

Subroutine
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Activity Chart Checks

(C14006) Usage of incompatible operators/functions

Error In:
Unsupported functions in MicroC Code Generation
Description:

An activity chart is using a built-in operator or function that is not supported in the MicroC
Code Generator.

Erroneous Elements:

Actions, activities, conditions, data-items, and subroutines

(C14007) Usage of incompatible operators on a record
data-item

Error In:
Unsupported operators in MicroC Code Generation
Description:

An activity chart is using a built-in operator on a data-item of type record that is not supported
by the MicroC code generator.

Erroneous Elements:

Actions, activities, conditions, data-items, and subroutines
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Module Chart Checks

This section documents the Check Model checks for module charts. The checks are listed in
numerical order.

(C5001) Loops in element definition

Error In:

Correctness
Description:

Textual elements use themselves in their own definition, via the “chain” definitions.
Example:

Compound event E1 is defined as “E2 or E3~
E2 is defined as “El or E4”

Erroneous Elements:

All textual elements in the loop
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Module Chart Checks

(C5003) Aliases defined as non variable or non bit-
array

Error In:
Correctness

Description:

Aliases are illegally defined because the element appearing in the definition of the alias is
defined as a non-variable compound or constant, or it is not a bit-array.

Erroneous Elements:

Data-items

(C5005) Arrays with an out of range index

Error In:
Correctness

Description:

Arrays or bit-arrays are used with an index value that is out of the defined index range.

Example:

A is an integer array from 1 to 100
There is an action in the model: \A(101):=1

Erroneous Elements:

Data-items, fields, conditions, and events
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(C5007) Arrays with indices in reverse order

(C5007) Arrays with indices in reverse order

Error In:
Correctness
Description:

There are arrays or bit-arrays for which there are references to slices whose borders are in a
reverse order relative to their type definition.

Example:

A is a bit-array from 31 down to O
There is an action in the model:
AC0.. 7):=3

Erroneous Elements:

Data-items, fields, conditions, and events

(C5009) Constants with inconsistent definition

Error In:
Correctness
Description:

There are either constant data-items or conditions whose values do not match their type
definition; constant strings, arrays, or integers whose length does not match their defined
length; or a constant integer whose value is not in the defined value range.

Erroneous Elements:

Data-items and conditions
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Module Chart Checks

(C5010) Data elements defined as arrays of bit

Error In:

Correctness
Description:

Elements are defined as array of a user-defined type (UDT), which is defined as bit.
Example:

DI1 defined as array of BIT1l, which is defined as bit

Erroneous Elements:

Data-items, user-defined types, and fields

(C5011) Elements using uninitialized context variables

Error In:

Correctness
Description:

Elements contain action expressions that use an uninitialized context variable.
Example:

There is a transition labeled as follows:

E /7 Y:=$X; $X:=Z
$x is used before any value is assigned to it.

Erroneous Elements:

Actions
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(C5013) Elements containing infinite While Loops

(C5013) Elements containing infinite While Loops

Error In:
Correctness
Description:

Elements contain action expressions in which there are infinite while loop statements. This
check detects cases in which the whi le loop control expression does not contain a context
variable and there is no break statement in the loop.

Erroneous Elements:

Actions

(C5015) Elements containing For Loops with
erroneous range indices

Error In:
Correctness
Description:

Elements contain action expressions in which there are for loops statements with invalid
ranges.

Example:
There is an action that contains the following for loop statements:

for $1 in 10 to 1 loop

for $1 in 1 down to 10 loop

Erroneous Elements:

Actions
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Module Chart Checks

(C5017) Numeric expressions using bit-arrays longer
than 32 bits

Error In:
Correctness
Description:

There are elements containing numeric expressions that use bit-arrays longer than 32 bits.
There is an automatic conversion from a bit-array to a numeric value only for bit-array with
less than or equal to 32 bits.

Erroneous Elements:

Actions

(C5019) Expressions containing operation between
arrays with unequal length

Error In:
Correctness
Description:

Elements contain assignments or comparisons between arrays or array slices of different
lengths.

Example:

An action that contains the assignment A=B, where A is defined as an array from 1 to 3, and B is
an array from 1 to 5.

Erroneous Elements:

Events, conditions, and actions
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(C5021) Loops in index definition

(C5021) Loops in index definition

Error In:

Correctness
Description:

Data elements use constants in their definition in a “circular” manner.
Example:

AR is an array from 1 to N, while N is defined as rindex(AR).
Erroneous Elements:

Data-items, conditions, events, and user-defined types

(C5023) Defined data elements that are used
incorrectly

Error In:
Correctness
Description:

Elements contain expressions in which data-items that are explicitly defined to be of some
data-type are used in a way that does not match the type consistency and conversion rules.

Example:

1 is defined as an integer; s is defined as a string. There is an action that contains the
following assignment:

1=S

Erroneous Elements:

Events, conditions, data-items, and actions
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Module Chart Checks

(C5025) Data elements without type definition that are
used inconsistently

Error In:
Correctness
Description:

There are unresolved or explicitly defined data-items with no type definition that are used in
expressions in an inconsistent manner.

Example:

D is an unresolved element (it is not explicitly defined); 1 is an integer; S is a string. D appears
in the following assignments:

D=1; D=S

Erroneous Elements:

Data-items, conditions, and user-defined types

(C5027) Predefined Statemate functions that are used
incorrectly

Error In:
Correctness
Description:

Predefined Rational Statemate functions are used with parameters of a wrong type, the wrong
number of parameters, or the wrong return type.

Erroneous Elements:

Functions
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(C5029) Subroutines that are used incorrectly

(C5029) Subroutines that are used incorrectly

Error In:
Correctness
Description:

User functions are used inconsistently in different expressions (for example, with different
return type, different parameter type, or different number of parameters).

Erroneous Elements:

Functions

(C5031) Loops in compound flow-lines

Error In:
Correctness
Description:

A group of flow-line segments, linked through connectors, create a loop or cycle that does not
contain a module.

Erroneous Elements:

Flow-line segments in the loops
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Module Chart Checks

(C5033) Compound flow-lines with identical sources
and targets

Error In:
Correctness
Description:

There are compound flow-lines, each of whose source set and target set contain the same basic
module.

Erroneous Elements:

Compound flow-lines

(C5035) Flow-line segments with illegal joints

Error In:

Correctness
Description:

Compound flow-lines are constructed by using joint connectors in a confusing order.
Erroneous Elements:

Components of the erroneous flow-lines

(C5037) Flow-lines between storage modules

Error In:
Correctness
Description:

Compound flow-lines denote a flow of information between storage modules, which are
passive elements.

Erroneous Elements:

Components of the erroneous flow-lines.

314 Check Model Guide



(C5039) Flow-lines between environment modules

(C5039) Flow-lines between environment modules

Error In:
Correctness
Description:

There are compound flow-lines between external modules. These flow-lines, even if they
exist, should not be specified in the chart where the source and target modules are external
and, therefore, out of the description scope.

Erroneous Elements:

Components of the erroneous flow-lines

(C5041) Conflicting labels on flow-line components

Error In:

Correctness
Description:

There are compound flow-lines whose segments are labeled with conflicting labels.
Erroneous Elements:

Components of the erroneous flow-lines

(C5043) Composition connectors with multiple
entrances and multiple exits

Error In:

Correctness
Description:

There are composition connectors with multiple entering and exiting flow-lines.
Erroneous Elements:

Connectors
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Module Chart Checks

(C5045) Instance off-page connectors with same name
as in-page connector

Error In:
Correctness
Description:

Off-page diagram connectors drawn in an instance module have the same name as another in-
page connector in the chart.

Erroneous Elements

: Instance connectors

(C5047) Multiple instance off-page connectors with
conflicting arrow directions

Error In:
Correctness
Description:

Off-page diagram connectors are drawn in an instance module in which another connector
having the same name, but conflicting arrow directions, is drawn.

Erroneous Elements:

Instance connectors
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(C5049) Definition off-page connectors with same name as in-page connector

(C5049) Definition off-page connectors with same
name as in-page connector

Error In:
Correctness
Description:

Definition off-page connectors match to an instance off-page connector and have the same
name as an in-page diagram connector.

The test is performed only when “with definition charts” is specified. The error is reported in
the definition chart.

Erroneous Elements:

Connectors

(C5051) Definition off-page connectors with conflicting
arrow directions in instance off-page connector

Error In:
Correctness
Description:

There are definition off-page connectors whose matching connector in the instance chart has a
conflicting arrow direction.

The test is performed only when “with definition charts” is specified. The error is reported in
the definition chart.

Erroneous Elements:

Definition off-page connectors
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Module Chart Checks

(C5053) Elements that flow to/from instance with
contradicting source/target name in definition chart

Error In:
Correctness
Description:

There are elements that flow to or from an instance module and an external module in the off-
page definition chart, but the source or target name in the off-page definition chart is not the
same as the name or synonym in the instance chart.

The test is performed only when “with definition charts” is specified. The error is reported in
the instance chart.

Erroneous Elements:

Events, conditions, data-items, information-flows, and fields

(C5055) Elements that flow to/from definition with
contradicting source/target name in instance chart

Error In:
Correctness
Description:

There are elements that flow to or from an external module in the off-page definition chart and
the instance module, but the source or target name in the instance chart is not the same as the
name or synonym in the off-page definition chart.

The test is performed only when “with definition charts” is specified. The error is reported in
the definition chart.

Erroneous Elements:

Events, conditions, data-items, information-flows, and fields
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(C5057) Instance modules with contradicting information in definition module

(C5057) Instance modules with contradicting
information in definition module

Error In:
Correctness
Description:

There are instance modules whose type or describing activity chart is different from the type
or describing activity chart entered in the properties of the top-level module in the off-page
definition chart.

This test is performed only when “with definition charts” is specified. The error is reported in
the instance chart.

Erroneous Elements:

Instance modules

(C5059) Generic instances with inconsistent parameter
binding
Error In:
Correctness
Description:

There is inconsistency between the actual bindings in the instance box and the defined formal
parameters in the generic chart.

Erroneous Elements:

Instance boxes
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Module Chart Checks

(C5061) Elements using field references that do not
appear in the record / union definition

Error In:
Correctness

Description:

Elements contain expressions in which a field of an explicitly defined record or union is used,
but the field does not appear in the record or union definition.

Erroneous Elements:

Textual elements

(C5062) Elements erroneously using field references

Error In:

Completeness
Description:

Elements erroneously reference fields.
Erroneous Elements:

Any element referencing fields.
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(C5063) Formal parameters whose data-type is not global

(C|2586|3) Formal parameters whose data-type is not
globa

Error In:
Correctness
Description:

Formal parameters are defined to be a particular user-defined type (UDT), but the UDT is
defined in the generic chart. Because the UDT is not visible outside the generic chart, an actual
binding cannot have this type.

Erroneous Elements:

Data-items of formal parameters

(C5065) Actual binding whose data-type is not global

Error In:
Correctness
Description:

Data-items, used as actual bindings in an instance box, are defined to be a particular user-
defined type (UDT), but the UDT is not global (the UDT is defined in a chart, not in a GDS).
Because this UDT is not visible to the generic chart, a formal parameter cannot have this type.

Erroneous Elements:

Data-items
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Module Chart Checks

(C5067) Empty Records/Unions

Error In:

Correctness

Description:

Data-items or data-types are defined to be a record or union, but there are no fields defined in
the structure. This is a correctness error because it is a fatal error situation for some tools.

Erroneous Elements:

Data-items and user-defined types

(C5069) Sub-types that conflict with enumerated type
definition

Error In:
Correctness
Description:
One of the following situations:

+ Values do not appear in the definition of the enumerated type.

+ Values in the subtype definition are not in the same order as in the enumerated type
definition.

* Values are missing from subtype definition.

Format:

<subtype name> (sub range of <enumerated-type name>):
<enum-value> - missing In <enumerated-type name>
<enum-value> - missing in <subtype name>
<enum-value> - incorrect ordinal in <subtype name>
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(C5071) Tasks/Procedures that are used incorrectly

Example:

WORKING_DAYS (sub range of DAYS)

MONDAY - missing in DAYS

TUE - missing in WORKING_DAYS

WED - incorrect ordinal in WORKING_DAYS
Erroneous Elements:

User-defined types

(C5071) Tasks/Procedures that are used incorrectly

Error In:
Correctness
Description:

Tasks can be bound only to activities; any other usage, such as expressions, is erroneous.
Procedures and functions cannot be bound to activities.

Format:

<subroutine name> (defined as <task/procedure/function>)
used as <procedure/function/task> in definition of <element name>

Example:

TASK PRINTER is used as procedure/function in definition of SCH:AN1

Erroneous Elements:

Subroutines
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Module Chart Checks

(C5075) Elements containing out of range assignments
of enumerated values

Error In:
Correctness
Description:

An element of some subtype is assigned a value that belongs to the enumerated type, but is not in
the range of the subtype.

Example:

In definition of SCH_ADA:ACTION WORKING_DAY:=SAT

Erroneous Elements:

Textual elements, boxes, and arrows

(C5077) Procedures/functions that are used incorrectly

Error In:
Correctness
Description:

Procedures are used as functions and treated in some expression as if they return a value, or
functions are used as procedures and. called in an expression where an action is expected.

Format:

<Function/Procedure> <subroutine name>
used as <Procedure/Function> in definition of
<element name>:<expression of subroutine call>
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(C5079) Callback procedures that are used/defined incorrectly

Example:

Function FACTORIAL
used as Procedure in definition of
SCH_ADA:ACTION: FACTORIAL(Y)

Erroneous Elements:

Subroutines

(C5079) Callback procedures that are used/defined
incorrectly

Error In:
Correctness
Description:

Procedures are used as callbacks, whose first parameter is either not of type string or of mode
Input.

Erroneous Elements:

Element
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Module Chart Checks

(C5081) Elements containing subroutine calls with
conflicting length of parameters

Error In:
Correctness
Description:

There are subroutine calls where the actual parameter’s length conflicts with the
corresponding formal parameter definition, or whose length is unknown.

Example:

STATE1
CALLBACK(A,ARRAY,3)
ARRAY - Unknown length

Erroneous Elements:

Textual elements, boxes, and arrows

(C5083) Subroutines using recursive calls

Error In:
Correctness
Description:
Subroutines use recursive calls either directly or by other subroutines.

Example:

SR3 called from SR2
SR2 called from SR3

Erroneous Elements:

Subroutines
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(C5085) Subroutines using element not declared as parameters, local variables or globals

(C5085) Subroutines using element not declared as
parameters, local variables or globals

Error In:
Correctness
Description:

Subroutines use elements not declared as parameters, local variables, or globals. All elements
used in the subroutine code should be declared, including constant data-items and conditions,
enumerated values, other subroutines, and user-defined types.

Format:

subroutine <subroutine name><used element name>
Example:

subroutine F L2

Erroneous Elements:

Subroutines
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(C5087) Subroutines that contain references to
activities
Error In:
Correctness
Description:

Subroutines contain references to activities. This occurs only when using a global variable,
which contains a reference to an activity.

Example:

subroutine F

Activity A used in GLOBAL1
Erroneous Elements:

Subroutines

(C5089) Subroutines with illegal parameter type or
return type

Error In:
Correctness
Description:

There is a subroutine where a User-Defined Type (UDT) is the return type, or the type of a
parameter. The following table below lists the illegal definitions for UDTSs.

Type Return Type Parameter
UDT array of string *) **||legal**
UDT array of bit-array * **||legal**
UDT array of direct R/U *) **||legal**
UDT queue of anything **|llegal** **[llegal**
Array of queue (any **||legal** **||legal**
dimension)

328 Check Model Guide



(C5091) Subroutines with illegal local variables type

(*) In these cases, a middle UDT is needed. For example, if the return type of a function
should be an array of string, it should be defined as:

UDT array of STR_UDT, and STR_UDT, a string

Example:

subroutine F1
return type ARR_STR1, defined as array of string STR_QUEUE1,
type of parameter P1l, defined as queue

Erroneous Elements:

Subroutines

(C5091) Subroutines with illegal local variables type

Error In:
Correctness
Description:

Local variables are defined as a user-defined type (UDT), as a queue or an array (of any
dimension) of a queue.

Example:

subroutine F1
STR_QUEUE1l, type of local variable LV1,
defined as queue

Erroneous Elements:

Subroutines
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(C5093) Subroutines with illegal/missing RETURN
command

Error In:
Correctness
Description:

There are functions without a RETURN command, procedures with a RETURN command, or a
function with return type that conflicts with the returned value’s type.

Erroneous Elements:

Subroutines

(C5095) Subroutines that call other subroutines whose
global elements are missing from
the calling subroutine definition

Error In:
Correctness
Description:

Global elements of a subroutine, sus, must be declared as global elements of any other
subroutine calling sus.

Erroneous Elements:

Subroutines
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(C5097) Subroutines with local variables/parameters overriding parameters/globals

(C5097) Subroutines with local variables/parameters
overriding parameters/globals

Error In:
Correctness
Description:

There are subroutines with local variables that override parameters or globals, or there are
parameters that override globals.

Erroneous Elements:

Subroutines

(C5099) Subroutines with illegal combination of type
and implementation

Error In:

Correctness
Description:

There are subroutines with an illegal combination of type and implementation.
Erroneous Elements:

Subroutines
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§C5101) Elements containing a truth table with illegal
actorization structure

Error In:
Correctness
Description:

United input cells are not nested in a previous union; or, there are two or more rows that share
the same input section, but have different output sections.

Erroneous Elements:

Subroutines and actions

(C5103) Elements containing a truth table with illegal
combination of inputs

Error In:
Correctness
Description:

Elements are described by truth tables using the same element twice as an input (via aliases).
This check ensures that the same element is not used twice as a whole, but does not compare
overlapping of slices.

Erroneous Elements:

Subroutines and actions
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(C5105) Elements containing a truth table with illegal combination of outputs

(C5105) Elements containing a truth table with illegal
combination of outputs

Error In:

Correctness
Description:

Elements are described by truth tables using the same element twice as an output (via aliases).
Erroneous Elements:

Subroutines and actions

(C5107) Elements containing out of range integer/real
assignments

Error In:
Correctness
Description:

Elements contain assignments of integers, where an out-of-range value is assigned to a
restricted range integer, or one restricted range integer is assigned to another where there is no
intersection of ranges. It tests if an integer or real value is compared with a value outside its
range, as well as values assigned to integer or real variable.

Erroneous Elements:

States, actions, data-items, and transitions
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(C5109) Inconsistent initial value

Error In:
Correctness
Description:
There is a Data-Item, with one of the following data in its definition:

* |ts “Min” value is smaller than its “Default Value” value.
* Its “Max” value is greater than its “Default Value” value.
* |ts “Default Value” needs more bits than defined in the “Bits#” field.

Erroneous Elements:

Data-Items

(C5111) Inconsistent range definition

Error In:
Correctness
Description:

This test warns about user-defined type definitions where the sub-type ranges are inconsistent
with the parent type definition.

Example:

INT_TYPE is an integer User Defined Type and has a defined minimum/maximum range of
10 - 100 (as shown in the first figure below). SUB_INT_TYPE is a User Defined Type of
INT_TYPE and has a range defined outside of 10 - 100 (as shown in the second figure).
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(C5111) Inconsistent range definition

INT_TYPE {User Defined Type) -0l x|
IDESE KB E BRI i8R =

Mame: I]]eFined In IT pe I]]e'F '] Mode ];l
INT_TYPE UzerlefTyp

SUB_INT_TYPE GDS1 UzerlefTyp Yez Update

=l

Gemeral Definition |ﬂttr‘ibutes I]]esign Attributes I]]escription

Structure: ISingle =l

Data Type: IIntegeP j Min:llO Maxz |100 Default 'u'alue:l
|Name ||DeFine-:I In || Type || Dief :|ch:|e ||i|
INT_TYPE GCIs1 UzerDef Typ Yes  Update

SUB_INT_TYPE GIS1 erlef Tup

Update

Gereral Definition Iﬂttr'ibutes I]]esign Attributes |Descr‘iption I

Structure: ISingle j

Data Type: IUSEI" Type j IINT_T’T’PE j
Subtype Rangea...l Subtype Ranges ﬂ

Definition: |- Hin: |2 Has | 102

Enum Default 'u'alue:l

0k | Cancel I Help

Erroneous Elements:

User-defined types
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(C5113) Empty information-flows

Error In:
Correctness
Description:
Array index expression does not result in an integer or contain elements with illegal type.
Example:
Case I:
Arr2 is an integer array from LeftInd2 to Rightind2.
LeftInd2 is defined as:
Single, Constant, with Data Type set to None, and definition set to SubDef?2
SubDef2 is defined as:
Single None Constant with definition set to 2.34
Case I1:
Arrl is an integer array from Leftind to Rightind.
Leftind is defined as:
Single, Constant, with Data Type set to None, and definition set to SubDef
SubDef is defined as:

Single String Constant with definition set to 'My Definition'
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(C6001) Empty information-flows

(C6001) Empty information-flows

Error In:

Completeness
Description:

There are information-flows whose Consists of field in the properties is empty.
Erroneous Elements:

Information-flows

(C6003) Missing actual values for parameters

Error In:
Completeness
Description:

There is an instance box in whose properties there are formal parameters without actual
bindings.

Erroneous Elements:

Instance boxes
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(C6005) Elements with incorrect or incomplete
attribute definitions

Error In:
Completeness
Description:

There are elements in whose properties there is an attribute name without a corresponding
attribute value, or vice-versa.

Erroneous Elements:

Elements of all types

(C6006) Elements with non-unique attribute definitions

Error In:

Completeness
Description:

Element contains more than one attribute with the same name.
Erroneous Elements:

Any element with attributes

(C6007) Elements that are never referenced

Error In:

Completeness
Description:

Textual elements are explicitly defined in the properties, but are not referenced in the model.
Erroneous Elements:

Textual elements
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(C6009) Elements using redundant context variables

(C6009) Elements using redundant context variables

Error In:
Completeness
Description:

Elements contain actions with context variables that are assigned a value, but are not used in
the action.

Erroneous Elements:

Actions

(C6011) Elements that could be defined lower in the
hierarchy of charts

Error In:
Completeness
Description:

There are textual elements explicitly defined in the tested chart that are used only in other
charts, which could be defined in the lower chart hierarchy without changing the resolution
results.

The lowest chart in which they could be defined is the lowest common ancestor of all the
charts in which references to this element exist.

Erroneous Elements:

Textual elements
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(C6013) Elements containing references to
components of non-array elements

Error In:
Completeness
Description:

Elements contain data-item expressions with indices, but the accessed data-item is not an
array.

Erroneous Elements:

Actions, conditions, and events

(C6015) Elements containing comparisons of unions:
(not supported in Code Generation)

Error In:
Completeness
Description:

Elements contain comparisons of two union data-items. The comparisons of two unions is
ambiguous because the result depends on which field of the unions is the current field in each
element.

Erroneous Elements:

Actions, conditions, and events
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(C6017) Unlabeled compound flow-lines

(C6017) Unlabeled compound flow-lines

Error In:

Completeness
Description:

There are compound flow-lines, all of whose components are unlabeled.
Erroneous Elements:

Components of erroneous flow-lines

(C6019) Unlabeled flow-lines entering or exiting
composition connectors

Error In:
Completeness
Description:

There are flow-line segments whose source or target is a composition connector and to which
no label is attached.

Erroneous Elements:

Unlabeled flow-line segments

(C6021) Flow-lines with incomplete source definition

Error In:
Completeness
Description:

There are flow-lines whose source is not connected to a module or connector. The source of
such flow-lines appears in the module chart as a small line perpendicular to the flow-line.

Erroneous Elements:

Flow-lines
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(C6023) Flow-lines with incomplete target definition

Error In:
Completeness
Description:

There are flow-lines whose target is not connected to a module or connector. The target of
such flow-lines appears in the activity chart as a small line perpendicular to the flow-line.

Erroneous Elements:

Flow-lines

(C6025) Compound flow-lines with identical sources

Error In:
Completeness
Description:

There are compound flow-lines whose source set contains the same module more than once, or
a module and one of its descendants.

Erroneous Elements:

Components of the erroneous flow-lines

(C6027) Compound flow-lines with identical targets

Error In:
Completeness
Description:

There are compound flow-lines whose target set contains the same module more than once, or
a module and one of its descendants.

Erroneous Elements:

Components of the erroneous flow-lines
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(C6029) Composition connectors with illegally located sources or targets

(C6029) Composition connectors with illegally located
sources or targets

Error In:
Completeness
Description:

There are composition connectors whose components flow from sources or to targets that are
outside the module in which the connector resides.

Erroneous Elements:

Connectors

(C6031) Isolated connectors

Error In:

Completeness
Description:

There are connectors with no entrances and no exits.
Erroneous Elements:

Connectors

(C6033) Connectors with an entrance and no exit

Error In:
Completeness
Description:

There are junction or composition connectors, or a group of in-page diagram connectors with
the same name, with an entrance, but no exit.

Erroneous Elements:

Connectors
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(C6035) Connectors with an exit and no entrance

Error In:
Completeness
Description:

There are junction or composition connectors, or a group of in-page diagram connectors, with
the same name, with an exit, but no entrance.

Erroneous Elements:

Connectors

(C6037) Junction or compaosition connectors with a
single entrance and a single exit

Error In:
Completeness
Description:

There are junction or composition connectors with a single entrance and a single exit and,
therefore, are probably redundant.

Erroneous Elements:

Connectors
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(C6039) Composition connectors with missing flow elements

(C6039) Composition connectors with missing flow
elements

Error In:

Completeness
Description:

There are composition connectors whose record decomposition is not complete.
Erroneous Elements:

Data-items

(C6041) Unresolved elements

Error In:
Completeness
Description:

There are reference elements for which no element with the same name is explicitly defined in
the relevant scope. This check also checks resolution of external modules in an off-page chart
to modules in the parent chart.

Erroneous Elements:

All types of elements
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(C6043) The tested chart is a definition chart with
multiple top-level boxes

Error In:
Completeness
Description:

The tested chart is used as an off-page definition of an instance module and has multiple top-
level modules.

The test is performed only when “with definition charts” is specified. The error is reported in
the definition chart.

Erroneous Elements:

Tested chart

(C6045) The tested chart is a definition chart with
empty top-level box

Error In:
Completeness
Description:

The tested charts is used as an off-page definition of an instance module and has a single,
empty, top-level module.

The test is performed only when “with definition charts” is specified. The error is reported in
the definition chart.

Erroneous Elements:

Tested chart
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(C6047) Instance off-page connectors without a matching definition off-page connector

(C6047) Instance off-page connectors without a
matching definition off-page connector

Error In:
Completeness
Description:
Instance off-page connectors have no matching definition diagram connector.

The test is performed only when “with definition charts” is specified. The error is reported in
the definition chart.

Erroneous Elements:

Connectors

(C6049) Elements that flow from/to instance without a
matching flow in definition chart

Error In:
Completeness
Description:

There are elements that flow from or to the instance module without matching flow-lines to or
from an external module in the off-page definition chart. Note that the elements flowing on
flow-lines are matched, not the sources or targets of the flow.

The test is performed only when “with definition charts” is specified. The error is reported in
the instance chart.

Erroneous Elements:

Events, conditions, data-items, information-flows, and fields
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(C6051) Elements that flow from/to definition without a
matching flow in instance chart

Error In:
Completeness
Description:

There are elements that flow to or from an external module in the definition chart without
matching flow-lines from or to the instance. Note that the elements flowing on the flow-lines
are matched, not the sources or targets of the flow.

The test is performed only when “with definition charts” is specified. The error is reported in
the definition chart.

Erroneous Elements:

Events, conditions, data-items, information-flows, and fields

(C6053) Actual parameters not flowing to/from generic
instance

Error In:
Completeness
Description:

Actual parameters are bound to some Input or Output formal parameter in an instance box, but
are not specified as Input or Output to that box.

Erroneous Elements:

Events, conditions, data-items, and fields
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(C6055) Elements that flow to/from generic instance but are not used as actual parameters

(C6055) Elements that flow to/from generic instance
but are not used as actual parameters

Error In:
Completeness
Description:

There are elements flowing into or out of an instance box of a generic chart, but they are not
declared as an actual input or output parameter.

Erroneous Elements:

Events, conditions, data-items, and fields

(C6057) External elements not declared as formal
parameters

Error In:
Completeness
Description:

There are elements that flow from or to an external module, to or from the top-level module in
a generic chart, but do not appear as In or Out formal parameters of the generic chart.

Erroneous Elements:

Events, conditions, and data-items
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§C605_9) Formal parameters not appearing on external
low-lines

Error In:
Completeness
Description:

There are elements declared as In or Out parameters of a generic module chart, but they do not
flow into or out of the top-level module to an external box in the generic chart.

Erroneous Elements:

Events, conditions, and data-items

(C6061) Data elements with incomplete type definition

Error In:

Completeness
Description:

There are data elements whose type definition is missing or incomplete.
Erroneous Elements:

Events, conditions, data-items, and user-defined types
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(C6063) Constant parameter arrays with incomplete length definition

(C6063) Constant parameter arrays with incomplete
length definition

Error In:
Completeness
Description:

There are constant parameter arrays where either the definition of the formal parameter in the
generic chart is incomplete, or they are bound to an actual parameter of undefined length.

Erroneous Elements:

Data-items and conditions

(C6065) Defined elements that can be merged with
elements from ancestor charts

Error In:
Completeness
Description:

There are textual elements explicitly defined in a chart that have matching, explicitly defined
elements with the same name in ancestor charts. Both elements have the same type in both
charts; therefore, they could probably be merged.

Erroneous Elements:

Textual elements
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(C6067) The tested Module chart contains no modules

Error In:

Completeness
Description:

The tested module chart contains no modules.
Erroneous Elements:

Tested module chart

(C6069) Elements overriding global definitions

Error In:

Completeness
Description:

There are textual elements with the same name as elements defined in a global definition set.
Erroneous Elements:

Textual elements
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(C6071) Subroutines not implemented in any language

(C6071) Subroutines not implemented in any language

Error In:
Completeness
Description:

There are subroutines that have no implementation in the Rational Statemate Action
Language, Procedural Statechart/Flowchart, Ada Code, K&R C Code, ANSI C Code, and so
on.

Format:

<subroutine name>

Example:

CALLBACK

Erroneous Elements:

Subroutines

(C6073) Subroutine parameters of a non-unique user-
defined type

Error In:
Completeness
Description:

A parameter of a subroutine is defined as a user-defined type (UDT), whose name is not
unique in the model.

Example:

P2 parameter of procedure CALLBACK
Using nonunique user-defined type DAYS
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Erroneous Elements:

Subroutines
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(C6075) Enumerated types with non-unique user-defined type

(C6075) Enumerated types with non-unique user-
defined type

Error In:
Completeness
Description:

There are enumerated types with values that appear in other unrelated enumerated type
definitions (not in a subtype).

Example:

user-defined type COLORS
BLUE, exists also in SCH:MOODS

Erroneous Elements:

User-defined types

(C6076) Data-Elements with Enumerated Value names

Error In:
Correctness
Description:
Textual element has same name as enumerated values.

Erroneous Elements:
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Textual elements

(C6077) Textual subroutines using uninitialized local
variables

Error In:
Completeness
Description:

Local variables of a textual subroutine are used before they are affected or assigned some
value.

Format:

<local variable name> in <subroutine name>
Example:

LOCAL1 in F1

Erroneous Elements:

Subroutines
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(C6079) Textual subroutine using redundant local variables

(C6079) Textual subroutine using redundant local
variables

Error In:

Completeness
Description:

Local variables of a textual subroutine are affected, but not used.
Format:

<local variable name> in <subroutine name>

Example:
LOCAL1 in F1

Erroneous Elements:

Subroutines

(C6081) Subroutines containing wrong usage of
parameters or globals

Error In:
Completeness
Description:
Subroutines contain the wrong usage of parameters or globals. For example:

+ In parameters that are affected by the subroutine.

+ In parameters that are not used by the subroutine.

+ Out parameters that are used by the subroutine.

+ Out parameters that are not affected by the subroutine.
+ InOut parameters that are not used by the subroutine.

+ InOut parameters that are not affected by the subroutine
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Example:

subroutine CALLBACK

Input parameter Pl not used
Erroneous Elements:

Subroutines

(C6083) Subroutines with incomplete type definition

Error In:

Completeness
Description:

There are subroutines with incomplete type definitions.
Erroneous Elements:

Subroutines

(C6085) Local variables not used in the subroutine

Error In:

Completeness
Description:

Local variables are not used in the subroutine code.
Example:

subroutine A Local variable L3 not used

Erroneous Elements:

Subroutines
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(C6087) Elements with illegal “Selected Implementation”

(C6087) Elements with illegal “ Selected
Implementation”

Error In:

Completeness
Description:

The selected implementation is not one of the existing implementations of the element.
Erroneous Elements:

Subroutines

(C6089) Elements containing a truth table with empty
default row

Error In:
Completeness
Descriptions:

Elements described by truth tables contain a default row with its the output columns blank and
the action section empty.

Erroneous Elements:

Subroutines and actions
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(C|6|O91) Elements containing a truth table with empty
cells

Error In:
Completeness
Description:

Elements described by truth tables contain blank cells (that is, cells that are not part of the
default row).

Erroneous Elements:

Subroutines and actions

(C6093) Elements containing a truth table with no
INn pUtS
Error In:
Completeness
Description:
Elements contain a truth table with no input column(s).
Erroneous Elements:

Elements containing truth tables
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(C6095) Complex Data elements not defined by User-type

(C6095) Complex Data elements not defined by User-
type

There are data elements defined directly as Record, Union or Array of non-primitive type (not
Integer or Real), and not by User-defined types.

Error In:
Completeness
Erroneous Elements:

Data-items, Conditions, Record or Union fields, Subroutine parameters and local-variables

(C6097) Elements containing wrong type Array indices

Error In:

Completeness
Description:

Elements containing expressions with Array Indices of the wrong type.
Erroneous Elements:

Activities, States, Transitions, Data-items, Conditions, Events, Actions and Subroutines
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Global Definition Set Checks

This section documents the Check Model checks for Global Definition Sets (GDSs). The checks
are listed in numerical order.

(C7001) Elements with incorrect or incomplete
attribute definitions

Error In:
Completeness
Description:

There are elements whose properties contain an attribute name without a corresponding
attribute value, or vice-versa.

Erroneous Elements:

Elements of all types

(C7002) Elements containing references to
components of non-array elements

Error In:
Completeness
Description:

Elements contain data-item expressions with indices, but the accessed data-item is not an
array.

Erroneous Elements:

Element

Rational Statemate 363



Global Definition Set Checks

(C7003) The tested global definition set contains no
elements

Error In:

Completeness
Description:

There are no elements defined in the tested global definition set (GDS).
Erroneous Elements:

The tested GDS

(C7004) Elements that are not referenced in Statemate
Expressions and Definitions

Error In:

Completeness
Description:

Checks for elements that are defined in GDS but are not referenced in the model.
Erroneous Elements:

Element

(C7005) Unresolved elements

Error In:
Completeness
Description:

There are reference elements for which no elements with the same name are explicitly defined
in the relevant scope.

Erroneous Elements:

All types of elements
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(C7006) Elements with non-unique attribute definitions

(C7006) Elements with non-unique attribute definitions

Error In:

Completeness
Description:

Element contains more than one attribute with the same name.
Erroneous Elements:

Any element with attributes

(C7007) Data elements with incomplete type definition

Error In:

Completeness
Description:

There are data elements whose type definition is missing or incomplete.
Erroneous Elements:

Conditions, data-items, and user-defined types

(C7009) Subroutines not implemented in any language

Error In:
Completeness
Description:

Subroutines have no implementation in the Rational Statemate Action Language, Procedural
Statechart/Flowchart, Ada Code, K&R C Code, ANSI C Code, and so on.

Example:

CALLBACK

Erroneous Elements:

Subroutines
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(C7011) Subroutines containing parameters defined as
a non-unique User-defined type

Error In:
Completeness
Description:

A parameter of a subroutine is defined a user-defined type, but its name is not unique in the
model.

Example:

P2 parameter of procedure CALLBACK
Using nonunique user-defined type DAYS

Erroneous Elements:

Subroutines

(C7013) Enumerated types with non-unique value
names

Error In:
Completeness
Description:

Enumerated types with values appear in other, unrelated enumerated type definitions (not in a
subtype).

Example:

user-defined type COLORS
BLUE, exists also in SCH:MOODS

Erroneous Elements:

User-defined types
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(C7014) Data-Elements with Enumerated Value names

(C7014) Data-Elements with Enumerated Value names

Error In:

Correctness
Description:

Textual element has same name as enumerated values.
Erroneous Elements:

Textual elements

(C7015) Textual subroutines using uninitialized local
variables

Error In:
Completeness
Description:

Local variables of a textual subroutine are used before they are affected or assigned some
value.

Example:

LOCAL1 in F1

Erroneous Elements:

Subroutines
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(C7017) Textual subroutines using redundant local
variables

Error In:

Completeness
Description:

Local variables of a textual subroutine are affected, but not used.
Example:

LOCALL1 in F1

Erroneous Elements:

Subroutines

(C7019) Subroutines containing wrong usage of
parameters or globals

Error In:
Completeness
Description:
Subroutines contain the wrong usage of parameters or globals, such as:

¢ In parameters that are affected by the subroutine.

¢ In parameters that are not used by the subroutine.

¢ Out parameters that are used by the subroutine.

¢ QOut parameters that are not affected by the subroutine

¢ InOut parameters that are not used by the subroutine

¢ InOut parameters that are not affected by the subroutine
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(C7020) Subroutines with incomplete type definition

Example:

subroutine CALLBACK
Input parameter Pl not used

Erroneous Elements:

Subroutines

(C7020) Subroutines with incomplete type definition

Error In:

Completeness
Description:

There are subroutines with incomplete type definitions.
Erroneous Elements:

Subroutines

(C7021) Local variables not used in the subroutine

Error In:
Completeness
Description:

A subroutine's selected implementation defines a local variable that is never used in the
implementation.

Erroneous Elements:

Subroutine
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(C7022) Elements containing a truth table with no
inputs
Error In:
Completeness
Description:
Elements contain a truth table with no input column(s).
Erroneous Elements:

Elements containing truth tables

(C7023) Elements with illegal “ Selected
Implementation”

Error In:

Completeness
Description:

The selected implementation is not one of the existing implementations of the element.
Erroneous Elements:

Subroutines, actions, and truth tables
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(C7024) Elements containing a truth table with empty default row

(C7024) Elements containing a truth table with empty
default row

Error In:
Completeness
Description:

The element is described by a truth table that contains an empty default row (the output
columns are blank and the action section is empty).

Erroneous Elements:

Subroutines, actions, and truth tables

(CﬁOZS) Elements containing a truth table with empty
cells

Error In:
Completeness
Description:

The element is described by a truth table that contains empty cells that are not part of the
default row.

Erroneous Elements:

Subroutines, actions, and truth tables
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(C7027) Complex Data elements not defined by User-
type

There are data elements defined directly as Record, Union or Array of non-primitive type (not
Integer or Real), and not by User-defined types.

Error In:
Completeness
Erroneous Elements:

Data-items, Conditions, Record or Union fields, Subroutine parameters and local-variables

(C7028) Elements containing wrong type Array indices

Error In:

Completeness
Description:

Elements containing expressions with Array Indices of the wrong type.
Erroneous Elements:

Activities, States, Transitions, Data-items, Conditions, Events, Actions and Subroutines
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(C7101) Loops in element definition

(C7101) Loops in element definition

Error In:

Correctness
Description:

Elements use themselves in their definition, via chain definitions.
Example:

Data-type T1 is defined as integer with a minimum value of K1 and a maximum value of K2; K1
a constant data-item defined to be of type T1.

Erroneous Elements:

All elements in the loop

(C7103) Arrays with indices in reverse order

Error In:
Correctness
Description:

There are arrays or bit-arrays for which there are references to slices whose borders are in a reverse
order, relative to their type definition.

Example:

A is a bit-array from 31 down to 0. There is an action in the model:

A (0..7)=3

Erroneous Elements:

Data-items, fields, conditions, and events
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(C7105) Constants with inconsistent definition

Error In:
Correctness
Description:

One of the following:

¢ There are constant data-items or conditions whose values do not match their type
definition.

There are constant strings, arrays, or integers whose length do not match their defined
length.

¢ There are constant integers whose values are not in the defined value range.
Erroneous Elements:

Data-items and conditions

(C7106) Data elements defined as arrays of bits

Error In:
Correctness

Description:

Elements are defined as an array of a user-defined type (UDT) defined as bit.

Example:

DI1 defined as array of BIT1l, which is defined as bit

Erroneous Elements:

Data-items, UDTs, and fields
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(C7107) Defined data elements that are used incorrectly

(C7107) Defined data elements that are used
incorrectly

Error In:
Correctness
Description:

Elements contain expressions in which data-items explicitly defined as a particular data-type
are used in a way that does not match the type consistency and conversion rules.

Example:

1 is defined as an integer; S is defined as a string. There is an action that contains the following
assignment:

1=S

Erroneous Elements:

States, transitions, events, conditions, data-items, and actions

(C7109) Data elements without type definition that are
used inconsistently

Error In:
Correctness
Description:

Elements contain expressions in which data-items are not explicitly defined to be of a
particular data-type are used in a way that does not match the type consistency and conversion
rules.
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Example:

1 is used as an integer; s is used as a string. There is an action that contains the following
assignment:

1=S

Erroneous Elements:

States, transitions, events, conditions, data-items, and actions

(C7110) Subroutines that are used incorrectly

Error In:
Correctness

Description:

There are subroutine calls with expressions, constants, or compound elements used as Out or
InOut parameters. Only variable/alias data-items or conditions can be used as output
parameters.

Example:

subroutine SR1
Output parameter P1:

assigned the expression Al+B in ACH:ACT2:
SR1(A1+B)

Erroneous Elements:

Subroutines
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(C7111) Elements having multiple definitions

(C7111) Elements having multiple definitions

Error In:

Correctness
Description:

Elements with the same name appear in multiple global definition sets.
Erroneous Elements:

User-defined types, data-items, and conditions

(C7112) Elements using field references that do not
appear in the record/union definition

Error In:
Correctness
Description:

There are elements that contain expressions in which a field of an explicitly defined record or
union is used, but the field does not appear in the definition of the record or union.

(C7113) Empty Records/Unions

Error In:
Correctness
Description:

Data-types are defined to be a record or union, but there are no fields defined in the structure. This
is a correctness error because it is a fatal error situation for some tools.

Erroneous Elements:

User-defined types
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(C7114) Elements erroneously using field references

Error In:

Completeness
Description:

Elements erroneously reference fields.
Erroneous Elements:

Any element referencing fields.

(C7116) Tasks/Procedures that are used incorrectly

Error In:
Correctness
Description:

Tasks can be bound to activities only. Any other usage, such as in expressions, is incorrect.
Procedures and functions cannot be bound to activities.

Example:
TASK PRINTER is used as procedure/function in definition of SCH:AN1
Erroneous Elements:

Subroutines

378 Check Model Guide



(C7119) Elements containing subroutine calls with conflicting length of parameters

(C7119) Elements containing subroutine calls with
conflicting length of parameters

Error In:
Correctness
Description:

There are subroutine calls where the actual parameter’s length conflicts with the
corresponding formal parameter definition, or whose length is unknown.

Example:

STATE1
CALLBACK(A,ARRAY,3)
ARRAY - Unknown length

Erroneous Elements:

Textual elements, boxes, and arrows

(C7121) Subroutines using recursive calls

Error In:

Correctness
Description:

There are subroutines using recursive calls (either directly or by other subroutines).
Example:

SR3 called from SR2
SR2 called from SR3

Erroneous Elements:

Subroutines
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(C7123) Subroutines using elements not declared as
parameters, local variables, or globals

Error In:
Correctness
Description:

Subroutines use elements that are not declared as parameters, local variables, or globals. All
elements used in the subroutine code should be declared, including constant data-items and
conditions, enumerated values, other subroutines, and user-defined types.

Example:
subroutine F L2
Erroneous Elements:

Subroutines

(C7125) Subroutines that contain references to
activities
Error In:
Correctness
Description:

Subroutines contain references to activities. This is possible only when using a global variable,
which contains a reference to an activity.

Example:

subroutine F
Activity A used in GLOBAL1

Erroneous Elements:

Subroutines
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(C7127) Subroutines with illegal parameter type or return type

(C7127) Subroutines with illegal parameter type or

return type

Error In:
Correctness

Description:

In a subroutine where a UDT is the return type or the type of a parameter, the UDT has an
illegal definition. The following table lists the illegal definitions for UDTs.

dimension)

Type Return Type Parameter
UDT array of string * ** |llegal **
UDT array of bit-array *) ** [llegal **
UDT array of direct R/U *) ** |llegal **
UDT queue of anything ** |llegal ** ** [llegal **
Array of queue (any ** |llegal ** ** |llegal **

(*) In these cases, a middle user-defined type, is needed. For example, if the return type of a
function is an array of string, it should be defined as:

UDT array of STR_UDT, and STR_UDT, a string

Example:

subroutine F1

return type ARR_STR1, defined as array of string STR_QUEUE1,

type of parameter P1l, defined as queue

Erroneous Elements:

Subroutines
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(C7129) Subroutines with illegal local variables type

Error In:
Correctness
Description:

A local variable is defined as a user-defined type (UDT), which is a queue or an array (of any
dimension) of a queue.

Example:

subroutine F1
STR_QUEUE1, type of local variable LV1, defined as queue

Erroneous Elements:

Subroutines

(C7131) Subroutines with illegal/missing RETURN
command

Error In:
Correctness
Description:

There are functions without a RETURN command, procedures with a RETURN command, or a
function with a return type that conflicts with the returned value’s type.

Erroneous Elements:

Subroutines
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(C7133) Subroutines with local variables/parameters overriding parameters/globals

(C7133) Subroutines with local variables/parameters
overriding parameters/globals

Error In:
Correctness
Description:

There are subroutines with local variables that override parameters or globals, or parameters
override globals.

Erroneous Elements:

Subroutines

(C7134) Subroutines with illegal combination of type
and implementation

Error In:
Correctness
Description:

A subroutine has a selected implementation that is not supported for the subroutine type (task,
function, or procedure).

Erroneous Elements:

Subroutine
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§C7135) Elements containing a truth table with illegal
actorization structure

Error In:
Correctness
Description:

United input cells are not nested in a previous union, or two or more rows share the same input
section, but have different output sections.

Erroneous Elements:

Subroutines, actions, and truth tables

(C7136) Elements containing a truth table with illegal
combination of inputs

Error In:
Correctness
Description:

Elements described by truth tables use the same element twice as an input, via aliases. The
check ensures that the same element is not used twice as a whole (but the check will not
compare overlapping of slices).

Erroneous Elements:

Subroutines, actions, and truth tables
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(C7137) Elements containing a truth table with illegal combination of outputs

(C7137) Elements containing a truth table with illegal
combination of outputs

Error In:

Correctness
Description:

Elements described by truth tables use the same element twice as an output, via aliases.
Erroneous Elements:

Subroutines, actions, and truth tables

(C7139) Elements containing out of range integer/real
assignments

Error In:
Correctness
Description:

Elements contain assignments of integers, where an out-of-range value is assigned to a
restricted range integer; or one restricted range integer is assigned to another, where there is no
intersection of ranges. It tests if an integer or real value is compared with a value outside its
range, as well as values assigned to integer or real variable.

Erroneous Elements:
States, actions, data-items, transitions, and subroutines.

Global elements of a subroutine, sus, must be declared as global elements of any other
subroutine calling suB.
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(C7141) Inconsistent initial value

Error In:

Correctness
Description:

An element has a default value that is inconsistent with its type and range definition.
Example:

Integer data-type X has a minimum value of 0, and max value 20 and Default Value A. Integer
data-item A is a constant set to 40. A is outside the Min and Max for X so it is an inconsistent
initial value.

Erroneous Elements:

Integer and real data-items

(C7143) Inconsistent range definition

Error In:
Correctness
Description:

This test warns about user-defined type definitions where the sub-type ranges are inconsistent
with the parent type definition.

Example:

INT_TYPE is an integer User Defined Type and has a defined minimum/maximum range of
10 - 100 (as shown in the first figure below). SUB_INT_TYPE is a User Defined Type of
INT_TYPE and has a range defined outside of 10 - 100 (as shown in the second figure below).
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(C7143) Inconsistent range definition

INT_TYPE {User Defined Type) -0l x|
IDESE KB E BRI i8R =

Mame: I]]eFined In IT pe I]]e'F '] Mode ];l
INT_TYPE UzerlefTyp

SUB_INT_TYPE GDS1 UzerlefTyp Yez Update

=l

Gemeral Definition |ﬂttr‘ibutes I]]esign Attributes I]]escription

Structure: ISingle =l

Data Type: IIntegeP j Min:llO Maxz |100 Default 'u'alue:l
|Name ||DeFine-:I In || Type || Dief :|ch:|e ||i|
INT_TYPE GCIs1 UzerDef Typ Yes  Update

SUB_INT_TYPE GIS1 erlef Tup

Update

Gereral Definition Iﬂttr'ibutes I]]esign Attributes |Descr‘iption I

Structure: ISingle j

Data Type: IUSEI" Type j IINT_T’T’PE j
Subtype Rangea...l Subtype Ranges ﬂ

Definition: |- Hin: |2 Has | 102

Enum Default 'u'alue:l

0k | Cancel I Help

Erroneous Elements:

User-defined types
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(C7145) Empty information-flows

Error In:
Correctness
Description:
Array index expression does not result in an integer or contain elements with illegal type.
Example:
Case I:
Arr2 is an integer array from LeftInd2 to Rightind2.
LeftInd2 is defined as:
Single, Constant, with Data Type set to None, and definition set to SubDef?2
SubDef2 is defined as:
Single None Constant with definition set to 2.34
Case I1:
Arrl is an integer array from Leftind to Rightind.
LeftInd is defined as:
Single, Constant, with Data Type set to None, and definition set to SubDef
SubDef is defined as:

Single String Constant with definition set to 'My Definition’
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Sequence Diagram Checks

This section documents the Check Model checks for sequence diagrams. The checks are listed in
numerical order:

(C7801) Unlabeled message-lines

Error In:

Completeness
Description:

A message line was drawn but not labeled.
Erroneous Elements:

Message lines

(C7802) Message-lines with incomplete source
definition

Error In:
Completeness
Description:

The source of a message line was not drawn on a life-line. The offending message line is
indicated on the sequence diagram with a small “x” at its source and target.

Erroneous Elements:

Message lines
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(C7803) Message-lines with incomplete target
definition

Error In:
Completeness
Description:

The target of a message line was not drawn on a life-line. The offending message line is
indicated on the sequence diagram with a small “x” at its source and target.

Erroneous Elements:

Message-lines

(C7804) Unlabeled timing constraints

Error In:

Completeness
Description:

A timing constraint was drawn but not labeled.
Erroneous Elements:

Timing constraints

(C7805) Life-Lines without any input or output

Error In:

Completeness
Description:

A life-line in a sequence diagram is neither the source nor the target for any message lines.
Erroneous Elements:

Life-lines
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(C7806) The tested sequence-diagram contains no life-lines

I(_C7806) The tested sequence-diagram contains no life-
ines

Error In:

Completeness
Description:

A sequence diagram was created, but no life-lines were drawn in the diagram.
Erroneous Elements:

Sequence diagrams

(C7807) Unresolved elements

Error In:
Completeness
Description:

The sequence diagram contains references to elements that are not explicitly defined in the
relevant scope. The scope for a sequence diagram is set in the chart properties for the sequence
diagram.

Erroneous Elements:

All life-lines and all elements used in message-line labels
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Statechart and Activity Chart
Relation Checks

This section documents the Check Model checks for Statechart (SC) and Activity Chart (AC)
relation checks. The checks are listed in numerical order:

(C7201) The control activity is not connected to a
statechart

Error In:

Completeness
Description:

The control activity of the tested activity is not connected to a statechart.
Erroneous Elements:

Control activity

(C7203) The control activity is connected to an
unresolved statechart

Error In:
Completeness
Description:

The control activity of the tested activity is connected to a statechart that does not exist in the
workarea.

Erroneous Elements:

Control activity
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(C7205) Unresolved elements

Error In:
Completeness
Description:

Activities referenced by the statechart are not defined in the activity controlled by the
statechart.

Erroneous Elements:

Activities

(C7207) Input elements not used in the statechart

Error In:
Completeness
Description:

Data elements specified in the activity chart as direct input to the control activity of the tested
activity are not used inside the statechart.

Erroneous Elements:

Events, conditions, data-items, and information-flows

(C7209) Output elements not affected by the statechart

Error In:
Completeness
Description:

Data elements specified in the activity chart as direct output of the control activity of the tested
activity are not affected, changed, or generated inside the statechart.

Erroneous Elements:

Events, conditions, data-items, and information-flows
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(C7211) Elements that are used in a statechart but are neither input nor affected internally

(C7211) Elements that are used in a statechart but are
neither input nor affected internally

Error In:
Completeness
Description:

Variable events, conditions, or data-items are used (evaluated) in the statechart, but are not
specified in the activity chart as input to the control activity (directly or to one of its ancestors),
nor are they generated or modified by actions in the statechart.

Erroneous Elements:

Events, conditions, and data-items

(C7213) Elements affected by the statechart that are
neither used nor output

Error In:
Completeness
Description:

Elements are affected (modified or generated in actions) by the statechart, but they are neither
specified as output of the control activity nor used in the statechart.

Erroneous Elements:

Events, conditions, and data-items
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(C7215) Elements affected and used in the statechart
but are neither input nor output

Error In:
Completeness
Description:

Elements are affected in actions and are used in the statechart (for example, in triggers), but
are defined outside the statechart (in an ancestor activity chart) and do not flow into or from
the control activity described by the statechart.

Erroneous Elements:

Events, conditions, and data-items

(C7217) Subactivities not activated by the statechart

Error In:
Completeness
Description:

Subactivities of the tested activity are neither started in any action, nor performed throughout
or within any state in the controlling statechart.

Erroneous Elements:

Activities
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(C7219) Missing termination connector in the statechart of a self-terminated activity

(C7219) Missing termination connector in the
statechart of a self-terminated activity

Error In:
Completeness
Description:

The tested activity is defined with termination type reactive self, but there is no termination
connector in the statechart connected to the control activity.

Erroneous Elements:

Tested activity

(C7221) Controlled-termination subactivities that are
not stopped by the statechart

Error In:
Completeness
Description:

Activities with termination type reactive controlled (which are subactivities of the tested
activity) are neither stopped in any action, nor performed throughout any state in the statechart
connected to the control activity.

Erroneous Elements:

Activities
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(C7223) Procedure-like subactivities that are stopped
by the statechart

Error In:
Completeness
Description:

Activities with a procedure-like termination type are stopped in actions or static reactions in
the statechart connected to the control activity.

Erroneous Elements:

Activities

(C7225) Activities suspended by the Statechart but not
resumed, or vice versa

Error In:
Completeness
Description:

Activities are suspended by actions in the controlling statechart, but are not resumed in
actions, or vice versa.

Erroneous Elements:

Activities
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(C7227) Empty controlling statechart

(C7227) Empty controlling statechart

Error In:

Completeness
Description:

The statechart that describes the control activity contains no states.
Erroneous Elements:

Controlling statechart

(C7301) Controlled-termination subactivities of self-
terminating activity

Error In:

Correctness

Description:

This check is generated when an activity of termination type reactive controlled (which is a
subactivity of an activity of termination type reactive self) has no control activity.

Erroneous Elements:

Activities

Rational Statemate 399



Statechart and Activity Chart Relation Checks

(C7303) Elements containing references to transparent
activities
Error In:
Correctness
Description:

The control activity contains references to an activity defined to be a transparent level. The
references should be made to the activity’s nontransparent subactivities.

Erroneous Elements:

Activities
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Activity and Module Chart Relation
Checks

This section documents the Check Model tests for activity-chart and module chart relation
checks. The checks are listed in numerical order.

(C7401) Unresolved elements

Error In:
Completeness
Description:

Activities, data-stores, and modules referenced in the properties in the fields is activity/data-
store and implemented by module are not found in the expected scope in the workarea.

The modules are searched in the entire workarea; the activities and data-stores are searched
only in the activity-chart that describes the implementing module.

Erroneous Elements:

Activities, data-stores, and modules
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(C7403) Elements that flow in the activity chart without
corresponding flow in the module chart

Errorin:
Correctness
Description:

Data elements are specified as flowing between activities in the activity-chart, but they do not
flow between the corresponding modules in the module chart.

Example:

In the following figure, assume that A1 is implemented by M1 and A2 is implemented by mM2. X
flows between A1 and A2 in the activity-chart. X will be detected as an erroneous element
because it does not flow between the modules that implement A1 and A2.

Actvity chagt o ule-chark
* Y e |
H
a E w

Erroneous Elements:

Events, conditions, data-items, and information-flows

(C7405) Elements that flow in the module chart without
corresponding flow in the activity chart

Error In:
Completeness
Description:

Data elements specified as flowing between modules in the module chart do not flow between
the corresponding activities in the activity-chart.

Erroneous Elements:

Events, conditions, data-items, and information-flows
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(C7407) Basic activities not allocated to any module

(C7407) Basic activities not allocated to any module

Error In:
Completeness
Description:

There are activities that are not decomposed into other activities and data-stores, and are not
specified as implemented by any module.

Erroneous Elements:

Activities

(C7409) Data-stores not allocated to any module

Error In:

Completeness
Description:

There are data-stores that do not reside in any module.
Erroneous Elements:

Data-stores

(C7411) Basic modules to which no activity or data-
store is allocated

Error In:
Completeness
Description:

There are basic modules (descendants of the module described by the tested activity-chart)
that implement no activity and in which no data-store resides.

Erroneous Elements:

Modules
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(C7501) Activities or data-stores whose allocation in
modules violates the hierarchy rules

Error In:
Correctness
Description:

There are activities and data-stores whose hierarchy as specified in the activity-chart is not
consistent with the hierarchy of modules to which they are allocated.

Example:

In the following figure, A represents an activity and m is a module. Assume that it is specified
in the properties that “A is implemented by M1” and “A1 is implemented by M2”. Because A1 is
a subactivity of A, this does not match the relation between M1 and m2.

Al Al M1 kL

Erroneous Elements:

Activities and data-stores
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